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Introduction

Visual Basic 2005 is Microsoft’s latest version of the highly popular Visual Basic .NET programming lan-
guage, one of the many languages supported in Visual Studio 2005. Visual Basic 2005’s strength lies in
its ease of use and the speed at which you can create Windows applications, Web applications, mobile
device applications, and Web Services.

In this book, we will introduce you to programming with Visual Basic 2005 and show you how to create
the types of applications and services mentioned above. Along the way you'll also learn about object-
oriented techniques and learn how to create your own business objects and Windows controls.

Microsoft’s .NET Framework provides Visual Basic 2005 programmers with the ability to create full
object oriented programs, just like the ones created using C# or C++. The .NET Framework provides a
set of base classes that are common to all programming languages in Visual Studio 2005, which provides
you with the same ability to create object-oriented programs as a programmer using C# or C++.

This book will give you a thorough grounding in the basics of programming using Visual Basic 2005;
from there the world is your oyster.

Who Is This Book For?

This book is designed to teach you how to write useful programs in Visual Basic 2005 as quickly and eas-
ily as possible.

There are two kinds of beginners for whom this book is ideal:

QO  You're a beginner to programming and you’ve chosen Visual Basic 2005 as the place to start.
That’s a great choice! Visual Basic 2005 is not only easy to learn; it’s also fun to use and very
powerful.

0  You can program in another language but you're a beginner to .NET programming. Again,
you’ve made a great choice! Whether you’ve come from Fortran or Visual Basic 6, you'll find
that this book quickly gets you up to speed on what you need to know to get the most from
Visual Basic 2005.

What Does This Book Cover?

Visual Basic 2005 offers a great deal of functionality in both tools and language. No one book could ever
cover Visual Basic 2005 in its entirety—you would need a library of books. What this book aims to do is to
get you started as quickly and easily as possible. It shows you the roadmap, so to speak, of what there is
and where to go. Once we’ve taught you the basics of creating working applications (creating the windows
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and controls, how your code should handle unexpected events, what object-oriented programming is, how
to use it in your applications, and so on) we’ll show you some of the areas you might want to try your
hand at next:

Q  Chapters 1 through 8 provide an introduction to Visual Studio 2005 and Windows programming.
Q  Chapter 9 provides an introduction to application debugging and error handling.

O  Chapters 10 through 12 provide an introduction to object-oriented programming and building
objects.

O  Chapters 13 and 14 provide an introduction to graphics in Windows applications.

Q  Chapters 15 and 16 provide an introduction to programming with databases and covers Access,
SQL Server, and ADO.NET.

Q  Chapter 17 provides an introduction to ASP.NET and shows you how to write applications for
the Web.

O  Chapter 19 provides a brief introduction to XML; a powerful tool for integrating your applica-
tions with others—regardless of the language they were written in.

Q  Chapter 20 introduces you to Web Services; a technology whereby functionality offered on the
Internet can be accessed by your applications and seamlessly integrated into them.

Q  Chapter 21 introduces you to building applications for mobile devices using the Compact
Framework classes.

What Do | Need to Run Visual Basic 2005?

Apart from a willingness to learn, all you'll need for the first 14 chapters are a PC running Windows 2000,
Windows XP (Home or Professional Edition), or Windows Server 2003; Internet Explorer; and of course:

O Microsoft Visual Basic 2005 Express Edition

or

QO  Microsoft Visual Basic 2005 Standard Edition

or

0  Microsoft Visual Basic 2005 Professional Edition
or
Q  Microsoft Visual Basic 2005 Team System
As the later chapters cover more advanced subject areas, you will need other software to get the most

out of them. Also, Visual Basic 2005 Express does not support creating Web applications, mobile applica-
tions, and deployment projects:

XXX
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Q  Chapter 15 requires Microsoft Access 2000.

Q  For Chapter 16, you will need to have access to SQL Server 2000, SQL Server 2005, or SQL
Server 2005 Express.

Don’t worry if you don’t have these products already and want to wait a while before you purchase
them. You should still find that you get a lot out of this book.

Conventions

We’ve used a number of different styles of text and layout in this book to help differentiate between
the different kinds of information. Here are examples of the styles we use and an explanation of what

they mean.

Try It Out How Do They Work?
1.  Each step has a number.

2. Follow the steps through.
3.  Thenread the subsequent “How It Works” to find out what’s going on.

Background information, asides, and references appear in text like this.

O  Bullets appear indented, with each new bullet marked like this.

Code has several styles. If it’s a word that we’re talking about in the text—for example, when discussing
aFor...Next loop,it’sin this font.Ifit’s a block of code that can be typed as a program and run, it’s

also in a gray box:

Private Sub btnAdd Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnAdd.Click
Dim n As Integer
n = 27
MessageBox . Show (n)
End Sub

Sometimes you'll see code in a mixture of styles, like this:

Private Sub btnAdd _Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnaAdd.Click
Dim n As Integer
n = 27
n=n+2
MessageBox.Show (n)
End Sub

In cases like this, the code with a white background is code that Visual Studio 2005 has automatically
generated (in a Try It Out) or code you are already familiar with (in a How It Works); the lines high-

lighted in gray is a new addition to the code.

XXXi
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Customer Support

We always value hearing from our readers, and we want to know what you think about this book: what
you liked, what you didn’t like, and what you think we can do better next time. You can send us your
comments by e-mail to feedback@wrox. com. Please be sure to mention the book title in your message.

How to Download the Sample Code for the Book

When you visit the Wrox site, www . wrox . com/, simply locate the title through our Search facility or
by using one of the title lists. Click Download in the Code column or Download Code on the book’s
detail page.

The files that are available for download from our site have been archived using WinZip. When you
have saved the attachments to a folder on your hard drive, you need to extract the files using a decom-
pression program such as WinZip, PKUnzip, or UltimateZip. When you extract the files, the code is usu-
ally extracted into chapter folders. When you start the extraction process, ensure that your
decompression software is set to use folder names.

Errata

We’ve made every effort to make sure that there are no errors in the text or in the code. However, no one
is perfect, and mistakes do occur. If you find an error in one of our books, like a spelling mistake or a
faulty piece of code, we would be very grateful to have your feedback. By sending in errata, you may
save another reader from hours of frustration, and of course, you will be helping us provide even higher
quality information. Simply e-mail the information to support@wrox. com; your information will be
checked and, if correct, posted to the errata page for that title or used in subsequent editions of the book.

To find errata on the Web site, go to www.wrox.com/, and simply locate the title through our Advanced
Search or title list. Click the Book Errata link, which is below the cover graphic on the book’s detail page.

If you wish to query a problem in the book directly with an expert who knows the book in detail, then
e-mail support@wrox.com, with the title of the book and the last four numbers of the ISBN in the sub-
ject field of the e-mail. A typical e-mail should include the following things:

Q  The title of the book, last four digits of the ISBN (4019), and page number of the problem in the
Subject field
QO  Your name, contact information, and the problem in the body of the message

We won’t send you junk mail. We need the details to save your time and ours. When you send an e-mail
message, it will go through the following chain of support:

QO  Customer Support—Your message is delivered to our customer support staff, who are the first
people to read it. They have files on most frequently asked questions and will answer anything
general about the book or the Web site immediately.

O  Editorial—Deeper queries are forwarded to the technical editors responsible for that book. They
have experience with the programming language or particular product and are able to answer
detailed technical questions on the subject.

XXXii
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Q  The authors—Finally, in the unlikely event that the editor cannot answer your problem, they
will forward the request to the author. We do try to protect the author from any distractions to
their writing; however, we are quite happy to forward specific requests to them. All Wrox
authors help with the support on their books. They will e-mail the customer and the editor with
their response, and again all readers should benefit.

The Wrox Support process can offer support only to issues that are directly pertinent to the content of
our published title. Support for questions that fall outside the scope of normal book support is provided
via the community lists at http: //p2p.wrox.com/forum.

p2p.wrox.com

For author and peer discussions, join the P2P mailing lists. Our unique system provides programmer-to-
programmer contact on mailing lists, forums, and newsgroups, all in addition to our one-to-one e-mail
support system. If you post a query to P2P, you can be confident that it is being examined by many Wrox
authors and other industry experts who are present on our mailing lists. At p2p.wrox.com you will find
a number of different lists that will help you, not only while you read this book, but also as you develop
your own applications. Particularly appropriate to this book are the beginning_vb and vb_dotnet
lists.

To subscribe to a mailing list just follow these steps:

Gotohttp://p2p.wrox.com/.

Choose the appropriate category from the left menu bar.

Click the mailing list you wish to join.

Follow the instructions to subscribe and fill in your e-mail address and password.

Reply to the confirmation e-mail you receive.

S Gk W N RE

Use the subscription manager to join more lists and set your e-mail preferences.

Why This System Offers the Best Support

You can choose to join the mailing lists, or you can receive them as a weekly digest. If you don’t have the
time, or facility, to receive the mailing list, you can search our online archives. Junk mails and spam are
deleted, and your own e-mail address is protected by the unique Lyris system. Queries about joining or
leaving lists, and any other general queries about lists, should be sent to 1istsupport@p2p.wrox.com.
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Welcome to Visual
Basic 2005

The goal of this book is to help you come up to speed with the Visual Basic 2005 language even if
you have never programmed before. You will start slowly and build on what you learn. So take a
deep breath, let it out slowly, and tell yourself you can do this. No sweat! No kidding!

Programming a computer is a lot like teaching a child to tie his shoes. Until you find the correct way
of giving the instructions, not much gets accomplished. Visual Basic 2005 is a language in which
you can tell your computer how to do things. But, like a child, the computer will understand only if
you explain things very clearly. If you have never programmed before, this sounds like an arduous
task, and sometimes it is. However, Visual Basic 2005 gives you a simple language to explain some
complex things. Although it never hurts to have an understanding of what is happening at the low-
est levels, Visual Basic 2005 frees the programmer from having to deal with the mundane complexi-
ties of writing Windows programs. You are free to concentrate on solving problems.

Visual Basic 2005 helps you create solutions that run on the Microsoft Windows operating system.
If you are looking at this book, you might have already felt the need or the desire to create such
programs. Even if you have never written a computer program before, as you progress through
the Try It Out exercises in this book, you will become familiar with the various aspects of the
Visual Basic 2005 language, as well as its foundation in Microsoft’s .NET Framework. You will find
that it is not nearly as difficult as you have been imagining. Before you know it, you will be feeling
quite comfortable creating a variety of different types of programs with Visual Basic 2005. Also

(as the name .NET implies) Visual Basic 2005 can be used to create applications for use over the
Internet. You can also create mobile applications for Pocket PCs and SmartPhones. However, when
learning any new technology, you have to walk before you can run, so in this book you will begin
by focusing on Windows applications before extending your boundaries to other platforms.

In this chapter, we will cover the following subjects:

Q  The installation of Visual Basic 2005
0 A tour of the Visual Basic 2005 Integrated Development Environment (IDE)
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O  How to create a simple Windows program

O  How to use and leverage the integrated help system

Windows Versus DOS Programming

A Windows program is quite different from its ancient relative, the MS-DOS program. A DOS program
follows a relatively strict path from beginning to end. Although this does not necessarily limit the func-
tionality of the program, it does limit the road the user has to take to get to it. A DOS program is like
walking down a hallway; to get to the end you have to walk down the hallway, passing any obstacles
that you may encounter. A DOS program would only let you open certain doors along your stroll.

Windows, on the other hand, opened up the world of event-driven programming. Events in this context
include, for example, clicking a button, resizing a window, or changing an entry in a text box. The code
that you write responds to these events. To go back to the hallway analogy: In a Windows program, to
get to the end of the hall, you just click on the end of the hall. The hallway can be ignored. If you get to
the end and realize that is not where you wanted to be, you can just set off for the new destination with-
out returning to your starting point. The program reacts to your movements and takes the necessary
actions to complete your desired tasks (Visual Basic 2005).

Another big advantage in a Windows program is the abstraction of the hardware; which means that Windows
takes care of communicating with the hardware for you. You do not need to know the inner workings of
every laser printer on the market just to create output. You do not need to study the schematics for graphics
cards to write your game. Windows wraps up this functionality by providing generic routines that commu-
nicate with the drivers written by hardware manufacturers. This is probably the main reason that Windows
has been so successful. The generic routines are referred to as the Windows Application Programming
Interface (API).

Before Visual Basic 1.0 was introduced to the world in 1991, developers had to be well versed in C and
C++ programming, as well as the building blocks of the Windows system itself, the Windows API. This
complexity meant that only dedicated and properly trained individuals were capable of turning out soft-
ware that could run on Windows. Visual Basic changed all of that, and it has been estimated that there
are now as many lines of production code written in Visual Basic as in any other language.

Visual Basic changed the face of Windows programming by removing the complex burden of writing
code for the user interface (UI). By allowing programmers to draw their own U], it freed them to concen-
trate on the business problems they were trying to solve. Once the Ul is drawn, the programmer can
then add the code to react to events.

Visual Basic has also been extensible from the very beginning. Third-party vendors quickly saw the mar-
ket for reusable modules to aid developers. These modules, or controls, were originally referred to as
VBXs (named after their file extension). Prior to Visual Basic 5.0, if you did not like the way a button
behaved, you could either buy or create your own, but those controls had to be written in C or C++.
Database access utilities were some of the first controls available. Version 5 of Visual Basic introduced
the concept of ActiveX, which allowed developers to create their own ActiveX controls.

When Microsoft introduced Visual Basic 3.0, the programming world changed again. Now you could
build database applications directly accessible to users (so-called front-end applications) completely with
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Visual Basic. There was no need to rely on third-party controls. Microsoft accomplished this task with
the introduction of Data Access Objects (DAO), which allowed programmers to manipulate data with the
same ease as manipulating the user interface.

Versions 4.0 and 5.0 extended the capabilities of Version 3.0 to allow developers to target the new
Windows 95 platform. Crucially they also made it easier for developers to write code, which could

then be manipulated to make it usable to other language developers. Version 6.0 provided a new way

to access databases with the integration of ActiveX Data Objects (ADO). The ADO feature was developed
by Microsoft to aid Web developers using Active Server Pages to access databases. All of the improve-
ments to Visual Basic over the years have ensured its dominant place in the programming world. It
helps developers write robust and maintainable applications in record time.

With the release of Visual Basic .NET in February 2002, most of the restrictions that used to exist have
been obliterated. In the past, Visual Basic has been criticized and maligned as a “toy” language, as it did
not provide all of the features of more sophisticated languages such as C++ and Java. Now, Microsoft
has removed these restrictions and made Visual Basic .NET a very powerful development tool. This
trend continues with Visual Basic 2005. Although not as drastic a change as from Visual Basic 6 to Visual
Basic .NET, there are enough improvements in the language and integrated development environment
that Visual Basic 2005 is a welcome upgrade and is a great choice for programmers of all levels.

Installing Visual Basic 2005

You may own Visual Basic 2005 in either of the following forms:

Q  As part of Visual Studio 2005, a suite of tools and languages that also includes C# (pronounced
“C-sharp”), J# (pronounced “J-sharp”), and Visual C++. The Visual Studio 2005 product line
includes Visual Studio Standard Edition, Visual Studio Professional Edition, Visual Studio Tools
for Office, and Visual Studio Team System. All of these versions come with progressively more
tools for building and managing the development of larger, enterprise-wide applications.

Q  Asthe Express Edition, which includes a reduced set of the tools and features that are available
with Visual Studio 2005.

Both enable you to create your own applications for the Windows platform. The installation procedure is
straightforward. In fact, the Visual Studio Installer is smart enough to figure out exactly what your com-
puter requires to make it work.

The descriptions in the Try It Out exercise that follows are based on installing Visual Studio 2005 Architect
Edition. Most of the installation processes are very straightforward, and you can accept the default instal-
lation options for most environments. So, regardless of which edition you are installing, the installation
process should be smooth when accepting the default installation options.

Try It Out Installing Visual Basic 2005

1.  The Visual Studio 2005 CD has an auto-run feature, but if the Setup screen does not appear after
inserting the CD, you have to run setup. exe from the root directory of the CD. To do this, go
to your Windows Start menu (usually found right at the bottom of your screen) and select Run.
Then type d:\ setup.exe into the Open box, where d is the drive letter of your CD drive. After
the setup program initializes, you will see the screen as shown in Figure 1-1.
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2.

This dialog box shows the order in which the installation takes place. To function properly,
Visual Basic 2005 requires that several updates be installed on your machine, such as Service
Pack 1 for Windows XP. The setup program will inform you if these updates are not installed.
You should then install any required updates before proceeding with the installation of Visual
Studio 2005. Step 1 installs Visual Studio 2005, so click the Install Visual Studio link.

al Studio Beta Setup

Microsoft®

Visual Studio® Beta Setup

Install ¥isual Studio Beta
Install Wisual Studio Beta features and required components,

Wiew Readie E it

Figure 1-1

After agreeing to the End User License agreement, click Continue to proceed to the next step.

As with most installations, you will be presented with an option list of components to install (see
Figure 1-2). You can choose to install only the features that you need. For example, if your drive
space is limited and you have no immediate need for Visual C++ 2005, you can exclude it from the
installation. You will also be given the chance to select the location of items (although the defaults
should suffice unless your particular machine has special requirements). Any option that is not
chosen at the initial setup can always be added later as your needs or interests change. However, if
you plan on developing database applications such as those discussed in Chapter 16, you should
choose to install SQL Server 2005 Express, which is the last option in the list.

Three sections of information are given for each feature:

Q  The Feature description box gives you an outline of each feature and its function.
Q  The Feature Install path section outlines where the required files will be installed.

Q  Finally, the Space Allocation section illustrates how the space on your hard drive will be
affected by the installation as a whole.

When you are running Visual Basic 2005, a lot of information is swapped from the disk to memory and
back again. Therefore, it is important to have some free space on your disk. There is no exact rule for
determining how much free space you will need, but if you use your machine for development as well as
other tasks, anything less than 100MB free space should be considered a full disk.
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After you have chosen all the features you want, click Install. Installation will begin and you can
sit back and relax for a bit. The setup time varies depending on how many features you chose to
install. As a reference, the installation process took around 20 minutes on a 2.4-GHz computer

When installation is completed, you will see a dialog informing you that the installation has

Here you will see any problems that setup encountered along the way. You are also given the
chance to look at the installation log. This log provides a list of all actions taken during the

installation process. Unless your installation reported errors, the installation log can safely be
ignored. The Visual Studio 2005 setup is nearly complete. Click Done to move on to installing

The MSDN Library installation is simple and straightforward, and this section covers the high-
lights. The first screen that you will see is the initial welcome screen. Click Next to proceed.

Figure 1-2

5.

with 512 MB RAM running Windows XP Professional.
6.

completed.

the documentation.
7.
8.

You will be allowed to select the amount of the documentation you want to install, as shown in
Figure 1-3. Click Next to start the installation process.

If you have the spare hard drive space, it is a very good idea to install the full documentation. That way
you have access to the full library, which will be important if you choose a limited set of options during
the install and later add more features.

9.

After the MSDN documentation has been installed, you are returned to the initial setup screen
again, and the Service Releases option is available.
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Setup Type
Select 4 setup type,

Instals all documentation to the local hard drive.

Space reguirad on C: 1250MB
Space avaiable on C: 455

 Custom
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 Minimum
Instals Wisual Studio documentation based on the Yisual
Studio 2005 features that are instaled on this computer,

Space required on C: 1069MB
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< Back I Menct = | Cancel Help

Figure 1-3

It is a good idea to select Service Releases to check for updates. Microsoft has done a good job of making
software updates available through the Internet. These updates can include anything from additional
documentation to bug fixes. You will be given the choice to install any updates via a Service Pack CD or
the Internet. Obviously, the Internet option requires an active connection. Since updates can be quite
large, a fast connection is highly recommended.

Once you have performed the update process, Visual Studio 2005 is ready to use. Now the real fun can
begin! So get comfortable, relax, and let us enter the world of Visual Basic 2005.

The Visual Basic 2005 IDE

You don’t actually need the Visual Basic 2005 product to write applications in the Visual Basic 2005 lan-
guage. The actual ability to run Visual Basic 2005 code is included with the .NET Framework. You could
actually just write all of your Visual Basic 2005 using a text editor such as Notepad. You could also ham-
mer nails using your shoe as a hammer, but that slick pneumatic nailer sitting there is probably a lot
more efficient. In the same way, by far the easiest way to write in Visual Basic 2005 is by using the Visual
Studio 2005 Integrated Development Environment, also known as the IDE. This is what you actually see
when working with Visual Basic 2005 — the windows, boxes, and so on. The IDE provides a wealth of
features unavailable in ordinary text editors —such as code checking, visual representations of the fin-
ished application, and an explorer that displays all of the files that make up your project.
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The Profile Setup Page

An IDE is a way of bringing together a suite of tools that makes developing software a lot easier. Fire up
Visual Studio 2005 and see what you've got. If you used the default installation, go to your Windows
Start menu and then Programs (All Programs on Windows XP and Windows Server 2003) &> Microsoft
Visual Studio 2005 => Microsoft Visual Studio 2005. A splash screen will briefly appear, and then you
should find yourself presented with the Choose Default Environment Settings dialog box. Select the
Visual Basic Development Settings option and then click Start Visual Studio. The Microsoft Development
Environment will appear, as shown in Figure 1-4.
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Figure 1-4

The Menu

By now, you may be a bit eager to start writing some code. But first, begin your exploration of the IDE
by looking at the toolbar and menu, which, as you will learn are not really all that different from the
toolbars and menus you have seen in other Microsoft software such as Word, Excel, and PowerPoint.

Visual Studio 2005’s menu is dynamic, meaning that items will be added or removed depending on what
you are trying to do. While you are looking at the blank IDE, the menu bar will consist only of the File,
Edit, View, Data, Tools, Window, Community, and Help menus. When you start working on a project,
however, the full Visual Studio 2005 menu appears as shown in Figure 1-5.

| File Edit “iew Project Buld Debug Data  Fomat  Tools  Window  Community  Help |

Figure 1-5
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At this point, there is no need to cover each menu topic in great detail. You will become familiar with
each of them as you progress through the book. Here is a quick rundown of what activities each menu
item pertains to:

a

File: It seems every Windows program has a File menu. It has become the standard where you
should find, if nothing else, a way to exit the application. In this case, you can also find ways of
opening and closing single files and whole projects.

Edit: The Edit menu provides access to the items you would expect: Undo, Redo, Cut, Copy,
Paste, and Delete.

View: The View menu provides quick access to the windows that exist in the IDE, such as the
Solution Explorer, Properties window, Output window, Toolbox, and so on.

Project: The Project menu allows you to add various files to your application such as forms and
classes.

Build: The Build menu becomes important when you have completed your application and
want to run it without the use of the Visual Basic 2005 environment (perhaps running it directly
from your Windows Start menu, as you would any other application such as Word or Access).

Debug: The Debug menu allows you to start and stop running your application within the
Visual Basic 2005 IDE. It also gives you access to the Visual Studio 2005 debugger. The debugger
allows you to step through your code while it is running to see how it is behaving.

Data: The Data menu helps you to use information that comes from a database. It appears only
when you are working with the visual part of your application (the [Design] tab will be the
active one in the main window), not when you are writing code. Chapters 15 and 16 will intro-
duce you to working with databases.

Format: The Format menu also appears only when you are working with the visual part of your
application. Items on the Format menu allow you to manipulate how the controls you create
will appear on your forms.

Tools: The Tools menu has commands to configure the Visual Studio 2005 IDE, as well as links
to other external tools that may have been installed.

Window: The Window menu has become standard for any application that allows more than
one window to be open at a time, such as Word or Excel. The commands on this menu allow
you to switch between the windows in the IDE.

Community: The Community menu provides access to developer resources, where you can ask
questions, search for code snippets, and send product feedback.

Help: The Help menu provides access to the Visual Studio 2005 documentation. There are many
different ways to access this information (for example, via the help contents, an index, or a
search). The Help menu also has options that connect to the Microsoft Web site to obtain
updates or report problems.

The Toolbars

Many toolbars are available within the IDE, including Formatting, Image Editor, and Text Editor, which
you can add to and remove from the IDE via the View = Toolbars menu option. Each one provides quick
access to often-used commands, preventing you from having to navigate through a series of menu
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options. For example, the leftmost icon (New Project) on the default toolbar (called the Standard tool-
bar), shown in Figure 1-6, is available from the menu by navigating to File ©> New => Project.

Navigate Forward Toolbox
Save Paste
Solution Properties | Other
Add Item Cut Redo Configurations Find in Files Window | Windows
Al G @ bl 96 33 b Debug - Ay CFU - | % ingCueniNavinage IEEEEY ET
New | Save All Undo Start Find Solution | Start
Project Debugging Explorer | Page
Copy
Open File Navigate Backward Solution Platform Object Browser
Figure 1-6

The toolbar is segmented into groups of related options, which are separated by a vertical bar. The first
five icons provide access to the commonly used project and file manipulation options available through
the File and Project menus, such as opening and saving files.

The next group of icons is for editing (Cut, Copy, and Paste). The third group of icons is for undoing and
redoing edits and for navigating through your code.

The fourth group of icons provides the ability to start your application running (via the green triangle).
You can also choose a configuration for your solution and target specific platforms.

The next section allows you to find text in your code throughout the entire document, project, or
solution.

The final group of icons provides quick links back to the Solution Explorer, Properties window, Toolbox,
Object Browser, Start Page, and other windows. If any of these windows is closed, clicking the appropri-
ate icon will bring it back into view.

If you forget what a particular icon does, you can hover your mouse pointer over it so that a ToolTip
appears displaying the name of the toolbar option.

You could continue to look at each of the windows by clicking on the View menu and choosing the
appropriate window. But, as you can see, they are all empty at this stage and therefore not too revealing.
The best way to look at the capabilities of the IDE is to use it while writing some code.

Creating a Simple Application

To finish your exploration of the IDE, you need to create a project, so that the windows shown earlier in
Figure 1-4 actually have some interesting content for you to look at. In the following Try It Out, you are
going to create a very simple application called HelloUser that will allow you to enter a person’s name
and display a greeting to that person in a message box.
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Try It Out Creating a HelloUser Project
1. Click the New Project button on the toolbar.

2. The New Project dialog box will open. Make sure you have Visual Basic selected in the Project
Types tree-view box to the left. Next, select Windows Application in the Templates box on the
right. Finally, type Hello User in the Name text box and click OK. Your New Project dialog box
should look like Figure 1-7.

New Project
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|8 project for creating an application with & Windows use! inteiface
Mame: |Helc| Uszar
Location: |C:\Do\:>\,merls and SetfingzhThearon'\My Documentz\Wizual Studio 200584FProjects ﬂ Browize... |
Salution Hame: |I {elo Uzer [ Cieate directory for solution
coe |
Figure 1-7

3.  The IDE will then create an empty Windows application for you. So far, your Hello User pro-
gram consists of one blank window;, called a Windows Form (or sometimes just a form), with
the default name of Forml . vb, as shown in Figure 1-8.

Whenever Visual Studio 2005 creates a new file, either as part of the project creation process or when
you create a new file, it will use a name that describes what it is (in this case, a form) followed by a
number.

Windows in the Visual Studio 2005 IDE

At this point, you can see that the various windows in the IDE are beginning to show their purposes,
and you should take a brief look at them now before you come back to the Try It Out. Note that if any of
these windows are not visible on your screen, you can use the View menu to select and show them. Also,
if you do not like the location of any particular window, you can move it by clicking on its title bar (the
blue bar at the top) and dragging it to a new location. The windows in the IDE can float (stand out on
their own) or be docked (as they appear in Figure 1-8). The following list introduces the most common
windows:

0  Database Explorer: The Database Explorer provides access to your defined database connec-

tions. Here you can create new database connections and view existing database connections.
In Figure 1-8, the Database Explorer is a tab at the bottom of the Toolbox window.

10
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Figure 1-8

0  Toolbox: The Toolbox contains reusable controls and components that can be added to your
application. These can range from buttons to data connectors to customized controls that you
have either purchased or developed.

QO  Design window: The Design window is where a lot of the action takes place. This is where you
will draw your user interface on your forms. This window is sometimes referred to as the
Designer.

Q  Solution Explorer: The Solution Explorer window contains a hierarchical view of your solution.
A solution can contain many projects, whereas a project contains forms, classes, modules, and
components that solve a particular problem.

Q  Properties: The Properties window shows what properties the selected object makes available.
Although you can set these properties in your code, sometimes it is much easier to set them
while you are designing your application (for example, drawing the controls on your form). You
will notice that the File Name property has the value Forml . vb. This is the physical file name
for the form’s code and layout information.

Try It Out Creating a HelloUser Project (cont.)

1. Change the name of your form to something more indicative of what your application is. Click
on Forml . vb in the Solution Explorer window. Then, in the Properties window, change the File
Name property from Forml . vb to HelloUser.vb and press Enter, as shown in Figure 1-9. When
changing properties you must either press Enter or click off the property for it to take effect.

11
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Figure 1-9

2. Notice that the form’s filename has also been updated in the Solution Explorer to read
HelloUser.vb.

3.  Now click the form displayed in the Design window. The Properties window will change to dis-
play the form’s Form properties (instead of the File properties, which you have just been look-
ing at). You will notice that the Properties window is dramatically different. The difference is
the result of two different views of the same file. When the form name is highlighted in the
Solution Explorer window, the physical file properties of the form are displayed. When the
form in the Design window is highlighted, the visual properties and logical properties of the
form are displayed.

The Properties window allows you to set a control’s properties easily. Properties are a particular
object’s set of internal data; they usually describe appearance or behavior. In Figure 1-10 you
can see that properties are grouped together in categories — Accessibility (not shown),
Appearance (header is not shown), Behavior, Data, Design, Focus (not shown), Layout (not
shown), Misc (not shown), and Window Style (not shown).

You can see that under the Appearance cateory (header not shown), even though we changed the file
name of the form to HelloUser . vb, the text or caption of the form is still Forml.

4. Right now, the title (Text property) of your form (displayed in the bar at the top) is Form1. This
is not very descriptive, so change it to reflect the purpose of this application. Locate the Text
property in the Appearance section of the Properties window. Change the Text property’s value
to Hello from Visual Basic 2005 and press Enter. Notice that the form’s title has been updated
to reflect the change.

If you have trouble finding properties, click the little AZ button on the toolbar toward the top of the
Properties window. This changes the property listing from being ordered by category to being ordered
by name.

5.  You are now finished with the procedure. Click the Start button on the Visual Studio 2005 tool-
bar (the green triangle) to run the application. As you work through the book, whenever we say
“run the project” or “start the project,” just click the Start button. An empty window with the
title Hello from Visual Basic 2005 is displayed.

12
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Figure 1-10

That was simple, but your little application isn’t doing much at the moment. Let us make it a little more
interactive. To do this, you are going to add some controls —a label, a text box, and two buttons to the
form. This will let you see how the Toolbox makes adding functionality quite simple. You may be won-
dering at this point when you will actually look at some code. Soon! The great thing about Visual Basic
2005 is that you can develop a fair amount of your application without writing any code. Sure, the code is
still there, behind the scenes, but, as you will see, Visual Basic 2005 writes a lot of it for you.

The Toolbox

The Toolbox is accessed via the View => Toolbox menu option, the Toolbox icon on the Standard menu
bar, or by pressing Ctrl+Alt+X. Alternatively, the Toolbox tab is displayed on the left of the IDE; hover-
ing your mouse over this tab will cause the Toolbox window to fly out, partially covering your form.

The Toolbox contains a Node type view of the various controls and components that can be placed onto
your form. Controls such as text boxes, buttons, radio buttons, and combo boxes can be selected and
then drawn onto your form. For the HelloUser application, you will be using only the controls in the
Common Controls node. In Figure 1-11, you can see a listing of common controls for Windows Forms.

Controls can be added to your forms in any order, so it does not matter if you add the label control after
the text box or the buttons before the label. In the next Try It Out, you start adding controls.
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Figure 1-11

Try It Out Adding Controls to the HelloUser Application

1. Stop the project if it is still running, because you now want to add some controls to your form.
The simplest way to stop your project is to click the _ button in the top-right corner of the form.
Alternatively, you can click the blue square in the IDE (which displays a ToolTip that says “Stop
Debugging” if you hover over it with your mouse pointer).

2. Add a Label control to the form. Click Label in the Toolbox and drag it over the form’s Designer
and drop it in the desired location. (You can also place controls on your form by double-clicking
on the required control in the Toolbox or clicking on the control in the Toolbox and then draw-
ing it on the form.)

3.  If the Label control you have just drawn is not in the desired location, it really isn’t a problem.
Once the control is on the form, you can resize it or move it around. Figure 1-12 shows what the
control looks like after you place it on the form. To move it, click the dotted border and drag it
to the desired location. The label will automatically resize itself to fit the text that you enter in
the Text property.

4. After drawing a control on the form, you should at least configure its name and the text that it
will display. You will see that the Properties window to the right of the Designer has changed
to Labell, telling you that you are currently examining the properties for it. In the Properties

14
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window, set your new label’s Text property to Enter Your Name. Notice that, once you press
enter or click off of the property, the label on the form has automatically resized itself to fit the
Text property. Now set the Name property to IbIName.

Hello from Visual Basic 2005 =]

Figure 1-12

5. Now, directly beneath the label, you want to add a text box, so that you can enter a name. You
are going to repeat the procedure you followed for adding the label, but this time make sure
you select the TextBox control from the toolbar. After you have dragged-and-dropped (or
double-clicked) the control into the appropriate position as shown in Figure 1-13, use the
Properties window to set its Name property to txtName.

Notice the sizing handles on the left and right side of the control. You can use these handles to resize the
text box horizontally.

Hello from Visual Basic 2005 =]

Figure 1-13

6. In the bottom left corner of the form, add a Button control in exactly the same manner as you
added the label and text box. Set its Name property to btnOK and its Text property to &OK.
Your form should now look similar to the one shown in Figure 1-14.

15
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The ampersand (&) is used in the Text property of buttons is to create a keyboard shortcut (known as a
hot key). The letter with the & sign placed in front of it will become underlined (as shown in Figure
1-14) to signal users that they can select that button by pressing the Alt+letter key combination, instead
of using the mouse (on some configurations the underline doesn’t appear until the user presses Alt). In
this particular instance, pressing Alt+O would be the same as clicking directly on the OK button. There
is no need to write code to accomplish this.

Hello from Visual Basic 2005 Hi=]

Enter “fiour Mame

e

Figure 1-14

Now add a second Button control to the bottom right corner of the form by dragging the Button
control from the Toolbox onto your form. You'll notice that, as you get close to the bottom right
of the form, a blue snap line will appear, as shown in Figure 1-15. This snap line will allow you
to align this new Button control with the existing Button control on the form. The snap lines
assist you in aligning controls to the left, right, top, or bottom of each other, depending on
where you are trying to position the new control. The light blue line provides you with a consis-
tent margin between the edge of your control and the edge of the form. Set the Name property
to btnExit and the Text property to E&xit. Your form should look similar to Figure 1-16.

Hello from Visual Basic 2005 H|=]
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Figure 1-15
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Figure 1-16

Now before you finish your sample application, let us briefly discuss some coding practices that you
should be using.

Modified Hungarian Notation

You may have noticed that the names given to the controls look a little funny. Each name is prefixed
with a shorthand identifier describing the type of control it is. This makes it much easier to understand
what type of control you are working with when you are looking through the code. For example, say
you had a control called simply Name, without a prefix of 1b1 or txt. You would not know whether
you were working with a text box that accepted a name or with a label that displayed a name. Imagine
if, in the previous Try It Out, you had named your label Namel and your text box Name2 —you would
very quickly become confused. What if you left your application for a month or two and then came back
to it to make some changes?

When working with other developers, it is very important to keep the coding style consistent. One of the
most commonly used styles for control names within application development in many languages was
brought forth by Dr. Charles Simonyi, who worked for the Xerox Palo Alto Research Center (XPARC)
before joining Microsoft. He came up with short prefix mnemonics that allowed programmers to easily
identify the type of information a variable might contain. Since Simonyi is from Hungary, and the pre-
fixes make the names look a little foreign, the name “Hungarian Notation” came into use for this system.
Because the original notation was used in C/C++ development, the notation for Visual Basic 2005 is
termed Modified. The following table shows some of the commonly used prefixes that you shall be
using in this book.

Hungarian Notation can be a real time-saver when you are looking at code someone else wrote or at
code that you wrote months earlier. However, by far the most important thing is to be consistent in your
naming. When you start coding, pick a convention for your naming. It is recommended that you use the
de facto standard Modified-Hungarian for Visual Basic 2005, but it is not required. Once you pick a con-
vention, stick to it. When modifying others’ code, use theirs. A standard naming convention followed
throughout a project will save countless hours when the application is maintained. Now let’s get back to
the application. It’s now time to write some actual code.

17
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Control Prefix
Button btn
ComboBox cbo
CheckBox chk
Label 1bl
ListBox 1lst
MainMenu mnu
RadioButton rdb
PictureBox pic
TextBox txt

The Code Editor

Now that you have the HelloUser form defined, you have to add some code to make it actually do
something interesting. You have already seen how easy it is to add controls to a form. Providing the
functionality behind those on-screen elements is no more difficult. To add the code for a control, you
just double-click the control in question. This will open the code editor in the main window, shown
in Figure 1-17.

File  Edit Yiew Project Buld Debwg Data  Jools  Window Community  Helo

G- @ S G20 - - LB b Debug - Any CPU - | [# imgCureniavimags S =
A bhoae [EEIZ 20 |3« 5 R

. " - HelloUser.vb™| HelloUzer.vb [Designf* - X
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=i @b = | # click |
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% = Public Class HelloUser —
g FPrivate Zub btnlE_Click(ByVal sender As System.Cbject, EyVal e As System.Eventirgs) Handles htnOE.Click

T

o

;_/ End Sub

}_ll End Class
Figure 1-17

Notice that an additional tab has been created in the main window. Now you have the Design tab and
the Code tab. You draw the controls on your form in the Design tab, and you write code for your form in
the Code tab. One thing to note here is that Visual Studio 2005 has created a separate file for the code.
The visual definition and the code behind exist in separate files: HelloUser.Designer.vb and Hello
User.vb. This is actually the reason why building applications with Visual Basic 2005 is so slick and
easy. Using the Design view you can visually lay out your application, and then, using Code view, you
add just the bits of code to implement your desired functionality.

You will also notice that there are two combo boxes at the top of the window. These provide shortcuts to

the various parts of your code. Hover your mouse on the combo box on the left, and you'll see a ToolTip
appear, telling you that it is the Class Name combo box. If you expand this combo box, you will see a list
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of all the objects within your application. If you hover your mouse on the combo box on the right, you'll
see a ToolTip telling you that this is the Method Name combo box. If you expand this combo box, you
will see a list of all defined functions and subroutines for the object selected in the Class Name combo
box. If this particular form had a lot of code behind it, these combo boxes would make navigating to the
desired area very quick—jumping to the selected area in your code. However, since all of the code fits
in the window, there are not a lot of places to get lost.

Try It Out Adding Code to the HelloUser Project

1.

To begin adding the necessary code, click the Design tab to show the form again. Then double-
click the OK button. The code window will open with the following code. This is the shell of the
button’s Click event and is the place where you enter the code that you want to run when you
click the button. This code is known as an event handler and sometimes is also referred to as an
event procedure:

Private Sub btnOK_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnOK.Click

End Sub

As a result of the typographic constraints in publishing, it is not possible to put the Sub declaration on
one line. Visual Basic 2005 allows you to break up lines of code by using the underscore character (_) to
signify a line continuation. The space before the underscore is required. Any whitespace preceding the
code on the following line is ignored.

Sub is an example of a keyword. In programming terms, a keyword is a special word that is used
to tell Visual Basic 2005 to do something special. In this case, it tells Visual Basic 2005 that this is
a subroutine, a procedure that does not return a value. Anything that you type between the lines
Private Sub and End Sub will make up the event procedure for the OK button.

Now add the highlighted code into the procedure:

Private Sub btnOK_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnOK.Click

'Display a message box greeting the user
MessageBox.Show ("Hello, " & txtName.Text & _
"l Welcome to Visual Basic 2005.", _
"Hello User Message")
End Sub

Throughout this book, you will be presented with code that you should enter into your program if you
are following along. Usually, we will make it pretty obvious where you put the code, but as we go, we
will explain anything that looks out of the ordinary. The code with the gray background is code that you
should enter.

After you have added the preceding code, go back to the Design tab, and double-click the Exit
button. Add the highlighted code to the btnExit_Click event procedure.

Private Sub btnExit_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnExit.Click

'End the program and close the form
Me.Close()
End Sub 19
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You may be wondering what Me is. Me is a keyword that refers to the form. Just like the pronoun
me, it is just shorthand for referring to one’s self.

4. Now that the code is finished, the moment of truth has arrived and you can see your creation.
First though, save your work by using File &> Save HelloUser.vb from the menu or by clicking
the Save button on the toolbar.

5.  Now click the Start button on the toolbar. You will notice a lot of activity in the Output window
at the bottom of your screen. Provided you have not made any mistakes in entering the code,
this information just lets you know which files are being loaded to run your application.

It is at this point that Visual Studio 2005 will compile the code. Compiling is the activity of taking
the Visual Basic 2005 source code that you have written and translating it into a form that the
computer understands. After the compilation is complete, Visual Studio 2005 runs (also known
as executes) the program, and you’'ll be able to see the results.

If Visual Basic 2005 encounters any errors, they will be displayed as tasks in the Task List window.
Double-clicking a task transports you to the offending line of code. We will learn more about how to
debug the errors in our code in Chapter 9.

6. When the application loads, you see the main form. Enter a name and click OK (or press the
Alt+O key combination) (see Figure 1-18).

Hello from Visual Basic 2005 =]
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Figure 1-18

7. Awindow known as a message box appears, welcoming the person whose name was entered in
the text box on the form —in this case Stephanie (see Figure 1-19).

Hello User Message

Hello,Stephanie! Welcome to Visual Basic 2005.

Figure 1-19
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8.  After you close the message box by clicking the OK button, click the Exit button on your form.
The application closes and you will be returned to the Visual Basic 2005 IDE.

How It Works

The code that you added to the Click event for the OK button will take the name that was entered in the
text box and use it as part of the message that was displayed in Figure 1-19.

The first line of text entered in this procedure is actually a comment, text that is meant to be read by the
human programmer who is writing or maintaining the code, not by the computer. Comments in Visual
Basic 2005 begin with a single quote ('), and everything following on that line is considered a comment
and ignored by the compiler. Comments will be discussed in detail in Chapter 3.

The MessageBox . Show method displays a message box that accepts various parameters. As used in
your code, you have passed the string text to be displayed in the message box. This is accomplished
through the concatenation of string constants defined by text enclosed in quotes. Concatenation of strings
into one long string is performed through the use of the ampersand (&) character.

The code that follows concatenates a string constant of "Hello, " followed by the value contained in the
Text property of the txtName text box control followed by a string constant of " ! Welcome to Visual
Basic 2005. " The second parameter being passed to the MessageBox. Show method is the caption to be
used in the title bar of the Message Box dialog box.

Finally, the underscore (_) character used at the end of the lines in the following code enables you to split
your code onto separate lines. This tells the compiler that the rest of the code for the parameter is contin-
ued on the next line. This is really useful when building long strings, because it allows you to view the
entire code fragment in the Code Editor without having to scroll the Code Editor window to the right to
view the entire line of code.

Private Sub btnOK_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnOK.Click

'Display a message box greeting the user
MessageBox.Show ("Hello, " & txtName.Text & _
"1 Welcome to Visual Basic 2005.", _
"Hello User Message")
End Sub

The next procedure that you added code for was the Exit button’s Click event. Here you simply enter the
code: Me.Close (). As explained earlier, the Me keyword refers to the form itself. The Close method of
the form closes the form and releases all resources associated with it, thus ending the program.

Private Sub btnExit_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnExit.Click

'End the program and close the form

Me.Close()
End Sub
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Using the Help System
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The Help system included in Visual Basic 2005 is an improvement over Help systems in previous
versions. As you begin to learn Visual Basic 2005, you will probably become very familiar with the
Help system. However, it is worthwhile to give you an overview, just to help speed your searches
for information.

The Help menu contains the menu items shown in Figure 1-20:
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About Microsoft Yisual Studio

Figure 1-20

As you can see, this menu contains a few more entries than the typical Windows application. The main
reason for this is the vastness of the documentation. Few people could keep it all in their heads —but
luckily, that is not a problem, because you can always quickly and easily refer to the Help system. Think
of it as a safety net for your brain.

One really fantastic feature is Dynamic Help. When you select the Dynamic Help menu item from the
Help menu, the Dynamic Help window is displayed with a list of relevant topics for whatever you may
be working on. The Dynamic Help window can be displayed by clicking Help &> Dynamic Help on the
menu bar. The Dynamic Help window is then displayed as a tab behind the Properties window.

Let us say, for example, that you are working with a text box (perhaps the text box in the HelloUser
application) and want to find out some information; you just select the text box on our form or in the
code window and you can see all the help topics that pertain to text boxes, as shown in Figure 1-21

The other help commands in the Help menu (Search, Contents, and Index), function just as they would
in any other Windows application. The How Do I menu item displays the Visual Studio Help collection
with a list of common tasks that are categorized. This makes finding help on common tasks fast and
efficient.
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Figure 1-21

Summary

Hopefully, you are beginning to see that developing basic applications with Visual Basic 2005 is not

that difficult. You have taken a look at the IDE and saw how it can help you put together software very
quickly. The Toolbox enables you to add controls to your form and design a user interface very quickly
and easily. The Properties window makes configuring those controls a snap, while the Solution Explorer
gives you a bird’s eye view of the files that make up your project. You even wrote a little code.

In the coming chapters, you will go into even more detail and get comfortable writing code. Before you
go too far into Visual Basic 2005 itself, the next chapter will give you an introduction to the Microsoft
.NET Framework. This Framework is what gives all of the NET languages their ease of use, ease of
interoperability, and simplicity in learning.

To summarize, you should now be familiar with:

Q  The Integrated Development Environment (IDE)
Q  Adding controls to your form in the Designer

Q  Setting the properties of your controls
a

Adding code to your form in the code window

Exercise

Create a Windows Application with a Textbox and Button control that will display whatever is typed in
the text box when the user clicks on the button.

The answers for this exercise and those at the end of all the other chapters can be found in Appendix D.
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The Microsoft .NET
Framework

The NET Framework provides an unprecedented platform for building Windows, Web, and
mobile applications with one or more languages. It is a definitive guide, encompassing and
encapsulating where we have come from as a development community and, of course, where
we are going.

Today, .NET has been a real success in many respects. Within the NET Framework, new languages
(C# and J#) have been born, and the well-established Visual Basic language has been reborn. The
.NET Framework even supports legacy languages such as C++.

The NET Framework provides the base for all development with Visual Studio 2005. It provides
base classes, available to all Visual Studio 2005 languages. for such functions as accessing databases,
parsing XML, displaying and processing Windows and Web forms, and providing security for your
applications. All languages in Visual Studio 2005 share and use the same base classes, making your
choice of a programming language in Visual Studio 2005 a matter of personal preference and syntax

style.
In this chapter, you will examine the following topics:
Q  What the NET Framework is

d  The .NET vision

QO  Why Microsoft dared to spend $2 billion on a single development project

Microsoft’s Reliance on Windows

In terms of the great corporations of the world, Microsoft is still a new kid on the block. It is a fab-
ulously rich and successful one. Nonetheless, the company has grown from nothing to a corporate
superpower in a very short time.
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What is perhaps more interesting is that although the origin of Microsoft can be traced to the mid-1970s,
it is really the Windows family of operating systems that has brought the company great success. Based
on Presentation Manager for OS/2, Windows has seen many incarnations from Windows /286 to
Windows XP, but the essential way that you use Windows and Windows applications has not changed in
all that time. (Granted, there have been advances in the user interface and the hardware, but you still use
the version of Excel included with Office XP in roughly the same way that you used the first version.)

The scary thing to Microsoft and its investors is that the pace of technological change means that they
cannot be sure that Windows is going to be as relevant in 2011 as it is today. All it takes is one change in
the way that people want to use computers, and the Windows platform’s current incarnation may
become obsolete.

It is unfair to say that Microsoft has been extremely lucky over the past several years in the way that it
has reacted to the new opportunities offered by the Internet. Yes, luck was involved, but do not underes-
timate the number of smart people working for that company! Once they discovered that companies like
Netscape were making money with the Internet and identified the risk, they turned a large corporation
on a dime and went after an unexplored market with teeth bared. Their gamble has paid off, and with
the invention of the NET Framework, corporations and users can leverage the power of the Internet in
new ways.

Luckily for Microsoft, the applications that drove the adoption of the Internet worked well on a desktop
operating system. Microsoft managed to adapt the Windows platform to provide the two killer Internet
applications (e-mail and the Web browser) to the end user with a minimum of hassle, securing the
Windows platform for another few years. It also delivered several powerful tools for developers, such
as Active Server Pages (ASP) and Internet Information Server (IIS), and improved existing tools such as
Visual Basic and SQL, all of which made it easier for developers to build advanced Internet applications.

MSN 1.0

26

When the Internet started to become popular, Microsoft was trying to push the original incarnation of
MSN. Rather than the successful portal that it is today, MSN was originally a proprietary dial-up service
much like CompuServe. In the beginning, MSN did not provide access to the rich world of the Internet
as we know today; it was a closed system. Let us call the original MSN “MSN 1.0.”

MSN 1.0 provided an opportunity for innovative companies to steal a march on Microsoft, which was
already seen as an unshakable behemoth thanks to the combination of Windows and Office.

Imagine an alternative 1995 in which Microsoft stuck to its guns with MSN 1.0, rather than plotting the
course that brings it where it is today. Imagine that a large computer manufacturer, such as Dell, identi-
fied this burgeoning community of forward-thinking business leaders and geeks called the Internet. Also
suppose Dell predicted that Microsoft’s strategy was to usurp this community with MSN 1.0 —in other
words, rather than cooperating with this community, Microsoft decided to crush it at all costs.

Now Dell needs to find a way to build this community. It predicts that home users and small businesses
will love the Internet and so puts together a very low-cost PC. They need software to run on it and, luck-
ily, predict that the Web and e-mail will be the killer applications of this new community. They find
Linus Torvalds, who has been working on this thing called Linux since 1991, and they find Sun, which is
keen to start pushing Java as a programming language to anyone who will listen. Another business part-
ner builds a competent, usable suite of productivity applications for the platform using Java. Another
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business partner builds easy-to-use connectivity solutions that allow the computers to connect to the
Internet and other computers in the LAN, easily and cheaply.

Dell, Sun, and their selected business partners start pushing this new computer to anyone and everyone.
The concept is a success and, for the first time since 1981, the dominance of the IBM-compatible PC is
reduced, and sales of Microsoft products plummet. This is all because Microsoft did not move on a criti-
cal opportunity.

We all know that this did not happen, but there is nothing outlandish or crazy about this idea. It could
have happened, and that is what scared Microsoft. It came very close to losing everything, and .NET is
its insurance against this happening again.

The .NET Vision

To understand .NET, you have to ignore the marketing hype from Microsoft and really think about what
it is doing. With the first version of the framework and indeed even now, Microsoft appears to be push-
ing .NET as a platform for building Web Services and large-scale enterprise systems. Although we cover
Web Services in Chapter 19, it is a tiny, tiny part of what .NET is about. In simple terms, .NET splits an
operating systems platform (be it Windows, Linux, MacOS, whatever) into two layers: a programming
layer and an execution layer.

All computer platforms are trying to achieve roughly the same effect: to provide applications to the user.
If you wanted to write a book, you would have the choice of using the word processor in Star Office
under Linux or Word under Windows. However, you would be using the computer in the same way;

in other words, the application remains the same irrespective of the platform.

It is a common understanding that software support is a large part of any platform’s success. Typically,
the more high quality the available software is for a given platform, the larger the consumer adoption of
that platform will be. The PC is the dominant platform because, back in the early 1980s, that is what the
predominant target for software writers was. That trend has continued today, and people are writing
applications that run on Windows targets for the Intel x86 type processors. The x86 processor harks back
to the introduction of the Intel 8086 processor in 1979 and today includes the Intel Pentium 4 processor
and competitors like AMD’s Athlon and Duron.

So without .NET, developers are still reliant on Windows, and Windows is still reliant on Intel. Although
the relationship between Microsoft and Intel is thought to be fairly symbiotic, it is reasonable to assume
that the strategists at Microsoft, who are feeling (rightly) paranoid about the future, might want to lessen
the dependence on a single family of chips too.

The Windows/Intel combination (sometimes known as Wintel) is what is known as the execution layer.
This layer takes the code and runs it—simple as that.

Although .NET targeted the Windows platform, there is no reason why later versions of .NET cannot

be directed at other platforms. Already, there are open-source projects trying to recreate .NET for other
platforms. What this means is that a program written by a .NET developer on Windows could run
unchanged on Linux. In fact, the Mono project (.mono-project.com/) has already released its first
version of its product. This project has developed an open-source version of a C# compiler, a runtime for
the Common Language Infrastructure (CLI, also known as the Common Intermediate Language — CIL),
a subset of the .NET classes, and other .NET goodies independent of Microsoft’s involvement.
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.NET is a programming layer. It is totally owned and controlled by Microsoft. By turning all developers
into .NET programmers rather than Windows programmers, software is written as .NET software, not
Windows software.

To see the significance of this, imagine that a new platform is launched and starts eating up market
share like crazy. Imagine that, like the Internet, this new platform offers a revolutionary way of working
and living that offers real advantages. With the .NET vision in place, all Microsoft has to do to gain a
foothold on this platform is develop a version of .NET that works on it. All of the .NET software now
runs on the new platform, lessening the chance that the new platform will usurp Microsoft’s market
share.

This Sounds like Java
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Some of this does sound a lot like Java. In fact, Java’s mantra of “write once, run anywhere” fits nicely
into the .NET doctrine. However, .NET is not a Java clone. Microsoft has a different approach.

To write in Java, developers were expected to learn a new language. This language was based on C++,
and while C++ is a popular language, it is not the most popular language. In fact, the most popular lan-
guage in terms of number of developers is Visual Basic, and, obviously, Microsoft owns it. Some esti-
mates put the number of Visual Basic developers at approximately 3 million worldwide, but bear in
mind that this number includes both Visual Basic professionals and people who tinker with macros in
the various Office products.

Whereas Java is “one language, many platforms,” .NET is “many languages, one platform, for now.”
Microsoft wants to remove the barrier to entry for NET by making it accessible to anyone who has used
pretty much any language. The three primary languages for .NET are Visual Basic 2005, C#, and J#.
Visual Studio 2005 comes supplied with all of these. Although C# is not C++, the developers of C++
should be able to migrate to C# with about the same amount of relearning that a Visual Basic 6 devel-
oper will have to do in order to move to Visual Basic 2005. Of course the .NET Framework supports
developers using C++ and allows them to write C++ applications using the .NET Framework.

With Java, Sun attempted to build from the ground-up something so abstracted from the operating sys-
tem that when you compare an application written natively in something like Visual C++ with a Java
equivalent, it becomes fairly obvious that the Java version will run slower and not look as good in terms
of user interface. Sun tried to take too big a bite out of the problem by attempting to support everything,
so in the end it did not support one single thing completely.

Microsoft’s .NET strategy is more like a military campaign. First, it will use its understanding of the
Windows platform to build .NET into something that will stand against a native C++ application. It will
also try to bolster the lackluster uptake of Pocket PC with the Compact Framework. After it wins over
the voters on Windows, it may invade another platform, most likely Linux. This second stage will prove
the concept that .NET applications can be ported from one platform to the next. After invading and con-
quering Linux, it will move to another platform. Microsoft has been attempting to shake Solaris from the
top spot in the server market for a long time, so it’s likely that it'll go there next.
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Where Now?

Microsoft has bet its future on .NET. With developers writing software for the programming layer rather
than an execution layer, it really does not matter whether Windows is the dominant platform in 2011 or
Linux is, or whether something totally off the radar will be. The remainder of this chapter drills into the
mechanics of .NET and takes a detailed look at how the whole thing works.

Writing Software for Windows

To understand how .NET works, you need to look at how developers used to write software for Windows.
The general principle was the same in both cases, only they had to do things in different ways to work with
different technologies — the Component Object Model (COM), ActiveX Data Objects (ADO), and so forth.

Any software that you write has to interact with various parts of the operating system to do its job. If the
software needs a block of memory to store data in, it interacts with the memory manager. To read a file
from disk, you use the disk subsystem. To request a file from the network, you use the network subsys-
tem. To draw a window on the screen, you use the graphics subsystem, and so on.

This subsystems approach breaks down, as far as .NET is concerned, because there is no commonality
between the ways you use the subsystems on different platforms, despite the fact that platforms tend to
have things in common. For example, even if you are writing an application for Linux, you may still
need to use the network, disk, and screen subsystems. However, because different organizations devel-
oped these platforms, the way you open a file using the Linux platform may be different from the way
you do it on Windows. If you want to move code that depends on one platform to another, you will
probably have to rewrite portions of the code. You will also have to test the code to ensure it still works
as intended.

Windows software communicates with the operating system and various subsystems using something
called the Windows 32-bit Application Programming Interface (Win32 API). Although object-orientation
in programming was around at the time, this API was designed to be an evolution of the original
Windows API, which predates the massive adoption of object-oriented techniques that are discussed

in Chapter 10.

It is not easy to port the Win32 API to other platforms, which is why there is no version of the Win32 API
for Linux even though Linux has been around for a decade. There is a cut-down version of the Win32
API for the Mac, but this has never received much of an industry following.

The Win32 API provides all basic functionality, but now and again, Microsoft extends the capabilities of
Windows with a new APIL. A classic example is the Windows Internet API, also known as the WinInet
API. This API allows an application to download resources from a Web server, upload files to an FTP
server, discover proxy settings, and so on. Again, it is not object oriented, but it does work.

Alarge factor in the success of early versions of Visual Basic is that it took the tricky-to-understand
Win32 API calls and packaged them in a way that could be easily understood. Using the native Win32
AP, it takes about a hundred lines of code to draw a window on the screen. The same effect can be
achieved in Visual Basic with a few gestures of the mouse. Visual Basic represents an abstraction layer
on top of the Win32 API that makes it easier for developers to use.
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A long-time frustration for C++ developers was that a lot of the things that were very easy to do in
Visual Basic remained not so much hard as laborious in C++. Developers like C++ because it gives them
an amazing amount of control over how a program works, but their programs take longer to write.
Microsoft introduced the Microsoft Foundation Classes (MFC) because of this overhead, which, along
with the IDE of Visual Studio, brought the ease of Visual C++ development closer to that of Visual Basic.

The .NET Framework Classes

30

Unlike the Win32 API, .NET is totally object-oriented. Anything you want to do in .NET, you are going
to be doing with an object. If you want to open a file, you create an object that knows how to do this. If
you want to draw a window on the screen, you create an object that knows how to do this. When you
get to Chapter 10, you will discover that this is called encapsulation; the functionality is encapsulated in
an object, and you don’t really care how it’s done behind the scenes.

Although there is still the concept of subsystems in .NET, these subsystems are never accessed directly —
instead they are abstracted away by the Framework classes. Either way, your .NET application never has
to talk directly to the subsystem (although you can do so if you really need or want to). Rather, you talk
to objects, which then talk to the subsystem. In Figure 2-1, the box marked System.I0.Fileisa class
defined in the .NET Framework.

If you are talking to objects that talk to subsystems, do you really care what the subsystem looks like?
Thankfully the answer is “no,” and this is how Microsoft removes your reliance on Windows. If you
know the name of a file, you use the same objects to open it whether you are running on a Windows XP
machine, a Pocket PC, or even, using the Mono Project version of the NET Framework, Linux. Likewise,
if you need to display a window on the screen, you do not care whether it is on a Windows operating
system or on a Mac.

The NET Framework is actually a set of classes called base classes. The base classes in the NET
Framework are rather extensive and provide the functionality for just about anything that you need to
do in a Windows or Web environment, from working with files to working with data to working with
forms and controls.

The class library itself is vast, containing several thousand objects available to developers, although in
your day-to-day development you will only need to understand a handful of these to create powerful
applications.

Another really nice thing about the base classes in the .NET Framework is that they are the same irre-
spective of the language used. So, if you are writing a Visual Basic 2005 application, you use the same
object as you would from within a C# or J# application. That object will have the same methods, proper-
ties, and events, meaning that there is very little difference in capabilities between the languages, since
they all rely on the framework.
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Your Application

Irrespective of System.lO.File provides
whatever platform access to a file on disk
you are writing for, or network

you still only use the System.lO.File

Framework classes

; ; Programming Languages

.NET supports Windows, Execution Platforms
so System.lO.File can
communicate with
Windows 98, ME, 2000,

XP, and 2003
Windows File System Pocket PC System Linux File System
Windows Pocket PC Linux
Figure 2-1

Executing Code

The base class library is only half the equation. After you have written the code that interacts with the
classes, you still need to run it. This poses a tricky problem; to remove the reliance on the platform is to
remove the reliance on the processor.

Whenever you write software for Windows, you are guaranteed that this code will run on an Intel x86
chip. With .NET, Microsoft does not want to make this guarantee. It might be that the dominant chip in
2008 is a Transmeta chip, or something you have never even seen. What needs to be done is to abstract
.NET away from the processor, in a similar fashion to the way .NET is abstracted from the underlying
subsystem implementations.

Programming languages are somewhere in between the languages that people speak every day and the
language that the computer itself understands. The language that a computer uses is the machine code
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(sometimes called machine instructions or machine language) and consists entirely of zeros and ones, each
corresponding to electrical current flowing or not flowing through this or that part of the chip. When
you are using a PC with an Intel or competing processor, this language is more specifically known as x86
machine instructions.

If you wrote an application with Visual Basic 6, you had to compile it into a set of x86 machine instruc-
tions before you could deploy it. This machine code would then be installed and executed on any
machine that supported x86 instructions and was also running Windows.

If you write an application with Visual Basic 2005, you still have to compile the code. However, you do
not compile the Visual Basic 2005 code directly into x86 machine instructions, because that would mean
that the resulting program would run only on processors that support this language —in other words,
the program would run only on Intel chips and their compatible competitors. Instead, compilation cre-
ates something called Microsoft Intermediate Language (MSIL). This language is not dependent on any
processor. It is a layer above the traditional machine code.

MSIL code will not just run on any processor, because processors do not understand MSIL. To run the
code, it has to be further compiled, as shown in Figure 2-2, from MSIL code into the native code that the
processor understands.

However, this approach also provides the industry with a subtle problem. In a world where .NET is
extremely popular (some might say dominant), who is responsible for developing an MSIL-to-native
compiler when a new processor is released? Is the new processor at the mercy of Microsoft’s willingness
to port .NET to the chip? Time, as they say, will tell!

Take a look at the thing that makes .NET work: the Common Language Runtime.

. . With VB6 the program source code
Visual Basic is converted to x86 instructions
Source Code (also known as ‘native’ or

‘machine’ code)

Visual Basw X86 Instructions
Compiler
) . With VB.NET the Before the program executes a portion
Visual Basic.NET source is compiled into  of code it converts the MSIL instructions
Source Code MSIL instructions to x86 instructions; this is known as
Just in Time (JIT) compilation
Visual Ba§|c.NET MSIL MSIL to x86 X86 Instruction Set
Compiler Converter
Figure 2-2
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Common Language Runtime

The Common Language Runtime, also known as the CLR, is the heart of .NET. The Common Language

Runtime takes your .NET application, compiles it into native processor code, and runs it. It provides an

extensive range of functionalities for helping the applications run properly, so look at each one in turn.
Q  Code loading and execution

Application isolation

Memory management

Security

Exception handling

U 000U o

Interoperation

Do not worry if you do not understand what all these are — the following sections discuss all of them
except for memory management. Memory management is quite a complex subject and is discussed in
Chapter 11.

Code Loading and Execution

This part of the Common Language Runtime deals with reading the MSIL code from the disk and run-
ning it. It compiles the code from MSIL into the native language (machine code) that the processor
understands.

Java also has a concept similar to MSIL, known as byte code.

Application Isolation

One important premise of modern operating systems like Windows and Linux is that applications are
isolated from one another. This is critically important from both security and stability standpoints.

Imagine that you have a badly written program and it crashes the PC. Should this happen? No, you
want only the badly behaved program to crash, as you do not want other applications or the operating
system itself to be affected by a program running on it. For example, if your e-mail program crashes, you
do not want to lose any unsaved changes in your word processor. With proper application isolation, one
application crashing should not cause others to crash.

In some instances, even under Windows XP, a badly behaved program can do something so horrendous
that the entire machine crashes. This is commonly known as a Blue Screen of Death, or BSOD, so called
because your attractive Windows desktop is replaced with a stark blue screen with a smattering of white
text “explaining” the problem. This problem should be alleviated in .NET, but it is unlikely to be com-
pletely solved.

The other aspect to application isolation is one of security. Imagine that you are writing a personal and

sensitive e-mail. You do not want other applications running on your computer to be able to grab, or
even stumble across, the contents of the e-mail and pass it on to someone else. Applications running in
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an isolated model cannot just take what they want. Instead, they have to ask whether they can have
something, and they are given it only if the operating system permits it.

This level of application isolation is already available in Windows. .NET extends and enhances this func-
tionality by further improving it.

Security

.NET has powerful support for the concept of code security. This was designed to give system adminis-
trators, users, and software developers a fine level of control over what a program can and cannot do.

Imagine that you have a program that scans your computer’s hard disk looking for Word documents.
You might think this is a useful program if it is the one that you run yourself to find documents that are
missing. Now imagine that this program is delivered through e-mail and it automatically runs and
e-mails copies of any “interesting” documents to someone else. You are less likely to find that useful.

This is the situation you find yourself in today with old-school Windows development. To all intents and
purposes, Windows applications have unrestricted access over your computer and can do pretty much
anything they want. That is why the Melissa and I Love You-type viruses are possible —Windows does
not understand the difference between a benign script file you write yourself that, say, looks through
your address book and sends e-mails to everyone, and those written by someone else and delivered as
viruses.

With .NET this situation changes because of the security features built into the Common Language
Runtime. Under the CLR, code requires evidence to run. This evidence can be policies set by you and
your system administrator, as well as the origin of the code (for example, whether it came off your local
machine, off a machine on your office network, or over the Internet).

Security is a very involved topic and is not covered in this book. However, you can find more informa-
tion in . NET Security Programming (ISBN 0-471-22285-2), written by Donis Marshall and published by
Wiley.

Interoperation

Interoperation in the NET Framework is achieved on various levels not covered here. However, we
must point out some of the types of interoperation that it provides. One kind of interoperation is at the
core of the framework, where data types are shared by all managed languages. This is known as the
Common Type System (CTS). This is a great improvement for language interoperability (see the section
“The Common Type System and Common Language Specification” later in this chapter).

The other type of interoperation is that of communicating with existing Component Object Model

(COM) interfaces. Because a large application software base is written in COM, it was inevitable that
.NET should be able to communicate with existing COM libraries. This is also known as COM interop.

Exception Handling

Exception handling is the concept of dealing with “exceptional happenings” when you are running the
code. Imagine that you have written a program that opens a file on disk. What if that file is not there?
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Well, the fact that the file is not there is exceptional, and you need to deal with it in some way. It could be
that you crash, or you could display a window asking the user to supply a new filename. Either way,
you have a fine level of control over what happens when an error does occur.

.NET provides a powerful exception handler that can “catch” exceptions when they occur and give your
programs the opportunity to react and deal with the problem in some way. Chapter 9 talks about excep-
tion handling in more detail, but for now, think of exception handling as something provided by the
Common Language Runtime to all applications.

The Common Type System and Common
Language Specification

One of the most important aspects of .NET that Microsoft had to get right is interlanguage operation.
Remember, Microsoft’s motivation was to get any developer using any language using .NET, and for this
to happen, all languages had to be treated equally. Likewise, applications created in one language have
to be understood by other languages. For example, if you create a class in Visual Basic 2005, a C# devel-
oper should be able to use and extend that class. Alternatively, you may need to define a string in C#,
pass that string to an object built in Visual Basic 2005, and make that object understand and manipulate
the string successfully.

The Common Type System (CTS) allows software written in different languages to work together. Before
.NET, Visual Basic and C++ handled strings in completely differently ways, and you had to go through a
conversion process each time you went from one to the other. With the Common Type System in place,
Visual Basic 2005, C#, and other .NET languages use strings, integers, and so on, in the same way, and
therefore no conversion needs to take place.

In addition, the Common Language Specification (CLS) was introduced by Microsoft to make it easier
for language developers to adapt their languages to make them compatible with .NET.

The Common Type System and Common Language Specification are the foundation for this interopera-
tion, but detailed discussion is, unfortunately, beyond the scope of this book.

When talking to other .NET developers, it is likely that you will hear the term managed code. This simply
describes code that runs inside the Common Language Runtime. In other words, you get all of the
advantages of the Common Language Runtime, such as the memory management and all of the lan-
guage interoperability features previously mentioned.

Code written in Visual Basic 2005, C#, and J# is automatically created as managed code. C++ code is not
automatically created as managed code, because C++ does not fit well into the memory management
scheme implemented by the Common Language Runtime. You can, if you are interested, turn on an
option to create managed code from within C++, in which case you use the term managed C++.

Hand-in-hand with managed code is managed data. As you can probably guess, this is data managed

by the Common Language Runtime, although in nearly all cases this data actually consists of objects.
Objects managed by the Common Language Runtime can easily be passed between languages.

35



Chapter 2

Summary
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This chapter introduced the Microsoft .NET Framework and why Microsoft had to choose to radically
change the way programs were written for Windows. You also saw that part of Microsoft’s motivation
for this was to move the dependence of developers from the execution platform (Windows, Linux, what-
ever) over to a new programming platform that it would always own.

After learning about why Microsoft developed .NET, you saw how writing for it is not much different
from writing for Windows. You still have a layer that you program against; it is just that now, rather than
being flat like the Win32 AP], it is a rich set of classes that allows you to write true object-oriented pro-
grams. This chapter also discussed how these classes could be ported to other platforms and how our
applications could transfer across.

Finally, you looked at some of the more technical aspects of the NET Framework, specifically the
Common Language Runtime.

To summarize, you should now understand:

QO  Microsoft’s new business venture

Q  The goals of the .NET Framework

Q  The abstractions that the NET Framework provides
Q

An introduction to the core of the .NET Framework
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Now that you have gotten Visual Basic 2005 up and running and even written a simple but work-
ing program, you're going to look at the fundamentals behind the process of writing software and
start putting together some exciting programs of your own.

In this chapter, you will:

Q  Learn about algorithms
Learn to use variables

Explore different data types including integers, floating-point numbers, strings, and dates

a
a
Q  Study scope
Q  Learn about debugging applications
a

Learn more about how computers store data in memory

Information and Data

Information describes facts and can be presented or found in any format, whether that format is
optimized for humans or for computers. For example, if you send four people out to different
intersections to survey traffic, at the end of the process you will end up with four handwritten tal-
lies of the number of cars that went past (say, a tally for each hour).

The term data is used to describe information that has been collated, ordered, and formatted in
such a way that it can be directly used by a piece of computer software. The information you have
(several notebooks full of handwritten scribbles) cannot be directly used by a piece of software.
Rather, someone has to work with it to convert it into data. For example, the scribbles can be trans-
ferred to an Excel spreadsheet that can be directly used by a piece of software designed to analyze
the results.
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Algorithms
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The computer industry is commonly regarded as one that changes at an incredible speed. Most profes-
sionals find themselves constantly retraining and re-educating to keep their skills sharp and up to date.
However, some aspects of computing haven't really changed since they were first invented and perhaps
won’t change within our lifetimes. The process and discipline of software development is a good exam-
ple of an aspect of computer technology whose essential nature hasn’t changed since the beginning.

For software to work, you need to have some data to work with. The software then takes this data and
manipulates it into another form. For example, software may take your customer database stored as
ones and zeros on your computer’s disk and make it available for you to read on your computer’s moni-
tor. The on-board computer in your car constantly examines environmental and performance informa-
tion and continually adjusts the fuel mix to make the car run more efficiently. Your telephone service
provider records the calls you make and generates bills based on this information.

The base underpinning all software is the algorithm. Before you can write software to solve a problem,
you have to break it down into a step-by-step description of how the problem is going to be solved. An
algorithm is independent of the programming language, so, if you like, you can describe it to yourself
either as a spoken language, with diagrams, or with whatever helps you visualize the problem.

Imagine that you work for a telephone company and need to produce bills based on calls that your cus-
tomers make. Here’s an algorithm that describes a possible solution:

1.  On the first day of the month, you need to produce a bill for each customer you have.

2.  For each customer, you have a list of calls that the customer has made in the previous month.

3.  You know the duration of each call, and the time of day when the call was made. Based on this
information, you can determine the cost of each call.

For each bill, you total up the cost of each call.

If a customer spends more than a preset limit, you give that customer a 10% discount.

o ok

You apply sales tax to each bill.
7. After you have the final bill, you need to print it.

Those seven points describe, fairly completely, an algorithm for a piece of software that generates bills
for a telephone company. At the end of the day, it doesn’t matter whether you build this solution in
C++, Visual Basic 2005, C#, J#, Java, or whatever — the basic algorithms of the software never change.
(However, it’s important to realize that each of those seven parts of the algorithm may well be made
up of smaller, more detailed algorithms.)

The good news for a newcomer to programming is that algorithms are usually easy to construct. There
shouldn’t be anything in the preceding algorithm that you don’t understand. Algorithms always follow
common-sense reasoning, although you may find yourself in a position in which you have to code algo-
rithms that contain complex mathematical or scientific reasoning. It may not seem like common sense to
you, but it will to someone else! The bad news is that the process of turning the algorithm into code can
be arduous. As a programmer, learning how to construct algorithms is the most important skill you will
ever obtain.

All good programmers respect the fact that the preferred language of the programmer is largely irrele-
vant. Different languages are good at doing different things. C++ gives the developer a lot of control
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over the way a program works; however, it’s harder to write software in C++ than it is in Visual Basic
2005. Likewise, building the user interface for desktop applications is far easier to do in Visual Basic 2005
than it is in C++. (Some of these problems do go away when you use managed C++ with .NET, so this
statement is less true today than it was years ago.) What you need to learn to do as a programmer is to
adapt different languages to achieve solutions to a problem in the best possible way. Although when you
begin programming you’ll be “hooked” on one language, remember that different languages are focused
toward developing different kinds of solutions. At some point, you may have to take your basic skills as
an algorithm designer and coder to a new language.

What Is a Programming Language?

In one way, you can regard a programming language as anything capable of making a decision.
Computers are very good at making decisions, but they have to be fairly basic, for example: “Is this
number greater than three?” or “Is this car blue?”

If you have a complicated decision to make, the process of making that decision has to be broken down
into simple parts that the computer can understand. You use algorithms to determine how to break
down a complicated decision into simpler ones.

A good example of a problem that’s hard for a computer to solve is recognizing peoples’ faces. You can’t
just say to a computer, “Is this a picture of Dave?” Instead, you have to break the question down into a
series of simpler questions that the computer can understand.

The decisions that you ask computers to make will have one of two possible answers: yes and no. These
possibilities are also referred to as true and false and also as 1 and 0. In software terms, you cannot make
a decision based on the question, “How much bigger is 10 compared to 4?” Instead, you have to make

a decision based on the question, “Is 10 bigger than 4?” The difference is subtle, yet important — the
first question does not yield an answer of yes or no, whereas the second question does. Of course, a
computer is more than capable of answering the first question, but this is actually done through an
operation; in other words, you have to actually subtract 4 from 10 to use the result in some other part

of your algorithm.

You might be looking at the requirement for yes/no answers as a limitation, but it isn’t really. Even in
our everyday lives the decisions we make are of the same kind. Whenever you decide something, you
accept (yes, true, 1) something and reject (no, false, 0) something else.

You are using Visual Basic 2005 for a language, but the important aspects of programming are largely
language independent. Understanding that any software, no matter how flashy it is, or which language
it is written in, is made up of methods (functions and subroutines: the lines of code that actually imple-
ment the algorithm) and variables (place holders for the data the methods manipulate) is key.

Variables

A variable is something that you store a value in as you work through your algorithm. You can then
make a decision based on that value (for example, “Is it equal to 7?”, “Is it more than 4?”), or you can
perform operations on that value to change it into something else (for example, “Add 2 to the value”,
“Multiply it by 6”, and so on).
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Working with Variables

Before you get bogged down in code for a moment, look at another algorithm:

1. Create a variable called n and store in it the value 27.
2. Add 1 to the value of the variable called n and store that value in the variable called n.

3. Display the value of the variable called n to the user.

In this algorithm, you're creating a variable called n and storing in it the value 27. What this means is
that there’s a part of the computer’s memory that is being used by the program to store the value 27.
That piece of memory keeps storing that value until you change it or tell the program that you don’t
need it any more.

In the second step, you're performing an add operation. You're taking n and adding 1 to its value. After
you've performed this operation, the piece of memory given over to storing n contains the value 28.

In the final point, you want to tell the user what the value of n is. So you read the current value from
memory and write it out to the screen.

Again, there’s nothing about the algorithm there that you can’t understand. It’s just common sense!
However, the Visual Basic 2005 code looks a little more cryptic. In the following Try It Out, you learn
more about working with variables first hand.

Try It Out

1. Create a new project in Visual Studio 2005 by selecting File &> New = Project from the menu bar.
In the New Project dialog box, select Windows Application from the right-hand pane and enter
the project name as Variables and click OK. (See Figure 3-1.)

Working with Variables
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Figure 3-1
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2. Make Forml a little smaller and add a Button control from the Toolbox to it. Set the button’s
Text property to Add 1 to intNumber and its Name property to btnAdd. Your form should look
like Figure 3-2.

Form1 [_ O] x|

Add 1 tointhumnber |

Figure 3-2

3.  Double-click the button to open the btnAdd_c1lick event handler. Add the following high-
lighted code to it:

Private Sub btnAdd_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnAdd.Click

Dim intNumber As Integer

intNumber = 27

intNumber = intNumber + 1

MessageBox.Show ("Value of intNumber + 1 = " & intNumber, "Variables")
End Sub

4. Run the project, click the Add 1 to intNumber button, and you'll see a message box like the one
in Figure 3-3.

Variahles

Value of intNumber + 1= 28

Figure 3-3

How It Works

The program starts at the top and works its way down, one line at a time, to the bottom. The first line
defines a new variable, called intNumber:

Dim intNumber As Integer

Dimis a keyword. As stated in Chapter 1, a keyword has a special meaning in Visual Basic 2005 and is
used for things such as commands. Dim tells Visual Basic 2005 that what follows is a variable definition.

Its curious name harks back to the original versions of the BASIC language. BASIC has always needed

to know how much space to reserve for an array (discussed in Chapter 5), so it had a command to tell it
the “dimensions” of the array— Dim for short. Visual Basic extends that command to all other kinds of
variables as well to mean “make some space for” in general.
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The variable name comes next and is intNumber. Notice that the variable name uses the Modified
Hungarian notation discussed in Chapter 1. In this case the prefix int is short for Integer, which repre-
sents the data type for this variable, as described in the following paragraph. Then a name was chosen
for this variable; in this case the name is Number. Whenever you see this variable throughout your code,
you know that this variable will represent a number that is of the Integer data type.

As Integer tells Visual Basic 2005 what kind of value you want to store in the variable. This is known as
the data type. For now, all you need to know is that this is used to tell Visual Basic 2005 that you expect to
store an integer (whole number) value in the variable.

The next line sets the value of intNumber:

intNumber = 27
In other words, it stores the value 27 in the variable intNumber.
The next statement simply adds 1 to the variable intNumber:
intNumber = intNumber + 1
What this line actually means is “Keep the current value of intNumber and add 1 to it.”
The final line displays a message box dialog box with the text value of intNumber + 1 = and the cur-
rent value of intNumber. You've also set the title of the message box dialog box to Variables to match

the project name:

MessageBox.Show("Value of intNumber + 1 = " & intNumber, "Variables")

Comments and Whitespace

When writing software code, you must be constantly aware that you or someone else may have to
change that code in the future. Therefore, you should try to make it as easy to understand as possible.

Comments
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Comments are parts of a program that are ignored by the Visual Basic 2005 compiler, which means you
can write whatever you like in them, be it English, C#, Perl, FORTRAN, Chinese, whatever. What they’re
supposed to do is help the human developer reading the code understand what each part of the code is
supposed to be doing.

All languages support comments, not just Visual Basic 2005. If you're looking at C# code, for example,
you'll find that comments start with a double forward slash (//).

What's a good way of knowing when you need a comment? Well, it’s different for different situations,
but a good rule of thumb is to think about the algorithm. The program in the previous Try It Out had
this algorithm:
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1. Define a value for intNumber.
2. Add 1 to the value of intNumber.

3. Display the new value of intNumber to the user.
You can add comments to the code from that example to match the steps in the algorithm:

'Define a variable for intNumber

Dim intNumber As Integer

'Set the initial value

intNumber = 27

'Add 1 to the value of intNumber

intNumber = intNumber + 1

'Display the new value of intNumber

MessageBox.Show ("Value of intNumber + 1 = " & intNumber, "Variables")

In Visual Basic 2005, you begin your comments with an apostrophe ('). Anything on the same line fol-
lowing that apostrophe is your comment. You can also add comments onto a line that already has code,
like this:

intNumber = intNumber + 1 'Add 1 to the value of intNumber

This works just as well, because only comments (not code) follow the apostrophe. Notice that the com-
ments in the preceding code, more or less, match the algorithm. A good technique for adding comments
is to write a few words explaining the stage of the algorithm that’s being expressed as software code.

You can also use the built-in XML Document Comment feature of Visual Studio 2005 to create comment
blocks for your methods. To use this feature, place your cursor on the blank line preceding your method
definition and type three consecutive apostrophes. The comment block will automatically be inserted as
shown in the highlighted code here.

'Y <summary>

'Y </summary>

'''" <param name="sender"></param>

''' <param name="e"></param>

"' <remarks></remarks>

Private Sub btnAdd Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnAdd.Click

What's really cool about this feature is that Visual Studio 2005 will automatically fill in the name values
of the parameters in the comment block based on the parameters defined in your method. If your

method does not have any parameters, the <param> element will not be inserted into the comment
block.

Once a comment block has been inserted, you can provide a summary of what the method does and any
special remarks that may need to be noted before this method is called or any other special requirements
of the method. If the method returns a value, then a <returns> element will also be inserted, and you
can insert the return value and description.
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Comments are primarily used to make the code easier to understand, either to a new developer who's
never seen your code before or to you when you haven’t reviewed your code for a while. The purpose of
a comment is to point out something that might not be immediately obvious or to summarize code to
enable the developer to understand what’s going on without having to ponder each and every line.

You'll find that programmers have their own guidelines about how to write comments. If you work for a
larger software company, or your manager/mentor is hot on coding standards, they’ll dictate which for-
mats your comments should take and where you should and should not add comments to the code.

White Space

D

Another important aspect of writing readable code is to leave lots of white space. White space (space on
the screen or page not occupied by characters) makes code easier to read, just as spaces do in English. In
the last example, there is a blank line before each comment. This implies to anyone reading the code that
each block is a unit of work, which it is.

You'll be coming back to the idea of white space in the next chapter when we discuss controlling the
flow through your programs using special code blocks, but you'll find that the use of whitespace varies
between developers. For now, remember not to be afraid to space out your code —it’ll greatly improve
the readability of your programs, especially as you write long chunks of code.

The compiler ignores white space and comments, so there are no performance differences between code
with lots of white space and comments and code with none.

ata Types

When you use variables, it’s a good idea to know ahead of time the things that you want to store in
them. So far in this chapter, you've seen a variable that holds an integer number.

When you define a variable, you must tell Visual Basic 2005 the type of data that should be stored in it.
As you might have guessed, this is known as the data type, and all meaningful programming languages
have a vast array of different data types to choose from. The data type of a variable has a great impact on
how the computer will run your code. In this section, you'll take a deeper look at how variables work
and how their types affect the performance of your program.

Working with Numbers
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When you work with numbers in Visual Basic 2005, you'll be working with two kinds of numbers: inte-
gers and floating-point numbers. Both have very specific uses. Integers are usually not much use for calcu-
lations of quantities, for example, calculating how much money you have left on your mortgage or
calculating how long it would take to fill a swimming pool with water. For these kinds of calculations,
you're more likely to use floating-point variables because they can be used to represent numbers with
fractional parts, whereas integer variables can hold only whole numbers.

On the other hand, oddly, you'll find that in your day-to-day activities you're far more likely to use inte-
ger variables than floating-point variables. Most of the software that you write will use numbers to keep
track of what is going on by counting, rather than to calculate quantities.
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For example, suppose you are writing a program that displays customer details on the screen. Let’s also
suppose you have 100 customers in your database. When the program starts, you'll display the first cus-
tomer on the screen. You also need to keep track of which customer is being displayed, so that when the
user says, “Next, please,” you'll actually know which one is next.

Because a computer is more comfortable working with numbers than with anything else, you'll usually
find that each customer has been given a unique number. This unique number will, in virtually all cases,
be an integer. What this means is that each of your customers will have a unique integer number
between 1 and 100 assigned to them. In your program, you'll also have a variable that stores the ID of
the customer that you're currently looking at. When the user asks to see the next customer, you add one
to that ID (“increment by one”) and display the new customer.

You'll see how this kind of thing works as you move on to more advanced topics, but for now, rest
assured that you're more likely to use integers than floating-point numbers. Take a look now at some
common operations.

Common Integer Math Operations

In this section, you create a new project for your math operations.

Try It Out Common Integer Math

1. Create a new project in Visual Studio 2005 by selecting File => New = Project from the menu. In
the New Project dialog box, select Windows Application from the right pane (refer to Figure
3-1), and enter the project name as IntegerMath and click OK.

2.  Using the Toolbox, add a new Button control to Form1 as before. Set its Name property to
btnIntMath and its Text property to Math Test. Double-click it and add the following high-
lighted code to the new Click event handler that will be created:

Private Sub btnIntMath_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnIntMath.Click

'Declare variable
Dim intNumber As Integer

'Set number, add numbers, and display results

intNumber = 16

intNumber = intNumber + 8

MessageBox.Show ("Addition test... " & intNumber, "Integer Math")

'Set number, subtract numbers, and display results

intNumber = 24

intNumber = intNumber - 2

MessageBox.Show ("Subtraction test... " & intNumber, "Integer Math")

'Set number, multiply numbers, and display results
intNumber = 6
intNumber = intNumber * 10

MessageBox.Show ("Multiplication test... " & intNumber, "Integer Math")

'Set number, divide numbers, and display results
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intNumber = 12
intNumber = intNumber / 6
MessageBox.Show("Division test... " & intNumber,

End Sub

"Integer Math")

3.  Run the project and click the Math Test button. You'll be able to click through four message box
dialog boxes, as shown in Figure 3-4.

Integer Math [ ] Integer Math [ ]
Addition test... 24 Subtraction test... 22
Integer Math Integer Math
Multiplication test... 60 Division test... 2
Figure 3-4

How It Works

Hopefully, none of the code you've seen should be too baffling. You've already seen the addition opera-

tor before. Here it is again:

'Set number, add numbers, and display results

intNumber = 16
intNumber = intNumber + 8

MessageBox.Show ("Addition test... " & intNumber, "Integer Math")

So, all you're saying is this:

1. LetintNumber be equal to the value 16.
2. Then, let intNumber be equal to the current value of intNumber (which is 16) plus 8.

As you can see from the message dialog box shown in Figure 3-4, you get a result of 24, which is correct.
The subtraction operator is a minus (-) sign. Here it is in action:

'Set number, subtract numbers, and display results

intNumber = 24

intNumber = intNumber - 2

MessageBox.Show ("Subtraction test... " & intNumber, "Integer Math")

Again, same deal as before:

1. Let intNumber be equal to the value 24.
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2. Let intNumber be equal to the current value of intNumber (which is 24) minus 2.

The multiplication operator is an asterisk (*). Here it is in action:

'Set number, multiply numbers, and display results

intNumber = 6
intNumber = intNumber * 10

MessageBox.Show ("Multiplication test... " & intNumber, "Integer Math")

Here your algorithm states:

1. Let intNumber be equal to the value 6.

2. Let intNumber be equal to the current value of intNumber (which is 6) times 10.

Finally, the division operator is a forward slash (/). Here it is in action:

'Set number, divide numbers, and display results

intNumber = 12
intNumber = intNumber / 6
MessageBox.Show ("Division test... " & intNumber, "Integer Math")

Again, all you're saying is:

1. Let intNumber be equal to the value 12.
2. Let intNumber be equal to the current value of intNumber (which is 12) divided by 6.

Integer Math Shorthand
In the next Try It Out, you'll see how can perform the same operations without having to write as much
code by using shorthand operators (assignment operators). Although they look a little less logical than
their more verbose counterparts, you'll soon learn to love them.

Try It Out Using Shorthand Operators

1. Goback to Visual Studio 2005 and open the code for Form1 . vb again. Change the highlighted
lines:

Private Sub btnIntMath_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnIntMath.Click

'Declare variable
Dim intNumber As Integer

'Set number, add numbers, and display results
intNumber = 16

intNumber += 8
MessageBox.Show ("Addition test... " & intNumber, "Integer Math")

'Set number, subtract numbers, and display results
intNumber = 24

intNumber -= 2
MessageBox.Show ("Subtraction test... " & intNumber, "Integer Math")
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'Set number, multiply numbers, and display results

intNumber = 6

intNumber *= 10

MessageBox.Show ("Multiplication test... " & intNumber, "Integer Math")

'Set number, divide numbers, and display results

intNumber = 12

intNumber /= 6

MessageBox.Show ("Division test... " & intNumber, "Integer Math")
End Sub

2. Run the project and click the Math Test button. You'll get the same results as in the previous Try
It Out.

How It Works

To use the shorthand version you just drop the last intNumber variable and move the operator to the
left of the equals sign. Here is the old version:

intNumber = intNumber + 8
... and here’s the new version:

intNumber += 8

The Problem with Integer Math

The main problem with integer math is that you can’t do anything that involves a number with a frac-
tional part. For example, you can’t do this:

'Try multiplying numbers. ..
intNumber = 6
intNumber = intNumber * 10.23

Or, rather, you can actually run that code, but you won’t get the result you were expecting. Because
intNumber has been defined as a variable designed to accept an integer only; the result is rounded

up or down to the nearest integer. In this case, although the actual answer is 61 .38, intNumber will
be set to the value 61. If the answer were 61 .73, intNumber would be set to 62.

A similar problem occurs with division. Here’s another piece of code:

'Try dividing numbers...

intNumber = 12

intNumber = intNumber / 7
This time the answer is 1. 71. However, because the result has to be rounded up in order for it to be
stored in intNumber, you end up with intNumber being set equal to 2. As you can imagine, if you were
trying to write programs that actually calculated some form of value, you’'d be in big trouble, as every

step in the calculation would be subject to rounding errors.

In the next section, you'll look at how you can do these kinds of operations with floating-point numbers.
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Floating-Point Math

So, you know that integers are not good for most mathematical calculations because most calculations of
these types involve a fractional component of some quantity. Later in this chapter, you'll see how to use
floating-point numbers to calculate the area of a circle, but in the next Try It Out, We'll just introduce the
concepts.

Try It Out Floating Point Math

1. Create a new Windows Application project in Visual Studio 2005 called Floating-Pt Math. As
before, place a button on the form, setting its name to btnFloatMath and its Text to Double Test.

2. Double-click btnFloatMath and add the following highlighted code:

Private Sub btnFloatMath_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnFloatMath.Click

'Declare variable
Dim dblNumber As Double

'Set number, multiply numbers, and display results

dblNumber = 45.34

dblNumber *= 4.333

MessageBox.Show ("Multiplication test... " & dblNumber, "Floating Points")

'Set number, divide numbers, and display results

dblNumber = 12

dblNumber /= 7

MessageBox.Show ("Division test... " & dblNumber, "Floating Points")
End Sub

3. Run the project and you'll see the results shown in Figure 3-5.

Floating Points Floating Points
Multiplication test... 196.45822 Division test... 1.71428571428571
Figure 3-5

How It Works

Perhaps the most important change in this code is the way you're defining your variable:

'Declare variable
Dim dblNumber As Double

Rather than saying As Integer at the end, you're saying As Double. This tells Visual Basic 2005 that

you want to create a variable that holds a double-precision floating-point number, rather than an integer
number. This means that any operation performed on db1Number will be a floating-point operation,
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rather than an integer operation. Also notice that you have used a different Modified Hungarian nota-
tion prefix to signify that this variable contains a number that is of the Double data type.

However, there’s no difference in the way either of these operations is performed. Here, you set
dblNumber to be a decimal number and then multiply it by another decimal number:

'Set number, multiply numbers, and display results

dblNumber = 45.34

dblNumber *= 4.333

MessageBox.Show("Multiplication test... " & dblNumber, "Floating Points")

When you run this, you get a result of 196. 45822, which, as you can see, has a decimal component, and
therefore you can use this in calculations.

Of course, floating-point numbers don’t have to have an explicit decimal component:

'Set number, divide numbers, and display results

dblNumber = 12

dblNumber /= 7

MessageBox.Show("Division test... " & dblNumber, "Floating Points")

This result still yields a floating-point result, because db1Number has been set up to hold such a result.
You can see this by your result of 1.71428571428571, which is the same result you were looking for
when you were examining integer math.

A floating-point number gets its name because it is stored like a number written in scientific notation on
paper. In scientific notation, the number is given as a power of ten and a number between 1 and 10 that is
multiplied by that power of ten to get the original number. For example, 10,001 is written 1.0001 _ 10%,
and 0.0010001 is written 1.0001 _ 1073. The decimal point “floats” to the position after the first digit in
both cases. The advantage is that large numbers and small numbers are represented with the same degree
of precision (in this example, one part in 10,000). A floating-point variable is stored in the same way
inside the computer, but in base two instead of base ten (see “Storing Variables,” later in this section).

Other States

Floating-point variables can hold a few other values besides decimal numbers. Specifically, these are:

0 NaN—which means “not a number”
Q  Positive infinity
Q  Negative infinity

We won’t show how to get all of the results here, but the mathematicians among you will recognize that
NET will cater to their advanced math needs.

Single-Precision Floating-Point Numbers

We've been saying “double-precision floating-point.” In .NET, there are two main ways to represent
floating-point numbers, depending on your needs. In certain cases the decimal fractional components
of numbers can zoom off to infinity (pi being a particularly obvious example), but the computer does
not have an infinite amount of space to hold digits, so there has to be some limit at which the computer
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stops keeping track of the digits to the right of the decimal point. The limit is related to the size of the
variable, which is a subject discussed in much more detail toward the end of this chapter. There are also
limits on how large the component to the left of the decimal point can be.

A double-precision floating-point number can hold any value between 1.7 (10® and + 1.7 (10°® to a
great level of accuracy (one penny in 45 trillion dollars). A single-precision floating-point number can
only hold between —3.4 ( 10% and +3.4 ( 10%. Again, this is still a pretty huge number, but it holds deci-
mal components to a lesser degree of accuracy (one penny in only $330,000) — the benefit being that
single-precision floating-point numbers require less memory and calculations involving them are faster
on some computers.

You should avoid using double-precision numbers unless you actually require more accuracy than the
single-precision type allows. This is especially important in very large applications, where using double-
precision numbers for variables that only require single-precision numbers could slow up your program
significantly.

The calculations you're trying to perform will dictate which type of floating-point number you should
use. If you want to use a single-precision number, use As Single rather than As Double, like this:

Dim sngNumber As Single

Working with Strings

A string is a sequence of characters, and you use double quotes to mark its beginning and end. You've
seen how to use strings to display the results of simple programs on the screen. Strings are commonly
used for exactly this function — telling the user what happened and what needs to happen next. Another
common use is storing a piece of text for later use in an algorithm. You'll see lots of strings throughout
the rest of the book. So far, you've used strings like this:

MessageBox.Show ("Multiplication test... " & dblNumber, "Floating Points")

"Multiplication test..." and "Floating Points" are strings; you can tell because of the double
quotes ("). However, what about db1Number? The value contained within db1Number is being con-
verted to a string value that can be displayed on the screen. (This is a pretty advanced topic that’s cov-
ered later in the chapter, but for now, concentrate on the fact that a conversion is taking place.) For
example, if db1Number represents the value 27, to display it on the screen it has to be converted into a
string two characters in length. In the next Try It Out, you look at some of the things you can do with
strings.

Try It Out Using Strings
1. Create a new Windows application using the File = New = Project menu option. Call it Strings.

2. Using the Toolbox, draw a button with the Name property btnStrings on the form and set its
Text property to Using Strings. Double-click it and then add the highlighted code:

Private Sub btnStrings_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnStrings.Click
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'Declare variable
Dim strData As String

'Set the string value
strData = "Hello, world!"

'Display the results
MessageBox.Show(strData, "Strings")
End Sub

3.  Run the project and click the Using Strings button. You'll see a message like the one in
Figure 3-6.

Strings

Hello, world!

Figure 3-6

How It Works

You can define a variable that holds a string using a similar notation to that used with the number vari-
ables, but this time using As String:

'Declare variable
Dim strData As String

You can also set that string to have a value, again as before:

'Set the string value
strData = "Hello, world!"

You need to use double quotes around the string value to delimit the string, meaning to mark where the
string begins and where the string ends. This is an important point, because these double quotes tell the
Visual Basic 2005 compiler not to try to compile the text that is contained within the string. If you don’t
include the quotes, Visual Basic 2005 treats the value stored in the variable as part of the program’s code,
tries to compile it, and can’t, causing the whole program to fail to compile.

With the value Hello, world! stored in a string variable called strData, you can pass that variable to
the message box whose job it is to then extract the value from the variable and display it. So, you can see
that strings can be defined and used in the same way as the numeric values you saw before. Now look at
how to perform operations on strings.

Concatenation
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Concatenation means linking something together in a chain or series. If you have two strings that you join
together, one after the other, you say they are concatenated. You can think of concatenation as addition
for strings. In the next Try It Out, you work with concatenation.
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Try It Out Concatenation

1. View the Designer for Forml and add a new button. Set its Name property to btnConcatenation
and its Text property to Concatenation. Double-click the button and add the following high-
lighted code:

Private Sub btnConcatenation_Click(ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles btnConcatenation.Click

'Declare variables

Dim strOne As String
Dim strTwo As String
Dim strResults As String

'Set the string values
strOne = "Hello"
strTwo = ", world!"

'Concatenate the strings
strResults = strOne & strTwo

'Display the results
MessageBox.Show (strResults, "Strings")
End Sub

2. Run the project and click the Concatenation button. You'll see the same results that were shown
in Figure 3-6.

How It Works

In this Try It Out, you start by declaring three variables that are String data types:

'Declare variables

Dim strOne As String

Dim strTwo As String

Dim strResults As String

Then you set the values of the first two strings.
'Set the string values
strOne = "Hello"

strTwo = ", world!"

After you've set the values of the first two strings, you use the & operator to concatenate the two previ-
ous strings, setting the results of the concatenation in a new string variable called strResults:

'Concatenate the strings
strResults = strOne & strTwo

What you're saying here is “let strResults be equal to the current value of strone followed by the
current value of strTwo”. By the time you call MessageBox . Show, strResults will be equal to
"Hello, world!", so you get the same value as before.
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'Display the results
MessageBox.Show (strResults, "Strings")

Using the Concatenation Operator Inline

You don’t have to define variables to use the concatenation operator. You can use it on the fly, as demon-
strated in the next Try It Out.

Try It Out Using Inline Concatenation
1.

View the Designer for Form1 once again and add a new button. Set its Name property to

btnlnlineConcatenation and set its Text property to Inline Concatenation. Double-click the
button and add the following highlighted code:

Private Sub btnInlineConcatenation_Click( _

ByVal sender As System.Object, ByVal e As System.EventArgs) _
Handles btnInlineConcatenation.Click

'Declare variable
Dim intNumber As Integer

'Set the value
intNumber = 26

'Display the results

MessageBox.Show ("The value of intNumber is: " & intNumber,

"Strings")
End Sub

2. Run the code and click the Inline Concatenation button. You'll see the results as shown in
Figure 3-7.

Strings

The value of intNumber is: 26

Figure 3-7

How It Works

You've already seen the concatenation operator being used like this in previous examples. What this is

actually doing is converting the value stored in intNumber to a string so that it can be displayed on the
screen. Look at this code:

'Display the results

MessageBox.Show ("The value of intNumber is: " & intNumber, "Strings")

The portion that reads, "The value of intNumber is:" is actually a string, but you don’t have to define
it as a string variable. Visual Basic 2005 calls this a string literal, meaning that it’s exactly as shown in the
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code and doesn’t change. When you use the concatenation operator on this string together with int
Number, intNumber is converted into a string and tacked onto the end of "The value of intNumber
is:". The result is one string, passed to MessageBox . Show, that contains both the base text and the

current value of intNumber.

More String Operations
You can do plenty more with strings! Take a look at some of them in the next Try It Out. The first thing
you’ll do is look at a property of the string that can be used to return its length.

Try It Out Returning the Length of a String

1. Using the Designer for Form1, add a TextBox control to the form and set its Name property to
txtString. Add another Button control and set its Name property to btnLength and its Text
property to Length. Rearrange the controls so that they look like Figure 3-8.

Form1 [_]O0]

Using Strings

Conheatenation |

Inline Concatenation

I Length |

Figure 3-8

2. Double-click the Length button to open its Click event handler. Add the following highlighted
code:

Private Sub btnLength_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnLength.Click

'Declare variable
Dim strData As String

'Get the text from the TextBox
strData = txtString.Text

'Display the length of the string
MessageBox.Show (strData.Length & " character(s)", "Strings")

End Sub

3. Run the project and enter some text into the text box.

4.  Click the Length button and you’ll see results similar to those shown in Figure 3-9.
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Strings

15 character(s)

Figure 3-9

How It Works

The first thing that you do is declare a variable to contain string data. Then you extract the text from the
text box and store it in your string variable called strData:

'Declare variable
Dim strData As String

'Get the text from the TextBox
strData = txtString.Text

Once you have the string, you can use the Length property to get an integer value that represents the
number of characters in it. Remember, as far as a computer is concerned, characters include things like
spaces and other punctuation marks:

'Display the length of the string
MessageBox.Show(strData.Length & " character(s)", "Strings")

Substrings

Common ways to manipulate strings in a program include using a set of characters that appears at the
start, a set that appears at the end, or a set that appears somewhere in between. These are known as
substrings.

In this Try It Out, you build on your previous application and get it to display the first three, middle
three, and last three characters.

Try It Out Working with Substrings

1. If the Strings program is running, close it.

2. Add another Button control to Form1 and set its Name property to btnSplit and its Text prop-
erty to Split. Double-click the button and add code as highlighted here:

Private Sub btnSplit_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnSplit.Click

'Declare variable
Dim strData As String

'Get the text from the TextBox
strData = txtString.Text

'Display the first three characters
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MessageBox.Show (strData.Substring (0, 3), "Strings")

'Display the middle three characters
MessageBox.Show (strData.Substring (3, 3), "Strings")

'Display the last three characters
MessageBox.Show (strData.Substring (strData.Length - 3), "Strings")
End Sub
3.  Run the project. Enter the word Cranberry in the text box.

4.  Click the Split button and you'll see three message boxes one after another as shown in

Figure 3-10.
Strings Strings Strings
Cra nhe my
[ ok | | ok | | ok |
Figure 3-10

How It Works

The substring method lets you grab a set of characters from any position in the string. The method
can be used in one of two ways. The first way is to give it a starting point and a number of characters to
grab. In the first instance, you're telling it to start at character position 0 — the beginning of the string —
and grab three characters:

'Display the first three characters
MessageBox.Show (strData.Substring (0, 3), "Strings")

In the next instance, you to start three characters in from the start and grab three characters:

'Display the middle three characters
MessageBox.Show (strData.Substring (3, 3), "Strings")

In the final instance, you're providing only one parameter. This tells the Substring method to start at
the given position and grab everything right up to the end. In this case, you're using the Substring
method in combination with the Length method, so you're saying, “Grab everything from three charac-
ters in from the right of the string to the end.”

'Display the last three characters
MessageBox.Show (strData.Substring (strData.Length - 3), "Strings")

Formatting Strings

Often when working with numbers, you'll need to alter the way they are displayed as a string. Figure 3-5
showed how a division operator works. In this case, you don’t really need to see 14 decimal places —two
or three would be fine! What you need to do is format the string so that you see everything to the left of
the decimal point, but only three digits to the right, which is what you do in the next Try It Out.
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Try It Out Formatting Strings

1. Open the Floating-Pt Math project that you created previously in this chapter.
2.  Open the Code Editor for Forml and make the following changes:

'Set number, divide numbers, and display results
dblNumber = 12
dblNumber /= 7

'Display the results without formatting
MessageBox.Show ("Without formatting: " & dblNumber, "Floating Points")

'Display the results with formatting
MessageBox.Show ("With formatting: " & String.Format("{0:n3}", dblNumber), _
"Floating Points")
End Sub

3. Run the project. After the message box dialog box for the multiplication test is displayed, the
next message box dialog box will display a result of 1.71428571428571.

4. When you click OK, the next message box will display a result of 1.714.

How It Works

The magic here is in the call to String.Format. This powerful method allows the formatting of num-
bers. The key is all in the first parameter, as this defines the format the final string will take:

MessageBox.Show ("With formatting: " & String.Format("{0:n3}", dblNumber), _
"Floating Points")

You passed String.Format two parameters. The first parameter, " {0:n3} ", is the format that you
want. The second parameter, db1Number, is the value that you want to format.

The 0 in the format tells String.Format to work with the zeroth data parameter, which is just a cute
way of saying “the second parameter”, or db1Number. What follows the colon is how you want
dblNumber to be formatted. You said n3, which means “floating-point number, three decimal places.”
You could have said n2 for “floating-point number, two decimal places.”

Localized Formatting
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When building .NET applications, it’s important to realize that the user may be familiar with cultural
conventions that are uncommon to you. For example, if you live in the United States, you're used to see-
ing the decimal separator as a period (.). However, if you live in France, the decimal separator is actu-
ally a comma (, ).

Windows can deal with such problems for you based on the locale settings of the computer. If you use
the NET Framework in the correct way, by and large you’ll never need to worry about this problem.
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Here’s an example —if you use a formatting string of n3 again, you are telling .NET that you want to
format the number with thousands separators and also that you want the number displayed to three
decimal places (1,714.286).

The equation changed from 12 /7 to 12000 / 7 to allow the display of the thousands separator (, ).

Now, if you tell your computer that you want to use the French locale settings, and you run the same code
(you make no changes whatsoever to the application itself), you'll see 1 714, 286.

You can change your language options by going to the Control Panel and clicking the Regional and
Language Options icon and changing the language to French.

In France, the thousands separator is a space, not a comma, while the decimal separator is a comma, not
a period. By using String.Format appropriately, you can write one application that works properly
regardless of how the user has configured the locale settings on the computer.

Replacing Substrings

Another common string manipulation replaces occurrences of one string with another. To demonstrate
this, in the next Try It Out you’ll modify your Strings application to replaces the string "Hello" with the
string "Goodbye".

Try It Out Replacing Substrings

1. Open the Strings program you were working with before.

2. InForml, add another Button control and set its Name property to btnReplace and set its Text
property to Replace. Double-click the button and add the following highlighted code to its Click
event handler:

Private Sub btnReplace_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnReplace.Click

'Declare variables
Dim strData As String
Dim strNewData As String

'Get the text from the TextBox
strData = txtString.Text

'Replace the string occurance
strNewData = strData.Replace("Hello", "Goodbye")

'Display the new string
MessageBox.Show (strNewData, "Strings")

End Sub

3. Run the project and enter Hello world! into the text box in this exact case.

4.  Click the Replace button. You should see a message box that says Goodbye wor1d!
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How It Works

Replace works by taking the substring to look for as the first parameter and the new substring to
replace it with as the second parameter. After the replacement is made, a new string is returned that you

can display in the usual way.

'Replace the string occurance
strNewData = strData.Replace("Hello", "Goodbye")

You're not limited to a single search and replace within this code. If you enter Hello twice into the text
box and click the button, you'll notice two Goodbyes. However, the case is important —if you enter
hello, it will not be replaced.

Using Dates

Another really common data type that you'll often use is Date. This data type holds, not surprisingly, a
date value. You will learn to display the current date in the next Try It Out.

Try It Out Displaying the Current Date
1. Create a new Windows Application project called Date Demo.

2. Inthe usual way, use the Toolbox to draw a new button control on the form. Call it btnDate and
set its Text property to Show Date.
3.  Double-click the button to bring up its Click event handler and add this code:
Private Sub btnDate_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnDate.Click

'Declare variable
Dim dteData As Date

'Get the current date and time
dteData = Now

'Display the results
MessageBox.Show (dteData, "Date Demo")
End Sub

4. Run the project and click the button. You should see something like Figure 3-11 depending on
the locale settings on your machine.

Date Demo E

4/30/2005 6:25:54 AM

Figure 3-11
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How It Works

The Date data type can be used to hold a value that represents any date and time. After creating the
variable, you initialized it to the current date and time using Now:

'Declare variable
Dim dteData As Date

'Get the current date and time
dteData = Now

Date data types aren’t any different from other data types, although you can do more with them. In the
next couple of sections, you'll see ways to manipulate dates and control how they are displayed on the

screen.

Formatting Date Strings

You've already seen one way in which dates can be formatted. By default, if you pass a Date variable to
MessageBox. Show, the date and time are displayed as shown in Figure 3-11.

Because this machine is in the United States, the date is shown in m/d/yyyy format and the time is
shown using the 12-hour clock. This is another example of how the computer’s locale setting affects the
formatting of different data types. For example, if you set your computer to the United Kingdom locale,
the date is in dd/mm/yyyy format and the time is displayed using the 24-hour clock, for example,
07/08/2004 07:02:47.

Although you can control the date format to the nth degree, it’s best to rely on .NET to ascertain how the
user wants strings to look and automatically display them in their preferred format. In the next Try It
Out, you'll look at four useful methods that enable you to format dates.

Try It Out Formatting Dates
1. If the Date Demo program is running, close it.

2. Using the Code Editor for Form1, find the Click event handler for the button, and add the fol-
lowing code:

'Display the results
MessageBox.Show (dteData, "Date Demo")

'Display dates
MessageBox.Show (dteData.ToLongDateString, "Date Demo")
MessageBox.Show (dteData.ToShortDateString, "Date Demo")

'Display times
MessageBox.Show (dteData.ToLongTimeString, "Date Demo")
MessageBox.Show (dteData.ToShortTimeString, "Date Demo")

End Sub

3. Run the project. You'll be able to click through five message boxes. You have already seen the
first message box dialog box; it displays the date and time according to your computers locale
settings. The next message box dialog box will display the long date, and the next message box
dialog box will display the short date. The fourth message box will display the long time, while
the last message box will display the short time.
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How It Works

You're seeing the four basic ways that you can display date and time in Windows applications, namely
long date, short date, long time, and short time. The names of the formats are self-explanatory!

'Display dates
MessageBox.Show (dteData.ToLongDateString, "Date Demo")
MessageBox.Show (dteData.ToShortDateString, "Date Demo")

'Display times
MessageBox.Show (dteData.ToLongTimeString, "Date Demo")
MessageBox.Show (dteData.ToShortTimeString, "Date Demo")

Extracting Date Properties

When you have a variable of type Date, there are several properties that you can call to learn more
about the date; let’s look at them.

Try It Out Extracting Date Properties

1.  If the Date Demo project is running, close it.

2. Add another Button control to Form1 and set its Name property to btnDateProperties and its
Text property to Date Properties. Double-click the button and add the following highlighted
code to the Click event:

Private Sub btnDateProperties_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnDateProperties.Click

'Declare variable
Dim dteData As Date

'Get the current date and time
dteData = Now

'Display the various properties

MessageBox.Show ("Month: " & dteData.Month, "Date Demo")
MessageBox.Show("Day: " & dteData.Day, "Date Demo")
MessageBox.Show("Year: " & dteData.Year, "Date Demo")
MessageBox.Show ("Hour: " & dteData.Hour, "Date Demo")
MessageBox.Show ("Minute: " & dteData.Minute, "Date Demo")
MessageBox.Show("Second: " & dteData.Second, "Date Demo")
MessageBox.Show("Day of week: " & dteData.DayOfWeek, "Date Demo")
MessageBox.Show("Day of year: " & dteData.DayOfYear, "Date Demo")

End Sub

3. Runthe project. If you click the button, you'll see a set of fairly self-explanatory message boxes.

How It Works
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Again, there’s nothing here that’s rocket science. If you want to know the hour, use the Hour property. To
get at the year, use Year, and so on.
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Date Constants

In the preceding Try It Out, you'll notice that when you called DayOfweek, you were actually given an
integer value, as shown in Figure 3-12.

Date Demo

Day of week: 6

Figure 3-12

The date that we’re working with, April 30, 2005, is a Saturday, and, although it’s not immediately obvi-
ous, Saturday is 6. As the first day of the week is Sunday in the United States, you start counting from
Sunday, with Sunday being 0. However, there is a possibility that you're working on a computer whose
locale setting starts the calendar on a Monday, in which case DayOfwWeek would return 5. Complicated?
Perhaps, but just remember that you can’t guarantee that what you think is "Day 1" is always going to
be Monday. Likewise, what’s Wednesday in English is Mittwoch in German.

If you need to know the name of the day or the month in your application, a better approach is to get
.NET to get the name for you, again from the particular locale settings of the computer, as you do in the

next Try It Out.
Try It Out Getting the Names of the Weekday and the Month

1.  If the Date Demo project is running, close it.

2. In the Form Designer, add a new Button control and set its Name property to btnDateNames
and its Text property to Date Names. Double-click the button and add the following highlighted
code to the Click event handler:

Private Sub btnDateNames_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnDateNames.Click
'Declare variable
Dim dteData As Date
'Get the current date and time
dteData = Now
'Display the various properties
MessageBox.Show ("Weekday name: " & dteData.ToString("dddd"), "Date Demo")
MessageBox.Show ("Month name: " & dteData.ToString("MMMM"), "Date Demo")
End Sub
3. Run the project and click the button. You will see a message box that tells you the weekday

name is Saturday and a second one that tells you that the month is April.
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How It Works

When you used your ToLongDateString method and its siblings, you were basically allowing .NET to
go look in the locale settings for the computer for the date format the user preferred. In this example,
you're using the ToString method but supplying your own format string.

'Display the various properties
MessageBox.Show ("Weekday name: " & dteData.ToString("dddd"), "Date Demo")
MessageBox.Show ("Month name: " & dteData.ToString("MMMM"), "Date Demo")

Usually, it’s best practice not to use ToString to format dates, because you should rely on the built-in
formats, but here you're using the "dddd" string to get the weekday name and "MMMM" to get the month
name. (The case is important here — "mmmm" won’t work.)

To show this works, if the computer is set to use Italian locale settings, you get one message box telling
you the weekday name is Sabato and another telling you the month name is Agosto.

Defining Date Literals
You know that if you want to use a string literal in your code, you can do this:

Dim strData As String
strData = "Woobie"

Date literals work in more or less the same way. However, you use pound signs (#) to delimit the start
and end of the date. You learn to define date literals in the next Try It Out.

Try It Out Defining Date Literals

1.  If the Date Demo project is running, close it.

2. Add another Button control to the form and set its Name property to btnDateLiterals and its
Text property to Date Literals. Double-click the button and add the following code to the Click
event handler:

Private Sub btnDateLiterals_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnDateLiterals.Click

'Declare variable
Dim dteData As Date

'Get the current date and time
dteData = #5/5/1967 6:41:00 AM#

'Display the date and time
MessageBox.Show (dteData.ToLongDateString & " " & _
dteData.ToLongTimeString, "Date Demo")
End Sub

3. Runthe project and click the button. You should see the message box shown in Figure 3-13.
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Date Demo

Friday, May 05, 1967 6:41:00 AM

Figure 3-13

How It Works

When defining a date literal, it must be defined in mm/dd/yyyy format, regardless of the actual locale
settings of the computer. You may or may not see an error if you try to define the date in the format
dd/mm/yyyy. This is because you could put in a date in the format dd/mm/yyyy (for example,
06/07/2004) that is also a valid date in the required mm/dd/yyyy format. This requirement is to reduce
ambiguity: Does 6/7/2004 mean July 6 or June 7?

In fact, this is a general truth of programming as a whole: There’s no such thing as dialects when writ-
ing software. It’s usually best to conform to North American standards. As you'll see through the rest of
this book, this includes variables and method names, for example GetColor rather than GetColour.

It’s also worth noting that you don’t have to supply both a date and a time. You can supply one, the
other, or both.

Manipulating Dates

One thing that’s always been pretty tricky for programmers to do is manipulate dates. You all remember
New Year’s Eve 1999, waiting to see whether computers could deal with tipping into a new century.
Also, dealing with leap years has always been a bit of a problem.

The next turn of the century that also features a leap year will be 2399 to 2400. In the next Try It Out,

you'll take a look at how you can use some of the methods available on the Date data type to adjust the
date around that particular leap year.

Try It Out Manipulating Dates

1.  If the Date Demo program is running, close it.

2. Add another Button control to the form and set its Name property to btnDateManipulation

and its Text property Date Manipulation. Double-click the button and add the following code
to the Click event handler:

Private Sub btnDateManipulation_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnDateManipulation.Click

'Declare variables
Dim dteStartDate As Date
Dim dteChangedDate As Date

'Start off in 2400
dteStartDate = #2/28/2400#
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'Add a day and display the results
dteChangedDate = dteStartDate.AddDays (1)
MessageBox.Show (dteChangedDate.ToLongDateString, "Date Demo")

'Add some months and display the results
dteChangedDate = dteStartDate.AddMonths (6)
MessageBox.Show (dteChangedDate.ToLongDateString, "Date Demo")

'Subtract a year and display the results
dteChangedDate = dteStartDate.AddYears(-1)
MessageBox.Show (dteChangedDate.ToLongDateString, "Date Demo")

End Sub

3.  Run the project and click the button. You'll see three message boxes, one after another. The first
message box dialog box will display the long date for 2/29 /2400, while the second message box
dialog box will display the long date for 8/28/2400. Finally, the final message box dialog box
will display the long date for 2/28/2399.

How It Works

Date supports several methods for manipulating dates. Here are three of them:

'Add a day and display the results
dteChangedDate = dteStartDate.AddDays (1)
MessageBox.Show (dteChangedDate.ToLongDateString, "Date Demo")

'Add some months and display the results
dteChangedDate = dteStartDate.AddMonths (6)
MessageBox.Show (dteChangedDate.ToLongDateString, "Date Demo")

'Subtract a year and display the results
dteChangedDate = dteStartDate.AddYears(-1)
MessageBox.Show (dteChangedDate.ToLongDateString, "Date Demo")

It’s worth noting that when you supply a negative number to the Add method when working with Date
variables, the effect is subtraction (as you've seen by going from 2400 back to 2399). The other important
Add methods are AddHours, AddMinutes, AddSeconds, and AddMilliseconds.

Boolean

So far, you've seen the Integer, Double, Single, String, and Date data types. The other one you need
to look at is Boolean. Once you've done that, you've seen all of the simple data types that you're most

likely to use in your programs.

A Boolean variable can be either True or False. It can never be anything else. Boolean values are
really important when it’s time for your programs to start making decisions, which is something you

look at in much more detail in Chapter 4.
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Storing Variables

The most limited resource on your computer is typically its memory. It is important that you try to get
the most out of the available memory. Whenever you create a variable, you are using a piece of memory,
so you must strive to use as few variables as possible and use the variables that you do have in the most
efficient manner.

Today, absolute optimization of variables is not something you need to go into a deep level of detail
about, for two reasons. First, computers have far more memory these days, so the days when program-
mers tried to cram payroll systems into 32KB of memory are long gone. Second, the compilers them-
selves have a great deal of intelligence built in these days, to help generate the most optimized code
possible.

Binary

Computers use binary to represent everything. That means that whatever you store in a computer must
be expressed as a binary pattern of ones and zeros. Take a simple integer, 27. In binary code, this number
is actually 11011, each digit referring to a power of two. The diagram in Figure 3-14 shows how you rep-
resent 27 in the more familiar base-ten format, and then in binary.

In base-10, each digit represents a

7 6 5 4 3 2 1 (0]
107]10°]1071107/1071107110" |10 power of ten. To find what number

1000 | one |99 10.000] 1,000 | 200 | 20 | 2 the “pattern of base-10 digits”
represents, you multiply the
01010 j010]|0}2]|7 relevant number by the power of
ten that the digit represents and
2%x10+7x1=27 add the results.

In base-2, or binary, each digit

7 6 5 4 3 2 1 0
2|27 |27 |27 |27 |27 |2 |2 represents a power of two. To find

128 | 64 | 32 | 16 | 8 4 2 1 what number the “pattern of binary
digits” represents, you multiply the
0]1]0]0j1j212]0]1}1 relevant number by the power of
two that the digit represents and
1x16+1x8+1x2+1x1=27 add the results.
Figure 3-14

Although this may appear to be a bit obscure, look what’s happening. In base-10, the decimal system
that you're familiar with; each digit fits into a “slot”. This slot represents a power of ten — the first repre-
senting ten to the power zero, the second ten to the power one, and so on. If you want to know what
number the pattern represents, you take each slot in turn, multiply it by the value it represents, and add
the results.

The same applies to binary —it’s just that you're not familiar with dealing with base twp. To convert the

number back to base ten, you take the digit in each slot in turn and multiply that power of two by the
number that the slot represents (zero or one). Add all of the results together and you get the number.
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Bits and Bytes

In computer terms, a binary slot is called a bit. It is the smallest possible unit of information, the answer
to a single yes/no question, represented by a part of the computer’s circuitry that either has electricity
flowing in it or not. The reason why there are eight slots/bits on the diagram in Figure 3-14 is that there
are eight bits in a byte. A byte is the unit of measurement that you use when talking about computer
memory.

A kilobyte or KB is 1,024 bytes. You use 1,024 rather than 1,000 because 1,024 is the 10th power of 2, so
as far as the computer is concerned it’s a “round number”. Computers don’t tend to think of things in
terms of 10s like you do, so 1,024 is more natural to a computer than 1,000.

Likewise, a megabyte is 1,024 kilobytes, or 1,048,576 bytes. Again, that is another round number because
this is the 20th power of 2. A gigabyte is 1,024 megabytes, or 1,073,741,824 bytes. (Again, think 2 to the
power of 30 and you're on the right lines.) Finally, a terabyte is 2 to the 40th power, and a petabyte is 2 to
the 50th power.

So what'’s the point of all this? Well, it’s worth having an understanding of how computers store vari-
ables so that you can design your programs better. Suppose your computer has 256 MB of memory.
That’s 262,144 KB or 268,435,456 bytes or (multiply by 8) 2,147,483,648 bits. As you write your software,
you have to make the best possible use of this available memory.

Representing Values
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Most desktop computers in use today are 32-bit, which means that they’re optimized for dealing with
integer values that are 32 bits in length. The number you just saw in the example was an 8-bit number.
With an 8-bit number, the largest value you can store is:

1x128 + 1x64 + 1x32 + 1x16 + 1x8 + 1x4 + 1x2 + 1xl = 255

A 32-bit number can represent any value between -2,147,483,648 and 2,147,483,647. Now, you know that
if you define a variable like this:

Dim intNumber As Integer
you want to store an integer number. In response to this, .NET will allocate a 32-bit block of memory in
which you can store any number between 0 and 2,147,483,647. Also, remember you only have a finite
amount of memory, and on your 256 MB computer; you can only store a maximum of 67,108,864 long
numbers. Sounds like a lot, but remember that memory is for sharing. You shouldn’t write software that
deliberately tries to use as much memory as possible. Be frugal!
You also defined variables that were double-precision floating-point numbers, like this:

Dim dblNumber As Double

To represent a double-precision floating point number, you need 64 bits of memory. That means you can
only store a maximum of 33,554,432 double-precision floating-point numbers.

Single-precision floating-point numbers take up 32 bits of memory — in other words half as much as a
double-precision number and the same as an integer value.
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If you do define an integer, whether you store 1, 3, 249, or 2,147,483,647, you're always using exactly
the same amount of memory, 32 bits. The size of the number has no bearing on the amount of memory
required to store it. This might seem incredibly wasteful, but the computer relies on numbers of the
same type taking the same amount of storage. Without this, it would be unable to work at a decent
speed.

Now look at how you define a string;:

Dim strData As String
strData = "Hello, world!"

Unlike integers and doubles, strings do not have a fixed length. Each character in the string takes up two
bytes, or 16 bits. So, to represent this 13-character string, you need 26 bytes, or 208 bits. That means that
your computer is able to store only a little over two million strings of that length. Obviously, if the string
is twice as long, you can hold half as many, and so on.

A common mistake that new programmers make is not taking into consideration the impact the data
type has on storage. If you have a variable that’s supposed to hold a string, and you try to hold a
numeric value in it, like this:

Dim strData As String
strData = "65536"

you're using 10 bytes (or 80 bits) to store it. That’s less efficient than storing the value in an integer type.
To store this numerical value in a string, each character in the string has to be converted into a numerical
representation. This is done according to something called Unicode, which is a standard way of defining
the way computers store characters. Each character has a unique number between 0 and 65,535, and it’s
this value that is stored in each byte allocated to the string.

Here are the Unicode codes for each character in the string:

Q  “6”: Unicode 54, binary 0000000000110110
Q  “5”: Unicode 53, binary 0000000000110101
Q  “5”: Unicode 53, binary 0000000000110101
Q  “3”: Unicode 51, binary 0000000000110011
Q  “6”: Unicode 54, binary 0000000000110110

Each character requires 16 bits, so to store a 5-digit number in a string requires 80 bits — five 16 bit num-
bers. What you should do is this:

Dim intNumber As Integer
intNumber = 65536

This stores the value as a single number binary pattern. An Integer uses 32 bits, so the binary represen-

tation will be 00000000000000010000000000000000, far smaller than the space needed to store it as a
string.

69



Chapter 3

Converting Values
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Although strings seem natural to us, they’re unnatural to a computer. A computer wants to take two
numbers and perform some simple mathematical operation on them. However, a computer can perform
such a vast number of these simple operations each second that you, as humans, get the results you
want.

Let’s imagine that a computer wants to add 1 to the value 27. You already know that you can represent
27 in binary as 11011. Figure 3-15 shows what happens.

As you can see, binary math is no different from decimal (base-10) math. If you try to add one to the first
bit, it won't fit, so you revert it to zero and carry the one to the next bit. The same happens, and you
carry the one to the third bit. At this point, you've finished, and if you add up the value you get 28, as
intended.

27|28 |25 |24 | 23| 22| 2t | 2°

128 64 32 16 8 4 2 1

ojojoj1|12])]0|1]|1

1x16+1x8+1x2+1x1=27

27 | 28|25 | 0% 23| 22|02t 2°

128 64 32 16 8 4 2 1

Oojojoj1]1]|1 «— add 1

0|0
A
carryl carry 1

Just like the math you're familiar with,

if we hit the "ceiling" value for the

base (in this case "2"), we set the

digit to "0" and carry "1". 1x16+1x8+1x4=28

Figure 3-15

Any value that you have in your program ultimately has to be converted to simple numbers for the com-
puter to do anything with them. To make the program run more efficiently, you have to keep the number
of conversions to a minimum. Here’s an example:

Dim strData As String
strData = "27"

strData = strData + 1
MessageBox.Show (strData)

Let’s look at what’s happening:

1. Youcreatea string variable called strData.

2.  You assign the value 27 to that string. This uses 4 bytes of memory.
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3. Toadd 1 to the value, the computer has to convert 27 to an internal, hidden integer variable that
contains the value 27. This uses an additional 4 bytes of memory, taking the total to 8. However,
more importantly, this conversion takes time!

4. When the string is converted to an integer, 1 is added to it.
5.  The new value then has to be converted into a string.
6. The string containing the new value is displayed on the screen.

To write an efficient program, you don’t want to be constantly converting variables between different
types. You want to perform the conversion only when it’s absolutely necessary.

Here’s some more code that has the same effect:

Dim intNumber As Integer
intNumber = 27

intNumber = intNumber + 1
MessageBox . Show (intNumber)

1 You create an integer variable called intNumber.
2.  Youassign the value 27 to the variable.
3 You add 1 to the variable.

4.  You convert the variable to a string and display it on the screen.

In this case, you have to do only one conversion, and it’s a logical one. MessageBox . Show works in
terms of strings and characters, so that’s what it’s most comfortable with.

What you have done is cut the conversions from two (string to integer, integer to string) down to one.
This will make your program run more efficiently. Again, it's a small improvement, but imagine this
improvement occurring hundreds of thousands of times each minute — you’ll get an improvement in
the performance of the system as a whole.

It is absolutely vital that you work with the correct data type for your needs. In simple applications like
the ones you've created in this chapter, a performance penalty is not really noticeable. However, when
you write more complex, sophisticated applications, you'll really want to optimize your code by using
the right data type.

Methods

A method is a self-contained block of code that “does something.” Methods, also called procedures, are
essential for two reasons. First, they break a program up and make it more understandable. Second, they
promote code reuse—a topic you'll be spending most of your time on throughout the rest of this book.

As you know, when you write code you start with a high-level algorithm and keep refining the detail of
that algorithm until you get the software code that expresses all of the algorithms up to and including
the high-level one. A method describes a “line” in one of those algorithms, for example “open a file”,

v ou

“display text on screen”, “print a document”, and so on.
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Knowing how to break a program up into methods is something that comes with experience. To add to
the frustration, it’s far easier to understand why you need to use methods when you’re working on far
more complex programs than the ones you’ve seen so far. In the rest of this section, we’ll endeavor to
show you how and why to use methods.

Why Use Methods?

In day-to-day use, you need to pass information to a method for it to produce the expected results. This
might be a single integer value, a set of string values, or a combination of both. These are known as input
values. However, some methods don’t take input values, so having input values is not a requirement of a
method. The method uses these input values and a combination of environmental information (for
instance, facts about the current state of the program that the method knows about) to do something
useful.

We say that when you give information to a method, you pass it data. You can also refer to that data as
parameters. Finally, when you want to use a method, you call it.

To summarize, you call a method, passing data in through parameters.

The reason for using methods is to promote this idea of code reuse. The principle behind using a method
makes sense if you consider the program from a fairly high level. If you have an understanding of all the
algorithms involved in a program, you can find commonality. If you need to do the same thing more
than once, you should wrap it up into a method that you can reuse.

Imagine you have a program that comprises many algorithms. Some of those algorithms call for the area
of a circle to be calculated. Because some of those algorithms need to know how to calculate the area of a
circle, it’s a good candidate for a method. You write code that knows how to find the area of a circle
given its radius, encapsulate it (“wrap it up”) into a method, which you can reuse it when you're coding
the other algorithms. This means that you don’t have to keep writing code that does the same thing —
you do it once and reuse it as often as needed.

It might be the case that one algorithm needs to work out the area of a circle with 100 for its radius, and
another needs to work out one with a radius of 200. By building the method in such a way that it takes
the radius as a parameter, you can use the method from wherever you want.

With Visual Basic 2005, you can define a method using the Sub keyword or using the Function key-
word. sub, short for “subroutine,” is used when the method doesn’t return a value, as mentioned in
Chapter 1. Function is used when the method returns a value.

Methods You’ve Already Seen

The good news is that you’ve been using methods already. Consider this code that you wrote at the
beginning of this chapter:

Private Sub btnAdd_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnAdd.Click

'Define a variable for intNumber
Dim intNumber As Integer
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'Set the initial value
intNumber = 27

'Add 1 to the value of intNumber
intNumber = intNumber + 1

'Display the new value of intNumber
MessageBox.Show ("Value of intNumber + 1 = " & intNumber, "Variables")
End Sub

That code is a method —it’s a self-contained block of code that does something. In this case, it adds 1 to
the value of intNumber and displays the result in a message box.

This method does not return a value (that is, it’s a subroutine, so it starts with the sub keyword and
ends with the End Sub statement). Anything between these two statements is the code assigned to the
method. Let’s take a look at how the method is defined (this code was automatically created by Visual
Basic 2005):

w

Private Sub btnAdd Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnAdd.Click

First of all, you have the word Private. The meaning of this keyword will be discussed in later
chapters. For now, think of it as ensuring that this method cannot be called up by anything
other than the user clicking the Add button.

Second, you have the keyword sub to tell Visual Basic 2005 that you want to define a
subroutine.

Third, you have btnadd_click. This is the name of the subroutine.

Fourth, you have Byval sender As System.Object, ByVal e As System.EventArgs. This
tells Visual Basic 2005 that the method takes two parameters — sender and e. We'll talk about
this more later.

Finally, you have Handles btnadd.click. This tells Visual Basic 2005 that this method should
be called whenever the Click event on the control btnadd is fired.

In the next Try It Out, you take a look at how you can build a method that displays a message box and
call the same method from three separate buttons.

Try It Out Using Methods

1.
2.
3.

Create a new Windows Application project called Three Buttons.
Use the Toolbox to draw three buttons on the form.

Double-click the first button (Buttonl) to create a new Click event handler. Add the highlighted
code:

Private Sub Buttonl_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Buttonl.Click
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'Call your method
SayHello ()
End Sub

Private Sub SayHello()

'Display a message box

MessageBox.Show("Hello, world!", "Three Buttons")
End Sub

4. Run the project and you'll see the form with three buttons appear. Click the topmost button and
you’ll see Hello, world!

How It Works

As you know now, when you double-click a Button control in the Designer, a new method is automati-
cally created:

Private Sub Buttonl_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Buttonl.Click

End Sub

The Handles Buttonl.Click statement at the end tells Visual Basic 2005 that this method should auto-
matically be called when the Click event on the button is fired. As part of this, Visual Basic 2005 provides
two parameters, which you don’t have to worry about for now. Outside of this method, you've defined a
new method:

Private Sub SayHello()

'Display a message box

MessageBox.Show("Hello, world!", "Three Buttons")
End Sub

The new method is called SayHello. Anything that appears between the two highlighted lines is part of
the method and when that method is called, the code is executed. In this case, you've asked it to display
a message box.

So you know that, when the button is clicked, Visual Basic 2005 will call the Buttonl_c1lick method.
You then call the sayHello method. The upshot of all this is that when the button is clicked, the mes-
sage box is displayed:

Private Sub Buttonl_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Buttonl.Click

'Call your method
SayHello ()
End Sub

That should make the general premise behind methods a little clearer, but why did you need to break

the code into a separate method to display the message box? You learn more about that in the next Try
It Out.
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Try It Out Reusing the Method
1. Ifthe project is running, close it.
2. Now double-click the second button. Add the highlighted code to the new event handler:

Private Sub Button2_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Button2.Click

'Call your method
SayHello ()
End Sub
3.  Flip back to Design view and double-click the third button. Add the highlighted code:
Private Sub Button3_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Button3.Click

'Call your method

SayHello()
End Sub
4. Now run the project. You'll notice that each of the buttons bring up the same message box when
clicked.
5.  Stop the project and find the SayHel1o method definition. Change the text to be displayed, like

this:

Private Sub SayHello()
'Display a message box

MessageBox.Show ("I have changed!", "Three Buttons")
End Sub

6. Run the project again and you'll notice that the text displayed on the message boxes has
changed.

How It Works

Each of the event handlers calls the same SayHello () method:

Private Sub Buttonl_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Buttonl.Click

'Call your method
SayHello ()
End Sub

Private Sub Button2_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Button2.Click

'Call your method

SayHello ()
End Sub

75



Chapter 3

Private Sub Button3_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Button3.Click

'Call your method
SayHello ()
End Sub

You'll also notice that the Handles keyword on each of the methods ties the method to a different con-
trol — Button1, Button2, or Button3.

What's really important (and clever!) here is that when you change the way that sayHello works, the
effect you see on each button is the same. This is a really important programming concept. You can cen-
tralize code in your application so that when you change it in once place, the effect is felt throughout the
application. Likewise, this saves you from having to enter the same or very similar code repeatedly.

Building a Method

In the next Try It Out, you'll build a method that’s capable of returning a value. Specifically, you'll build

a method that can return the area of a circle if its radius is given. You can do this with the following
algorithm:

1. Square the radius.
2. Multiply it by pi.

Try It Out Building a Method
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1.

To try out this exercise, you can reuse the Three Buttons project you used before.

2.  Add this code to define a new method (which will be a function, because it returns a value):

'CalculateAreaFromRadius - find the area of a circle

Private Function CalculateAreaFromRadius (ByVal radius As Double) As Double
'Declare variables

Dim dblRadiusSquared As Double
Dim dblResult As Double

'Square the radius
dblRadiusSquared = radius * radius

'Multiply it by pi
dblResult = dblRadiusSquared * Math.PI

'Return the result
Return dblResult
End Function

3. Now delete the existing code from the Buttonl_Click event handler, and add this code:

Private Sub Buttonl_Click(ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles Buttonl.Click
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'Declare variable
Dim dblArea As Double

'Calculate the area of a circle with radius 100
dblArea = CalculateAreaFromRadius (100)

'Print the results
MessageBox.Show (dblArea, "Area")
End Sub
4, Run the project and click on Buttonl. You'll see results like the one shown Figure 3-16.

Area

31415.9265358979

Figure 3-16

How It Works

First of all, you build a separate method called CalculateAreaFromRadius. You do this by using the
Private Function...End Function block.

Private Function CalculateAreaFromRadius (ByVal radius As Double) As Double
End Function

Anything between Private Function and End Function is the body of the method and will be exe-
cuted only when the method is called.

The Byval radius As Double portion defines a parameter for the method. When a parameter is passed
by value, as indicated here by the keyword Byval,.NET in effect creates a new variable and stores the
passed parameter information in it. Even if the method is called with a variable given for the parameter,
the contents of that original variable are not modified by the method. In this case, you're telling .NET
that you want to pass a parameter into the method called radius. In effect, this statement creates a vari-
able called radius, just as if you had done this:

Dim radius As Double
In fact, there’s a little more. The variable will be automatically set to the value passed through as a
parameter, so if you pass 200 through as the value of the parameter, what you're effectively doing is
this:

Dim radius As Double = 200

If you passed 999 as the value of the parameter, you’d have this:

Dim radius As Double = 999

7



Chapter 3

Another way of passing a parameter is by reference, using the keyword ByRef instead of Byval. When
a parameter is passed by reference, the parameter name used within the method body effectively becomes
another name for the variable specified when the method is called, so that anything the method does that
modifies the parameter value modifies the original variable value as well.

The As Double sitting at the end of the method declaration tells Visual Basic 2005 that this method will
return a double-precision floating-point number back to whoever called it:

Private Function CalculateAreaFromRadius (ByVal radius As Double) As Double

Now you can look at the method properly. First off, you know that to find the area of a circle you have
this algorithm:

1. Getanumber that represents the radius of a circle.
2. Square the number.
3.  Multiply it by pi (r).
And that’s precisely what you've done:
'Declare variables
Dim dblRadiusSquared As Double

Dim dblResult As Double

'Square the radius
dblRadiusSquared = radius * radius

'Multiply it by pi
dblResult = dblRadiusSquared * Math.PI

The Math.PI in the previous code is a constant defined in Visual Basic 2005 that defines the value of pi
(() for us. After the last line, you need to return the result to whatever code called the method. This is
done with this statement:

'Return the result
Return dblResult

The code you added in Buttonl_Click calls the method and tells the user the results:

'Declare variable
Dim dblArea As Double

'Calculate the area of a circle with radius 100
dblArea = CalculateAreaFromRadius (100)

'Print the results
MessageBox.Show (dblArea, "Area")

The first thing to do is define a variable called dblArea that will contain the area of the circle. You set
this variable to whatever value CalculateAreaFromRadius returns. Using parentheses at the end of a
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method name is how you send the parameters. In this case, you're passing just one parameter and
you're passing the value 100.

After you call the method, you wait for the method to finish calculating the area. This area is returned
from the method (the Return result line defined within CalculateAreaFromRadius) and stored in the
variable dblArea. You can then display this on the screen in the usual way.

Choosing Method Names

The NET Framework has a few standards for how things should be named. This helps developers
move between languages —a topic discussed in Chapter 2. We recommend that whenever you create a
method, you use Pascal casing. This is a practice in which the first letter in each word in the method is
uppercase but nothing else is. This is merely a suggestion for best coding practices and is not a require-
ment of Visual Basic 2005. An example of this is as follows:

a CalculateAreaFromRadius
U OpenXmlFile
a GetEnvironmentValue
You'll notice that even when an abbreviation is used (in this case, XML), it isn’t written in uppercase.

This is to alleviate confusion for developers, who may or may not know how something should be
capitalized.

We recommend that you always write parameter names in camel casing. (If you've ever seen Java code,
you'll be familiar with this.) To get camel casing, you do the same as Pascal casing, but you don’t capital-
ize the very first letter:

U myAccount
U customerDetails
U updatedDnsRecord

Again, abbreviations (such as DNS) are not treated as a special case, so they appear as a mix of upper
and lowercase letters, just like in Pascal casing.

The name camel casing comes from the fact that the identifier has a hump in the middle, for example,
camelCasing. Pascal casing comes from the fact that the convention was invented for use with the
programming language Pascal.

In Chapter 2, you saw that .NET isn't tied to a particular language. Because some languages are case-
sensitive and others are not, it’s important that you define standards to make life easier for programmers
who may be coming from different programming language backgrounds.

The term “case sensitive” means that the positions of uppercase and lowercase letters are important. In a
case-sensitive language, MYACCOUNT is not the same as myAccount. However, Visual Basic 2005 is not a
case-sensitive language, meaning that for all intents and purposes you can do whatever you like with

respect to capitalization, in other words MYACCOUNT would be the same as mYacCounT.

Note that languages such as Java, C#, C++, and J# are case-sensitive.
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Scope

When introducing the concept of methods, we described them as self-contained. This has an important
effect on the way that variables are used and defined in methods. Imagine you have these two methods,
both of which define a variable called strName:

Private Sub DisplaySebastiansName ()
'Declare variable and set value
Dim strName As String
strName = "Sebastian Blackwood"

'Display results
MessageBox.Show (strName, "Scope Demo")
End Sub

Private Sub DisplayBalthazarsName ()
'Declare variable and set value
Dim strName As String
strName = "Balthazar Keech"

'Display results
MessageBox.Show (strName, "Scope Demo")
End Sub

Even though both of these methods use a variable with the same name (strName), the “self-contained”
feature of methods means that this is perfectly practicable and the variable names won’t affect each
other. Try it out next.

Try It Out Scope
1. Create a new Windows Application project called Scope Demo.

2. Add a Button control to the form and set its Name property btnScope and its Text property to
Scope. Double-click the button and add the following highlighted code to the Click event han-
dler and the other two methods:

Private Sub btnScope_Click(ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles btnScope.Click

'Call a method
DisplayBalthazarsName ()
End Sub

Private Sub DisplaySebastiansName ()
'Declare variable and set value
Dim strName As String
strName = "Sebastian Blackwood"

'Display results

MessageBox.Show (strName, "Scope Demo")
End Sub
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Private Sub DisplayBalthazarsName ()
'Declare variable and set value
Dim strName As String
strName = "Balthazar Keech"

'Display results
MessageBox.Show (strName, "Scope Demo")
End Sub

3. Runthe project and you'll see the message box displaying the name Balthazar Keech when
you click the button.

How It Works

What this exercise illustrates is that even though you’ve used the same variable name in two separate
places, the program still works as intended:

Private Sub DisplaySebastiansName ()
'Declare variable and set value
Dim strName As String
strName = "Sebastian Blackwood"

'Display results
MessageBox.Show (strName, "Scope Demo")
End Sub

Private Sub DisplayBalthazarsName ()
'Declare variable and set value
Dim strName As String
strName = "Balthazar Keech"

'Display results
MessageBox.Show (strName, "Scope Demo")
End Sub

When a method starts running, the variables that are defined within that method (in other words,
between Sub and End Sub, or between Function and End Function) are given local scope. The scope
defines which parts of the program can see the variable, and local specifically means “within the current
method”.

The strName variable technically doesn’t exist until the method starts running. At this point, NET and
Windows allocate memory to the variable so that it can be used in the code. First, you set the value and
then you display the message box. Therefore, in this case as you're calling DisplayBalthazarsName,
the variable is created the moment the method is called, you run the code in the method that alters the
newly created version of strName, and when the method has finished, the variable is deleted.

You will see in the next chapter that scope can even be limited to loops within your subroutines and
functions.
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Summary

This chapter introduced the concept of writing software not just for Visual Basic 2005 but also for all pro-
gramming languages. We started by introducing the concept of an algorithm — the underpinnings of all
computer software. We then introduced the concept of variables, and you looked closely at the most
commonly used data types: Integer, Double, String, Date, and Boolean. You saw how you could use
these data types to perform operations such as mathematical operations, concatenating strings, return-
ing the length of a string, splitting text into substrings, retrieving the current date, and extracting date
properties. You then looked at how variables are stored in the computer.

After this, you looked at methods —what they are, why you need them, how to create them, and how
the variables you declare within your methods have local scope within that method and do not apply
outside of it. We also described the difference between a function and a subroutine.

To summarize, you should know:

O  What an algorithm is and how it applies to software development

QO  How to declare and use the most common types of variables

QO  How to use the most common string functions when working with the String data type
Q

How to use the Date data type and display dates and times so that they are automatically local-
ized to the user’s computer settings

QO  How to create and use simple methods

Exercises

Exercise 1

Create a Windows application with two button controls. In the click event for the first button, declare
two Integer variables and set their values to any number that you like. Perform any math operation on
these variables and display the results in a message box.

In the click event for the second button, declare two String variables and set their values to anything
that you like. Perform a string concatenation on these variables and display the results in a message box.

Exercise 2

Create a Windows application with a text box and a button control. In the button’s click event, display
three message boxes. The first message box should display the length of the string that was entered into
the text box. The second message box should display the first half of the string, and the third message
box should display the last half of the string.
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In Chapter 3, you learned about algorithms and their role in programming. In this chapter, you're
going to look at how you can control the flow through your algorithms so that you can make deci-
sions like, “If X is the case, go and do A; otherwise do B.” This ability to make decisions is known
as branching. You'll also see how you can repeat a section of code (a process known as looping) a
specified number of times, or while a certain condition applies.

Specifically, you'll learn more about:

Q The 1f statement
0 Select Case
Q  For loops
d

Do loops

Making Decisions

Algorithms often include decisions. In fact, it’s this decision-making ability that makes computers
do what they do so well. When you're writing code, you make two kinds of decisions. The first
kind is used to find out what part of an algorithm you're currently working on or to cope with
problems. For example, imagine you have a list of 10 people and need to write a piece of code to
send an e-mail to each of them. To do this, after sending each e-mail, you ask, “Have I finished?” If
50, you quit the algorithm; otherwise you get the next person in the list. As another example, you
might need to open a file, so you ask, “Does the file exist?” You have to deal with both possible
answers to that question.

The second kind of decision is used to perform a different part of the algorithm depending on one
or more facts. Imagine you're going through your list of ten people so that you can send an e-mail
to those who own a computer but telephone those who don’t. As you look at each person, you use
the fact that the person does or doesn’t own a computer, to choose what you should do.
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These decisions are all made in the same way, and it doesn’t matter whether you have more of the first
kind, more of the second kind, or whatever. Now, let’s take a look at how to make a decision using the

If statement.

The If Statement

The simplest way to make a decision in a Visual Basic 2005 program is to use the If ... Then statement.
You learn to use an If .. Then statement in the following Try It Out.

Try It Out A Simple If . . . Then Statement
1. Create a Windows Application project called Simple If. Add a Button control, set its Name
property to btnlf, and set its Text property to If. Double-click the button and add the following
highlighted code:

Private Sub btnIf Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnIf.Click

'Declare and set a variable
Dim intNumber As Integer = 27

'Here's where you make a decision,
'and tell the user what happened

If intNumber = 27 Then
MessageBox.Show (" 'intNumber' is, indeed, 27!", "Simple If")

End If
End Sub

2. Now run the project and click the If button. You’ll see the message box dialog box shown in

Figure 4-1.

Simple If [ X]

‘intdumber’ is, indeed, 27!

Figure 4-1

How It Works
First you declare an Integer variable called intNumber and set its value to 27, all in the same line of
code, as shown here.

'Declare and set a variable
Dim intNumber As Integer = 27
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Then you use an If ... Then statement to determine what you should do next. In this case, you say, “If
intNumber is equal to 27...”:

'Here's where you make a decision,
'and tell the user what happened
If intNumber = 27 Then
MessageBox.Show (" 'intNumber' is, indeed, 27!", "Simple If")
End If

The code block that follows this will be executed only if intNumber equals 27. You end the code block
with End If. Anything between If and End If is called only if the expression you're testing for is True.

So, as you walk through the code, you get to the If statement, and it’s true. You drop into the code block
that runs if the expression is true, and the text is displayed in a message box.

Notice that the code within the If . .. End If block is automatically indented for you. This is to
increase readability so that you can tell what code will run in the event of the condition being true. It’s
also good to add some white space before the T£ . .. Then statement and after the End I£ statement to
enhance readability further.

A simple If block like the previous one may also be written on one line, without an End If statement,
for example:

If intNumber = 27 Then MessageBox.Show("'intNumber' is, indeed, 27!", "Simple If"

This works equally well —although you are limited to only one line of code within the 1f statement. So
now you know what happens if your condition is true. But what happens if you fail the test and the
result is false? You find out in the next Try It Out.

Try It Out Failing the Test

1.  Stop your Simple If program if it is still running. Add another Button control to the form and set
its Name property to btnAnotherIf and its Text property to Another If. Double-click the button
and add the following highlighted code:

Private Sub btnAnotherIf Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnAnotherIf.Click

'Declare and set a variable
Dim intNumber As Integer = 27

'Here's where you make a decision,
'and tell the user what happened
If intNumber = 1000 Then
MessageBox.Show (" 'intNumber' is, indeed, 1000!", "Simple If")
End If
End Sub

2. Run the code.
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How It Works

In this case, the question “Is intNumber equal to 1000?” comes out false. The code block executes only if
the statement is true, so it’s skipped. If the statement were true, the line between the If and End If lines
would have executed. However, in this instance the statement was false, so the next line to be executed
was the first line directly following the End If line (which is End Sub). In effect, the “true” code block is
skipped.

The Else Statement

If you want to run one piece of code if the condition is true and another piece if the condition is false,
you use the Else statement. Expand on the previous Try It Out to see how it works.

Try It Out The Else Statement

1. Change the code in the btnAnotherIf_Click procedure so that it looks like this:

Private Sub btnAnotherIf Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnAnotherIf.Click

'Declare and set a variable
Dim intNumber As Integer = 27

'Here's where you make a decision,
'and tell the user what happened
If intNumber = 1000 Then

MessageBox.Show (" "intNumber' is, indeed, 1000!", "Simple If")
Else
MessageBox.Show (" 'intNumber' is not 1000!", "Simple If"
End If
End Sub
2. Run the code and you'll see the message box shown in Figure 4-2.

Simple If [ <]

‘intNumber’ is not 1000!

Figure 4-2

How It Works

The code following the Else statement runs if the condition in the If statement is not met. In this case,
the value of intNumber is 27, but the condition being tested for is intNumber = 1000, so the code after
the Else statement is run:

Else

MessageBox.Show (" 'intNumber' is not 1000!", "Simple If"
End If
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Allowing Multiple Alternatives with Elself

If you want to test for more than one condition, you need to make use of the E1seIf statement. Now
take your Simple If program as an example to see how you can test for the value of intNumber being 27

and 1000.

Try It Out The Elself Statement
1. Change the code in the btnAnotherIf_Click procedure so that it looks like this:
Private Sub btnAnotherIf Click(ByVal sender As System.Object, _

ByVal e As System.EventArgs) Handles btnAnotherIf.Click

'Declare and set a variable
Dim intNumber As Integer = 27

'Here's where you make a decision,
'and tell the user what happened

If intNumber = 1000 Then
MessageBox.Show (" 'intNumber' is, indeed, 1000!", "Simple If")

ElseIf intNumber = 27 Then

MessageBox.Show (" 'intNumber' is 27!", "Simple If")
Else

MessageBox.Show (" 'intNumber' is neither 1000 nor 27!", "Simple If")
End If

End Sub

2. Run the code and you'll see the message box shown in Figure 4-3.

Simple If

‘intNumber’ is 27!

Figure 4-3

How It Works

This time the code in the E1seIf statement ran because intNumber met the condition intNumber = 27.
Note that you can still include the E1se statement at the end to catch instances where intNumber is nei-

ther 27 nor 1000, but something else entirely:

ElseIf intNumber = 27 Then

MessageBox.Show (" 'intNumber' is 27!", "Simple If"
Else

MessageBox.Show (" 'intNumber' is neither 1000 nor 27!", "Simple If")
End If

You can add as many ElseIf statements as you need to test for conditions. However, bear in mind that
each ElseIf statement is executed as Visual Basic 2005 attempts to discover whether the condition is
true. This slows your program if you have a lot of conditions to be tested. If this is the case, you should
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try to put the statements in the order they are most likely to be executed, with the most common one at
the top. Alternatively, you should use a Select Case block, which you will be looking at later in the
chapter.

Nested If Statements

It’s possible to nest an If statement inside another:

If intX = 3 Then
MessageBox.Show ("intX = 3")

If intY = 6 Then
MessageBox.Show ("intY = 6")
End If

End If
There’s no real limit to how far you can nest your If statements. However, the more levels of nesting

you have, the harder it is to follow what’s happening in your code. So try to keep the nesting of If state-
ments to a minimum if you can.

Single-Line If Statement

The single-line form is typically used for short, simple tests, and it saves space in the text editor.
However, it doesn’t provide the structure and flexibility of the multiline form and is usually harder to
read:

If intX = 3 Then MessageBox.Show("intX = 3") Else MessageBox.Show("intX is not 3")

You don’t need an End If at the end of a single-line If ... Then statement.

Multiple statements can also be executed within a single line If ... Then statement. All statements must
be on the same line and must be separated by colons, as in the following example:

If intX = 3 Then MessageBox.Show("intX = 3") : intX = intX + 1 : Total += intX

Comparison Operators

You know how to check whether a particular variable is equal to some value and execute code if this is
the case. In fact, If is far more flexible than this. You can ask questions such as these, all of which have
yes/no answers.

QO  Is intNumber greater than 497

Is intNumber less than 49?

a

Q  Is intNumber greater than or equal to 497
Q  Is intNumber less than or equal to 497

a

Is strName not equal to Ben?
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When working with string values, most of the time you’ll use the Equal To or Not Equal To operators.
When working with numeric values (both integer and floating-point), you can use all of these arithmetic
operators discussed in the previous chapter.

Using Not Equal To

You have not used Not Equal To yet, so test the Not Equal To operator with strings.

Try It Out Using Not Equal To
1. Create a new Windows Application project called If Demo.

2.  When the Form Designer for Form1 appears, add a TextBox control and a Button control. Set the
Name property for TextBox1 to txtName and the Text property to Robbin. Set the Name prop-
erty for Buttonl to btnCheck and the Text property to Check.

3. Double-click the Button control to create its C1ick event handler. Add the highlighted code:

Private Sub btnCheck_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnCheck.Click

'Declare a variable and get the name from the text box
Dim strName As String
strName = txtName.Text

'Is the name Gretchen?
If strName <> "Gretchen" Then
MessageBox.Show ("The name is *not* Gretchen.", "If Demo")

End If
End Sub

4. Run the project and click the Check button. You will see a message box dialog box indicating
that the name is not Gretchen.

How It Works

The Not Equal To operator looks like this: <>. When the button is clicked, the first thing you do is to
retrieve the name from the text box by looking at its Text property:

'Declare a variable and get the name from the text box
Dim strName As String
strName = txtName.Text

After you have the name, you use an If statement. This time, however, you use the Not Equal To opera-
tor rather than the Equal To operator. Also notice that you are comparing two string values.

'Is the name Gretchen?
If strName <> "Gretchen" Then
MessageBox.Show ("The name is *not* Gretchen.", "If Demo")

End If
The code between Then and End If executes only if the answer to the question asked in the If state-

ment is True. You'll probably find this a bit of a heady principle, because the question you're asking is,
“Is strName not equal to Gretchen?” to which the answer is “Yes, the strName is not equal to
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Gretchen.” As the answer to this question is yes, or True, the code runs and the message box displays.
However, if you enter Gretchen into the text box and click Check, nothing happens, because the answer
to the question is “No, the strName is equal to Gretchen”; therefore you have a no, or False, answer.

If you try this, be sure to enter Gretchen with an uppercase G and with the rest of the letters in lower-
case; otherwise the application won't work properly. You'll see why later.

An alternative way of checking that something does not equal something is to use the Not keyword. The
condition in the If statement could have been written:

If Not strName = "Gretchen" Then

Using the Numeric Operators

In this section, you take a look at the four other comparison operators you can use. These are all fairly
basic, so you'll go through this quite fast.

Try It Out Using Less Than

1. Ifthe project is running, close it. Open the Form Designer for Form1 and add another TextBox
control and set its Name property to txtValue. Add another Button control and set its Name
property to btnCheckNumbers and its Text property to Check Numbers.

2. Double-click the Check Numbers button and add the following highlighted code to its C1ick
event handler:

Private Sub btnCheckNumbers_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnCheckNumbers.Click

'Declare variable
Dim intNumber As Integer

Try
'Get the number from the text box
intNumber = txtValue.Text

Catch

End Try

'Is intNumber less than 27?2
If intNumber < 27 Then

MessageBox.Show ("Is 'intNumber' less than 27? Yes!", "If Demo")
Else

MessageBox.Show ("Is 'intNumber' less than 27? No!", "If Demo")
End If

End Sub

3. Runthe project. Enter a number into the text box and click the Check Numbers button. You'll be
told whether the number entered is less than or greater than 27 as shown in Figure 4-4.
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B Form1 =] 3

IHobbin Check |
|48 Check Numnbers |

If Demo

Is ‘intNumber’ less than 277 No!

Figure 4-4

How It Works

First, you get the value back from the text box. However, there is a slight wrinkle. Because this is a text
box, the end users are free to enter anything they like into it, and if a series of characters that cannot be
converted into an integer is entered, the program will crash. Therefore, you add an exception handler to
make sure that you always get a value back. If the user enters something invalid, intNumber remains 0
(the default value), otherwise it will be whatever is entered:

'Declare variable
Dim intNumber As Integer

Try
'Get the number from the text box
intNumber = txtValue.Text

Catch

End Try

You’ll be introduced to exception handling properly in Chapter 9. For now, you can safely ignore it!

The Less Than operator looks like this: <. Here, you test to see whether the number entered was less than
27, and if it is, you say so in a message box; otherwise you say No:

'Is intNumber less than 272
If intNumber < 27 Then

MessageBox.Show ("Is 'intNumber' less than 27? Yes!", "If Demo")
Else

MessageBox.Show ("Is 'intNumber' less than 27? No!", "If Demo")
End If

Here’s something interesting though. If you actually enter 27 into the text box and click the button,
you'll see a message box that tells you intNumber is not less than 27. The If statement said No, and it’s
right; intNumber is actually equal to 27 and the cutoff point for this operator is anything up to but not
including the value itself. You can get around this problem with a different operator, as you'll see in the
next Try It Out.
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Try It Out Using the Less Than Or Equal To Operator

1. Change the If statement in the btnCheckNumbers_Click event handler as shown here:

Try
'Get the number from the text box
intNumber = txtValue.Text

Catch

End Try

'Is intNumber less than or equal to 27?
If intNumber <= 27 Then
MessageBox.Show ("Is 'intNumber' less than or equal to 27? Yes!", _
"If Demo")
Else

MessageBox.Show ("Is 'intNumber' less than or equal to 272 No!", _
"If Demo")
End If

2. Now run the project and enter 27 into the text box. Click the Check Numbers button and you
should see the results shown in Figure 4-5.

Form1 =] E3

IF!obbin Check |
|2? Check Numbers |

If Demo B

Is ‘intNumber’ less than or equal to 277 Yes!

Figure 4-5

How It Works

The Less Than Or Equal To operator looks like this: <=. In this situation, you're extending the possible
range of values up to and including the value you're checking. So, in this case when you enter 27, you
get the answer, Yes, n is less than or equal to 27. This type of operator is known as an inclusive
operator.

The final two operators look really similar to this, so let’s look at them now.

Try It Out Using Greater Than and Greater Than Or Equal To

1. Open the click event handler and add these two additional If statements:

'Is intNumber less than or equal to 277
If intNumber <= 27 Then
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MessageBox.Show ("Is 'intNumber'

"If Demo")
Else
MessageBox.Show ("Is 'intNumber'
"If Demo")
End If

'Is intNumber greater than 27?
If intNumber > 27 Then

MessageBox.Show ("Is 'intNumber'
"If Demo")
Else
MessageBox.Show ("Is 'intNumber'
"TIf Demo")
End If

less than or

less than or

greater

greater

'Is intNumber greater than or equal to 272

If intNumber >= 27 Then

MessageBox.Show ("Is 'intNumber'
"If Demo")
Else
MessageBox.Show ("Is 'intNumber'
"If Demo")
End If
End Sub

greater

greater

than

than

than

than

equal to 277 Yes!", _

equal to 27? No!", _

27? Yes!", _

27?2 No!", _

or equal to 277 Yes!", _

or equal to 27? No!", _

2. Run the program. This time enter a value of 99 and click the Check Numbers button. You'll see
three message boxes one after the other. The first message box will indicate that intNumber is

not less than or equal to 27, while the second message box will indicate that intNumber is
greater than 27. The final message box will indicate that intNumber is greater than or equal

to 27.

How It Works

The Greater Than and Greater Than Or Equal To operators are basically the opposite of their Less Than

counterparts. This time, you're asking, “Is intNumber greater than 27?” and, “Is intNumber greater

than or equal to 27?” The results speak for themselves.

The And and Or Operators

What happens when you need your If statement to test more than one condition? For example, if you
want to make sure that “intNumber is less than 27 and greater than 10”? Or, how about checking that
strName is "Sydney" or "Stephanie"? You can combine operators used with an If statement with the

And and Or operators, as you do in the next Try It Out.

Try It Out Using the Or Operator

1. Create a new Windows application called And Or Demo.

2. Inthe Form Designer for Form1, add two TextBox controls and a Button control. Set the Name
properties of the text boxes to txtNamel and txtName2 and the Name property of the button to

btnOrCheck.
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3.  Set the Text property for txtNamel to Sydney and the Text property for txtName2 to Stephanie.
Finally, set the Text property for btnOrCheck to Or Check. Your completed form should look
similar to the one shown in Figure 4-6.

™ Form1 =]

ISydney Or Check. |
IStephanie

Figure 4-6

4. Double-click the button and add the following code to its C1ick event handler:

Private Sub btnOrCheck_ Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnOrCheck.Click

'Declare variables
Dim strNamel As String, strName2 As String

'Get the names
strNamel = txtNamel.Text
strName2 = txtName2.Text

'Is one of the names Sydney?
If strNamel = "Sydney" Or strName2 = "Sydney" Then
MessageBox.Show("One of the names is Sydney.", _
"And Or Demo")
Else
MessageBox.Show ("Neither of the names is Sydney.", _
"And Or Demo")
End If
End Sub

5.  Run the project and click the button. You should see the results as shown in Figure 4-7.

M Form1 - O] x|

|Sydney 0Or Check |
IStephanie

And Or Demo

One of the names is Sydney.

Figure 4-7
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. ic to dismiss the message box dialog box and flip the names around so that the top one
6 Click OK to dismiss th g box dial gb dﬂ'p h d hat th p
txtNamel) is Stephanie and the bottom one (txtName?2) is ney. Click the button again an
is Stephani d the b is Sydney. Click the b gai d
you’ll see a message box indicating that one of the names is Sydney.

7. Now, click OK to dismiss the message box again and this time change the names so that neither
of them is Sydney. Click the button and you should see a message box indicating that neither of
the names is Sydney.

How It Works

The or operator is a great way of building If statements that compare two different values in a single
hit. In your click event handler, the first thing you do is declare your variables and then retrieve both
names and store them in variables strNamel and strName2:

'Declare variables
Dim strNamel As String, strName2 As String

'Get the names
strNamel = txtNamel.Text
strName2 = txtName2.Text

You'll notice that you've defined two variables on the same line. This is perfectly legitimate coding prac-
tice, although it can sometimes make the code look congested. The variables are separated with commas;
notice that it’s still important to use the As keyword to tell Visual Basic 2005 what data type each of the
variables is.

Once you have both names, you use the Or operator to combine two separate If statements. The ques-
tion you're asking here is, “Is strNamel equal to Sydney or is strName2 equal to Sydney?” The answer
to this question (providing that one of the text boxes contains the name Sydney) is, “Yes, either
strNamel is equal to Sydney or strName?2 is equal to Sydney.” Again, it’s a yes/no or true/ false
answer, even though the question is seemingly more complex:

'Is one of the names Sydney?
If strNamel = "Sydney" Or strName2 = "Sydney" Then
MessageBox.Show ("One of the names is Sydney.", _
"And Or Demo")
Else
MessageBox.Show ("Neither of the names is Sydney.", _
"And Or Demo")
End If

Using the And Operator

The And operator is conceptually similar to Or, except that both parts of the condition need to be satis-
fied, as you will see in the next Try It Out.

Try It Out Using the And Operator

1. Add another Button control to the form and set its Name property to btnAndCheck and its Text
property to And Check. Double-click the button and add the following highlighted code to its
Click event handler:
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Private Sub btnAndCheck_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnAndCheck.Click

'Declare variables
Dim strNamel As String, strName2 As String

'Get the names
strNamel = txtNamel.Text
strName2 = txtName2.Text

'Are both names Sydney?
If strNamel = "Sydney" And strName2 = "Sydney" Then

MessageBox.Show ("Both names are Sydney.", _
"And Or Demo")

Else
MessageBox.Show("One of the names is not Sydney.", _

"And Or Demo")
End If
End Sub

2. Run the program. Click the And Check button, and a message box tells you that one of the
names is not Sydney.

3.  However, if you change both names so that they are both Sydney and click the button, you'll see
the results shown in Figure 4-8.

M Form1 O] x|

ISydney Or Check |
ISydney And Check I

And Or Demo

Boths names are Sydney.

Figure 4-8

How It Works

After you've retrieved both names from the text boxes, you compare them. In this case, you're asking the
question, “Is strNamel equal to Sydney and is strName2 equal to Sydney?” In this case, both parts of
the If statement must be satisfied in order for the “Both names are Sydney” message box to be dis-

played:
'Are both names Sydney?
If strNamel = "Sydney" And strName2 = "Sydney" Then

MessageBox.Show ("Both names are Sydney.",

"And Or Demo")
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Else
MessageBox.Show ("One of the names is not Sydney.", _
"And Or Demo")
End If

More on And and Or

You've only seen And and Or used with strings. But they can be used with numeric values, like this:

If intX = 2 And intY = 2.3 Then
MessageBox.Show ("Hello, the conditions has been satisfied!")
End If

or

If intX = 2 Or intY = 2.3 Then
MessageBox.Show ("Hello, the conditions have been satisfied!")
End If

Also, in Visual Basic, there’s no realistic limit to the number of And operators or Or operators that you
can include in a statement. It’s perfectly possible to do this:

If intA = 1 And intB = 2 And intC = 3 And intD = 4 And intE = 5 And _
intF = 6 And intG = 7 And intH = 1 And intI = 2 And intJ = 3 And _
intK = 4 And intL = 5 And intM = 6 And intN = 7 And intO = 1 And _
intP = 2 And intQ = 3 And intR = 4 And intS = 5 And intT = 6 And _
intU = 7 And intV = 1 And intW = 2 And intX 3 And intY = 4 And _
intZ = 5 Then
MessageBox.Show ("That's quite an If statement!")

End If

... although quite why you’d want to do so is beyond us!

Finally, it’s possible to use parentheses to group operators and look for a value within a range. For exam-
ple, say you want to determine whether the value of intX is between 12 and 20 exclusive or between 22
and 25 exclusive. You can use the following If ... Then statement:

If (intX > 12 And intX < 20) Or (intX > 22 And intX < 25) Then

There are many other combinations of operators, far more than we have room to go into here. Rest
assured that if you want to check for a condition, there is a combination to suit your needs.

String Comparison

When working with strings and If statements, you often run into the problem of uppercase and lower-
case letters. A computer treats the characters "A" and "a" as separate entities, even though people con-
sider them to be similar. This is known as case sensitivity —meaning that the case of the letters does
matter when comparing strings. For example, if you run the following code, the message box would not
be displayed.
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Dim strName As String

strName = "Winston"

If strName = "WINSTON" Then
MessageBox.Show("Aha! You are Winston.")

End If

Because WINSTON is not strictly speaking the same as Winston, because the case is different, this T £
statement will not return a message. However, in many cases you don’t actually care about the case, so
you have to find a way of comparing strings and ignoring the case of the characters. In the next Try It
Out, you work with case-insensitive strings.

Try It Out Using Case-Insensitive String Comparisons

1. Open the Form Designer for Form1 and add another Button control. Set the Name property to
btnStringCompare and the Text property to String Compare.

2. Double-click the button to open its C1ick event handler and add the highlighted code:

Private Sub btnStringCompare_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnStringCompare.Click

'Declare variable
Dim strName As String

'Get the name
strName = txtName2.Text

'Compare the name

If String.Compare (strName, "STEPHANIE", True) = 0 Then
MessageBox.Show("Hello, Stephanie!", "And Or Demo")
End If
End Sub

3.  Run the project and click the button. You should see results like the ones shown in Figure 4-9.

™ Form1 I [=]
[Syaney | OiCheck |
[Stepharie | AndCheek |

And Or Demo

Hello, Stephanie!

Figure 4-9
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4. Now, dismiss the message box and enter the name in the second text box as StEpHaNiE, or
some other combination of upper- and lowercase letters, and click the button. You should still
see a message box that says “Hello, Stephanie!”

5. However, if you enter a name that isn’t Stephanie, the message box will not be displayed when
y P g play
you click the button.

How It Works

After you get the name back from the text box, you have to use a function to compare the two values
rather than use the basic Equal To operator. In this instance, you're using the Compare method on
System. String and giving it the two strings you want to compare. The first string is the value stored in
strName (which is the value entered into the text box), with the second string being " STEPHANIE". The
last parameter that you supply is True, which tells Compare to perform a case-insensitive match; in
other words, it should ignore the differences in case. If you had supplied False for this parameter, the
comparison would have been case sensitive, in which case you would have been no better off than using
the vanilla Equal To operator:

'Compare the name

If String.Compare (strName, "STEPHANIE", True) = 0 Then
MessageBox.Show ("Hello, Stephanie!", "And Or Demo")
End If

String.Compare returns a fairly curious result. It actually returns an integer, rather than a True or
False value. This is because String.Compare can be used to determine how two strings are different
rather than just a straightforward, “Yes, they are” or, “No, they're not.” If the method returns 0, the
strings match. If the method returns a value that is not 0, the strings do not match.

String.Compare returns an indication of how different two strings are in order to help you build
sorting algorithms.

Select Case

On occasion, you need to make a set of similar decisions like this:

Q  Is the customer called Bryan? If so, do this.
Q  Is the customer called Stephanie? If so, do this.
Q  Is the customer called Cathy? If so, do this.
Q  Is the customer called Betty? If so, do this.
Qa

Is the customer called Edward? If so, do this.

You can obviously do this with a set of If ... Then statements. In fact, it would look a little like this:

If Customer.Name = "Bryan" Then
(do something)
ElseIf Customer.Name = "Stephanie" Then

(do something)
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ElseIf Customer.Name = "Cathy" Then
(do something)

ElseIf Customer.Name = "Betty" Then
(do something)

ElseIf Customer.Name = "Edward" Then
(do something)

End If

Using Select Case

What happens if you decide you want to check Customer . FirstName instead of Customer . Name?
You’d have to change every If statement, which is a pain. Also, if Customer . Name turns out to be
"Edward", you still have to go through the other four If statements, which is very inefficient. In the
next Try It Out, you learn a better way!

Try It Out Using Select Case

1. Create a new Windows Application project. Call it Select Demo. Set the Text property of the
form to Select Case.

2.  From the Toolbox, add a ListBox control to the form and set its Name property to IstData, its
Dock property to Fill, and set its IntegralHeight property to False.

3.  With the IstData selected in the Form Designer, look at the Properties window and select the
Items property. Click the ellipsis dots button to the right of the property, and in the String
Collection Editor that appears, add the five names on separate lines as shown in Figure 4-10.

String Collection Editor

Enter the strings it the collection [one per ling]:

DK I LCancel | Help |

Figure 4-10

4. Click OK to save the changes, and the names are added to your list box. Now double-click
IstData to create a new SelectedIndexChanged event handler and add the highlighted code:

Private Sub lstData_SelectedIndexChanged(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles lstData.SelectedIndexChanged

'Declare variables
Dim strName As String
Dim strFavoriteColor As String

'Get the selected name
strName = lstData.Items (lstData.SelectedIndex)
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'Use a Select Case to get the favorite color

'of the selected name
Select Case strName
Case "Bryan"
strFavoriteColor

Case "Stephanie"
strFavoriteColor

Case "Cathy"
strFavoriteColor

Case "Betty"
strFavoriteColor

Case "Edward"
strFavoriteColor
End Select

"Madras Yellow"

"Sea Blue"

"Morning Mist"

"Passionate Purple"

"Battleship Gray"

'Display the favorite color of the selected name
MessageBox.Show (strName & "'s favorite color is " & strFavoriteColor,
"Select Demo")

End Sub

5.  Run the project. Whenever you click one of the names, a message box will appear as shown in

Figure 4-11.

f®Select Case 9 =] X

Select Demo [ x|

Betty's favorite color is Passionate Purple

Figure 4-11

How It Works

The first thing you need to do in the SelectedIndexChanged handler is declare your variables and
work out which name was selected. You do this by finding the item in the list that matches the current

value of the SelectedIndex property:

'Declare variables
Dim strName As String

Dim strFavoriteColor As String

'Get the selected name

strName = lstData.Items(lstData.SelectedIndex)
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Once you have that, you start a Select Case ... End Select block. To do this, you need to supply the
variable that you're matching against; in this case, you're using the name that was selected in the list.

Inside the Select Case. .. End Select block, you define separate Case statements for each condition
to be checked against. In this example, you have five, and each one is set to respond to a different name.
If a match can be found, Visual Basic 2005 executes the code immediately following the relevant Case
statement.

For example, if you clicked Betty, the message box would display Passionate Purple as her favorite color,
because Visual Basic 2005 would execute the line, strFavoriteColor = "Passionate Purple". If you
clicked Stephanie, the message box would display Sea Blue as her favorite color, because Visual Basic
2005 would execute strFavoriteColor = "Sea Blue".

'Use a Select Case to get the favorite color
'of the selected name
Select Case strName
Case "Bryan"
strFavoriteColor = "Madras Yellow"

Case "Stephanie"
strFavoriteColor = "Sea Blue"

Case "Cathy"
strFavoriteColor = "Morning Mist"

Case "Betty"
strFavoriteColor = "Passionate Purple"

Case "Edward"
strFavoriteColor = "Battleship Gray"
End Select

After the Select Case ... End Select block, you display a message box:

'Display the favorite color of the selected name
MessageBox.Show(strName & "'s favorite color is " & strFavoriteColor,
"Select Demo")

So how do you get out of a Select Case. .. End Select block? Well, as you're processing code that’s
beneath a Case statement, if you meet another case statement, Visual Basic 2005 jumps out of the block
and down to the line immediately following the block. Here’s an illustration:

1. The user clicks Betty. The SelectedIndexChanged event is activated, and you store "Betty" in
strName.

2.  Youreach the select Case statement. This is set to compare the value in strName with one of
the five supplied names.

3.  Visual Basic 2005 finds a Case statement that satisfies the request and immediately moves to
strFavoriteColor = "Passionate Purple".
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Visual Basic 2005 moves to the next line. This is another Case statement, and, seeing that you're

already in one, you move to the first line after the Select Case ... End Select block and dis-
play the message box.

4,

Select Case is a powerful and easy-to-use technique for making a choice from several options.
However, you must leave the block as soon as another Case statement is reached.

Case-Insensitive Select Case

Justlike If, Select Case is case sensitive; prove it to yourself in the next Try It Out.

Try It Out Using Case-Sensitive Select Case

1. Open the Form Designer for Form1. Locate the Items property for the list box and open the
String Collection Editor again.
2. Change all the names so that they appear in all uppercase letters as shown in Figure 4-12.
Enter the stings in the collection [one per ling]:
BRYAN N
STEPHANIE
CATHY
BETTY
EDWARD =
‘ _'IJ
ok I LCancel I Help |
4
Figure 4-12
3.

Click OK to save your changes and run the project. You'll notice that whenever you click a
name, the message box doesn’t specify a favorite color as shown in Figure 4-13.

™ Select Case

=10 x|

Select Demo

BETTY’s favorite color is

Figure 4-13
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How It Works

Select Case performs a case-sensitive match, just like I£. This means that if you provide the name
CATHY or BETTY to the statement, there won’t be a corresponding Case statement because you're trying

to say:

If "CATHY" = "Cathy"
or

If "BETTY" = "Betty"

Earlier in this chapter, you took a look at how you can use the String.Compare method to perform
case-insensitive comparisons with If statements. With select Case, you can’t use this method, so if
you want to be insensitive towards case, you need to employ a different technique — the one you learn
in the next Try It Out.

Try It Out Case-Insensitive Select Case

1. Open the Code Editor for Form1 and make these changes to the event handler for
SelectedIndexChanged. Pay special attention to the Case statements —the name that you're
trying to match must be supplied in all lowercase letters:

Private Sub lstData_SelectedIndexChanged(ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles lstData.SelectedIndexChanged

'Declare variables
Dim strName As String
Dim strFavoriteColor As String

'Get the selected name
strName = lstData.Items(lstData.SelectedIndex)

'Use a Select Case to get the favorite color
'of the selected name

Select Case strName.ToLower
Case "bryan"
strFavoriteColor = "Madras Yellow"

Case "stephanie"
strFavoriteColor = "Sea Blue"

Case "cathy"
strFavoriteColor = "Morning Mist"

Case "betty"
strFavoriteColor = "Passionate Purple"

Case "edward"
strFavoriteColor = "Battleship Gray"
End Select
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'Display the favorite color of the selected name
MessageBox.Show (strName & "'s favorite color is " & strFavoriteColor,
"Select Demo")
End Sub

2. Runthe project and try again. This time you will see that the message box includes the favorite
color of the person you click as shown in Figure 4-14.

fmSelect Case - O] x|

Select Demo

BETTY's favorite color is Passionate Purple

Figure 4-14

How It Works

To make the selection case insensitive, you have to convert the strName variable into all lowercase let-
ters. This is done using the ToLower method:

Select Case strName.ToLower

This means that whatever string you're given (whether it’s "BETTY" or "Betty") you always convert it
to all lowercase ("betty"). However, when you do this, you have to make sure that you're comparing
apples to apples (and not to Apples), which is why you had to convert the values you're checking
against in the Case statements to all lowercase too. Therefore, if you are given "BETTY", you convert this
to "betty", and then try to find the Case that matches "betty":

Case "bryan"
strFavoriteColor = "Madras Yellow"

Case "stephanie"
strFavoriteColor = "Sea Blue"

Case "cathy"
strFavoriteColor = "Morning Mist"

Case "betty"
strFavoriteColor = "Passionate Purple"

Case "edward"

strFavoriteColor = "Battleship Gray"
End Select
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Finally, once you have the favorite color, you display a message box as usual.

You could have done the opposite of this and converted all the names to uppercase and used
strName . ToUpper instead of strName . ToLower

Multiple Selections

You're not limited to matching one value inside a Select Case. .. End Select block. You can also

match multiple items. In the next Try It Out, you'll change the application so that you report the sex of
whoever you click on.

Try It Out Multiple Selections

1. Open the Code Editor for Form1 and change the code in the SelectedIndexChanged handler
as highlighted here:

Private Sub lstData_SelectedIndexChanged(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles lstData.SelectedIndexChanged

'Declare variables
Dim strName As String
Dim strFavoriteColor As String

'Get the selected name
strName = lstData.Items(lstData.SelectedIndex)

'Use a Select Case to display a person's gender
Select Case strName.ToLower
Case "bryan", "edward"
MessageBox.Show("Male", "Select Demo")
Case "stephanie", "cathy", "betty"
MessageBox.Show("Female", "Select Demo")
End Select
End Sub

2. Run the project and click one of the female names. You will see results as shown in Figure 4-15.

@Select Case 9 =] B3

Select Demo

Female

Figure 4-15
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How It Works

The code you use to get back the name and initialize the Select Case block remains the same. However,
in each Case statement you can provide a list of possible values separated with commas. In the first one,
you look for bryan or edward. If either of these matches, you run the code under the Case statement:

Case "bryan", "edward"
MessageBox.Show("Male", "Select Demo")

In the second one, you look for stephanie or cathy or betty. If any of these three matches, you again
run the code under the Case statement:

Case "stephanie", "cathy", "betty"
MessageBox.Show ("Female", "Select Demo")

It’s important to realize that these are all or matches. You're saying “one or the other,” not “one and the
other.”

The Case Else Statement

So what happens if none of the Case statements that you've included is matched? You saw this before
when demonstrating the case-sensitive nature of Select Case. In the next Try It Out, you see it with the
Case Else statement.

Try It Out Using Case Else

1. Open the Form Designer for Form1. Locate the Items property for the list box and open the
String Collection Editor again. Add another name to the collection and then click the OK button.

2. Inthe lstData_SelectedIndexChanged event handler, add the highlighted code:

'Use a Select Case to display a person's gender
Select Case strName.ToLower

Case "bryan", "edward"
MessageBox.Show("Male", "Select Demo")

Case "stephanie", "cathy", "betty"
MessageBox.Show ("Female", "Select Demo")

Case Else
MessageBox.Show ("I don't know this person's gender.", _
"Select Demo")
End Select

3. Run the project and click the last name that you just added, and you will see results similar to
those shown in Figure 4-16.
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®Select Case I |=] 3

Select Demo

I don't know this person’s gender.

Figure 4-16

How It Works

The Case Else statement is used if none of the other supplied Case statements match what you're look-
ing for. There isn’t a Case "sydney" defined within the block, so you default to using whatever is
underneath the Case Else statement. In this instance, you display a message box indicating that you do
not know the gender of the person who’s been selected.

Different Data Types with Select Case

In this chapter, you used Select Case with variables of type String. However, you can use Select
Case with all basic data types in Visual Basic 2005, such as Integer, Double, and Boolean.

In day-to-day work, the most common types of Select Case are based on String and Integer data
types. However, as a general rule, if a data type can be used in an If statement with the Equals (=) oper-
ator, it will work with Select Case.

Loops

When writing computer software, you often need to perform the same task several times to get the effect
you want. For example, you might need to create a telephone bill for all customers, or read in 10 files
from your computer’s disk.

To accomplish this, you use a loop, and in this section, you'll take a look at the two main types of loops
available in Visual Basic 2005:

QO  Forloops—These loops occur a certain number of times (for example, exactly 10 times).

O Do loops —These loops keep running until a certain condition is reached (for example, until all
of the data is processed).
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The For ... Next Loop

The simplest loop to understand is the For . . . Next loop, which you learn to build in the next Try
It Out.

Try It Out Building a For . . . Next Loop
1. Create a new Windows Application project called Loops.
2 Add a ListBox and a Button control to the form that appears.
3.  Change the Name property of the list box to IstData and its IntegralHeight property to False.
4

Change the Name property of the button to btnForNextLoop. Also, set its Text property to For
Next Loop. Your form should now look similar to the one shown in Figure 4-17.

ﬂglFurnﬂ Hi=1E3

lstData For Mext Loop I

Figure 4-17

5.  Double-click the button to create its C1ick event handler and add the highlighted code:

Private Sub btnForNextLoop_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnForNextLoop.Click

'Declare variable
Dim intCount As Integer

'Perform a loop
For intCount = 1 To 5
'Add the item to the list
lstData.Items.Add("I'm item " & intCount & " in the list!")
Next
End Sub

6. Run the project and click the button. You should see results like those in Figure 4-18.
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F®Form1 =
Frn tem 1 in the fisl | sk Larep |

I'mn item 2 in the ligt
I'mn item 3 in the list
I'm itern 4 in the list!
I'mn item 5 in the list

Figure 4-18

How It Works

First, inside the C1ick event handler, you define a variable:

'Declare variable
Dim intCount As Integer

Then you start the loop by using the For keyword. This tells Visual Basic 2005 that you want to create a
loop. Everything that follows the For keyword is used to define how the loop should act. In this case,
you're giving it the variable you just created and then telling it to count from 1 to 5:

'Perform a loop
For intCount = 1 To 5

The variable that you give the loop (in this case, intCount) is known as the control variable. When you
first enter the loop, Visual Basic 2005 sets the control variable to the initial count value —in this case, 1.
After the loop starts, Visual Basic 2005 moves to the first line within the For loop —in this case, the line
that adds a string to the list box:

'Add the item to the list
lstData.Items.Add("I'm item " & intCount & " in the list!")

This time, this line of code adds I'm item 1 in the 1ist! to the list box. Visual Basic 2005 then hits the
Next statement, and that’s where things start to get interesting;:

Next

When the Next statement is executed, Visual Basic 2005 increments the control variable by one. The first
time Next is executed, 1 changes to 2. Providing that the value of the control variable is less than or
equal to the “stop” value (in this case, 5), Visual Basic 2005 moves back to the first line after the For
statement, in this case:

'Add the item to the list
lstData.Items.Add("I'm item " & intCount & " in the list!")
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This time, this line of code adds I'm item 2 in the list! to the list box. Again, after this line is exe-
cuted, you run the Next statement. The value of intCount is now incremented from 2 to 3 and, because
3 is less than or equal to 5, you move back to the line that adds the item to the list. This happens until
intCount is incremented from 5 to 6. As 6 is greater than the stop value for the loop, the loop stops.

When you're talking about loops, you tend to use the term iteration. One iteration includes one move-
ment from the For statement to the Next statement. Your loop has five iterations.

Step

You don’t have to start your loop at 1 —you can pick any value you like. You also don’t have to incre-
ment the control value by 1 on each iteration —again, you can increment by any value you like. In the
next Try It Out, you learn about the flexibility of Step.

Try It Out Using Step

1.  Stop your project if it is still running. Add another Button control to your form and set its Name
property to binForNextLoopWithStep and its Text property to For Next Loop w/Step.

2. Double-click the button and add the following highlighted code in the c1ick event handler:

Private Sub btnForNextLoopWithStep_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnForNextLoopWithStep.Click

'Perform a loop
For intCount As Integer = 4 To 62 Step 7
'Add the item to the list
lstData.Items.Add (intCount)
Next
End Sub

3.  Run the project and click the button. You will see results like those in Figure 4-19.

™ Form1 A=l
141 For Mext Loop I
122 | For Mext Loop wiStep I
32
33
46
53
B0
Figure 4-19
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How It Works

The magic in this example all happens with this statement:

'Perform a loop
For intCount As Integer = 4 To 62 Step 7

First, notice that you didn’t declare the intCount variable using a Dim statement. This has been done as
part of the For statement and makes this variable local to this loop. Using the As keyword and the data
type for the variable (in this case Integer), you have effectively declared an inline variable. Next, instead
of using 1 as the start value, you're using 4. This means that on the first iteration of the loop, intCount is
set to 4, and you can see this by the fact that the first item added to the list is indeed 4. Also, you've used
the step keyword to tell the loop to increment the control value by 7 on each iteration rather than by the
default of 1. This is why, by the time you start running the second iteration of the loop, intCount is set to
11 and not 5.

Although you gave For a stop value of 62, the loop has actually stopped at 60 because the stop value is
a maximum. After the ninth iteration, intCount is actually 67, which is more than 62, and so the loop
stops.

Looping Backwards

By using a Step value that’s less than 0 (or a negative number), you can make the loop go backwards
rather than forward, as you see in the next Try It Out.

Try It Out Looping Backwards

1.  Stop your project if it is still running. Add another Button control to your form and set its Name
P your proj ) Y
property to btnBackwardsForNextLoop and its Text property to Backwards For Next Loop.

2. Double-click the button and add the following highlighted code in the c1ick event handler:

Private Sub btnBackwardsForNextLoop_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnBackwardsForNextLoop.Click

'Perform a loop
For intCount As Integer = 10 To 1 Step -1
'Add the item to the list
lstData.Items.Add (intCount)
Next
End Sub

3. Run the project and click the button. You should see results like those shown in Figure 4-20.

How It Works

If you use a negative number, like -1, For tries to add -1 to the current control value. Adding a negative
number has the effect of subtracting the number, so intCount goes from its start value of 10 to its new
value of 9 and so on until the stop value is reached.
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Figure 4-20

The For Each ... Next Loop

In practical, day-to-day work, it’s unlikely that you'll use For . .. Next loops as illustrated here. Because
of way the NET Framework typically works, you'll usually use a derivative of the For . . . Next loop
called the For Each. .. Next loop.

In the algorithms you design, whenever a loop is necessary, you'll have a set of things to work through,
and usually this set is expressed as an array. For example, you might want to look through all of the files
in a folder, looking for ones that are over a particular size. When you ask the .NET Framework for a list
of files, you are returned an array of objects, each object in that array describing a single file. In the next
Try It Out, you'll modify your Loops application so that it returns a list of folders contained at the root of
your C drive.

Try It Out For Each Loop

1.

2.

Add another Button control to your form and set its Name property to btnForEachLoop and its
Text property to For Each Loop.

Double-click the button and add the following highlighted code to the c1ick event handler:

Private Sub btnForEachLoop_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnForEachLoop.Click

'List each folder at the root of your C drive
For Each strFolder As String In _
My .Computer.FileSystem.GetDirectories ("C:\")
'Add the item to the list
lstData.Items.Add (strFolder)
Next
End Sub

Run the project and click the button. You should see a list of folders that are at the root of your
C drive.
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How It Works

The My namespace in the NET Framework exposes several classes that make it easy for you to find the
information that you'll use on a daily basis. In particular, the Computer class provides several other
classes related to the computer that your program is running on. Since you want to find out about files
and folders, you use the FileSystem class, which provides methods and properties for working with
files and folders.

The GetDirectories method returns a collection of strings representing names of directories (or folders)
on your computer. In this case, you use it to return a collection of names of folders in the root of the com-
puter’s C drive.

The principle with a For Each. . . Next loop is that for each iteration you'll be given the “thing” that
you're supposed to be working with. You need to provide a source of things (in this case, a collection of
strings representing folder names) and a control variable into which the current thing can be put. The
GetDirectories method provides the collection, and the inline variable strFolder provides the con-
trol variable:

'List each folder at the root of your C drive
For Each strFolder As String In _

My.Computer.FileSystem.GetDirectories ("C:\")
Next

What this means is that on the first iteration, strFolder is equal to the first item in the string collection
(in my case, "C:\Documents and Settings”). You then add that item to the list box:

'Add the item to the list
lstData.Items.Add(strFolder)

As with normal For . . . Next loops, for every iteration of the loop you're given a string containing a
folder name, and you add that string to the list.

The Do ... Loop Loops

The other kind of loop you can use is one that keeps happening until a certain condition is met. These
are known as Do . . . Loop loops, and there are a number of variations.

The first one I'll introduce is the Do Until ... Loop. This kind of loop keeps going until something hap-
pens. For this Try It Out, you're going to use the random number generator that’s built into the NET
Framework and create a loop that will keep generating random numbers until it produces the number
10. When you get the number 10, you'll stop the loop.

Try It Out Using the Do Until . . . Loop

1. In the Form Designer, add another Button control to your form and set its Name property to
btnDoUntilLoop and its Text property to Do Until Loop.

2. Double-click the button and add the following highlighted code to its C1ick event handler:

Private Sub btnDoUntilLoop_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnDoUntilLoop.Click
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'Declare variables
Dim objRandom As New Random ()
Dim intRandomNumber As Integer = 0

'Clear the list
lstData.Items.Clear ()

'Process the loop until intRandomNumber = 10

Do Until intRandomNumber = 10
'Get a random number between 0 and 24
intRandomNumber = objRandom.Next (25)
'Add the number to the list
lstData.Items.Add (intRandomNumber)

Loop

End Sub

3. Runthe project and click the button. You'll see results similar to the results shown in Figure 4-21.
Keep clicking the button. You'll see that the number of elements in the list is different each time.

™ Form1 M=] 3
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17 Do Until Loop

Figure 4-21

How It Works

ADoUntil . . . Loop keeps running the loop until the given condition is met. When you use this type
of loop, there isn’t a control variable per se; rather, you have to keep track of the current position of the
loop yourself —let’s see how you do this. You begin by declaring a variable (also known as an object) for
the Random class, which provides methods for generating random numbers. This object has been pre-
fixed with obj to specify that this is an object derived from a class. The next variable that you declare is
the intRandomNumber, and this variable will be used to receive the random number generated by your
objRandom object:

'Declare variables
Dim objRandom As New Random()
Dim intRandomNumber As Integer = 0
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Then you clear the list of any previous items that may have been added:

'Clear the list
lstData.Items.Clear ()

Next, you set up the loop and tell it that you want to keep running the loop until intRandomNumber is
equal to 10:

'Process the loop until intRandomNumber = 10
Do Until intRandomNumber = 10

With each iteration of the loop, you ask the random number generator for a new random number and
store it in intRandomNumber. This is done by calling the Next method of objRandom to get a random
number. In this case, you've passed 25 as a parameter to Next, meaning that any number returned
should be between 0 and 24 inclusive — that is, the number you supply must be one larger than the
biggest number you ever want to get. In other words, the bounds that you ask for are noninclusive. You
then add the number that you got to the list:

'Get a random number between 0 and 24

intRandomNumber = objRandom.Next (25)

'Add the number to the list

lstData.Items.Add (intRandomNumber)
Loop

The magic happens when you get to the Loop statement. At this point, Visual Basic 2005 returns not to
the first line within the loop, but instead to the Do Unti1 line. When execution returns to Do Until, the
expression is evaluated. Provided it returns False, the execution pointer moves to the first line within
the loop. However, if intRandomNumber is 10, the expression returns True, and instead of moving to
the first line within the loop, you continue at the first line immediately after Loop. In effect, the loop is
stopped.

Do While . .. Loop

The conceptual opposite of a Do Until ... Loop isa Do While... Loop. This kind of loop keeps iterating
while a particular condition is True. Let’s see it in action.

Try It Out Using the Do While . . . Loop

1. Add another Button control to your form and set its Name property to btnDoWhileLoop and
its Text property to Do While Loop.

2. Double-click the button and add the following highlighted code to the c1ick event handler:
Private Sub btnDoWhileLoop_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnDoWhileLoop.Click

'Declare variables
Dim objRandom As New Random()
Dim intRandomNumber As Integer = 0

'Clear the list
lstData.Items.Clear ()
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'Process the loop while intRandomNumber < 15

Do While intRandomNumber < 15
'Get a random number between 0 and 24
intRandomNumber = objRandom.Next (25)
'Add the number to the list
lstData.Items.Add (intRandomNumber)

Loop

End Sub

3. Run the project and click the button. You'll see something similar to the results shown in
Figure 4-22.
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Figure 4-22

4. Every time you press the button, the loop executes until the random number generator pro-
duces a number greater than or equal to 15.

How It Works

ADothile...Loop keeps running so long as the given expression remains True. As soon as the
expression becomes False, the loop quits. When you start the loop, you check to make sure that
intRandomNumber is less than 15. If it is, the expression returns True, and you can run the code within
the loop:

'Process the loop while intRandomNumber < 15

Do While intRandomNumber < 15
'Get a random number between 0 and 24
intRandomNumber = objRandom.Next (25)
'Add the number to the list
lstData.Items.Add (intRandomNumber)

Loop

Again, when you get to the Loop statement, Visual Basic 2005 moves back up to the Do While statement.
When it gets there, it evaluates the expression again. If it’s True, you run the code inside the loop once
more. If it’s False (because intRandomNumber is greater than or equal to 15), you continue with the
first line after Loop, effectively quitting the loop.
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Acceptable Expressions for a Do . . . Loop

You might be wondering what kind of expressions you can use with the two variations of Do . . . Loop. If
you can use it with an If statement, you can use it with a Do . . . Loop. For example, you can write this:

Do While intX > 10 And intX < 100
or

Do Until (intX > 10 And intX < 100) Or intY = True
or

Do While String.Compare(strA, strB) > 0

In short, it’s a pretty powerful loop!

Other Versions of the Do . . . Loop

It’s possible to put the Until or While statements after Loop rather than after Do. Consider these two

loops:
Do While intX < 3
intX += 1
Loop
and
Do
intX += 1

Loop While intX < 3

At first glance, it looks like the While intX < 3 has just been moved around. You might think that these
two loops are equivalent—but there’s a subtle difference. Suppose the value of intX is greater than 3 (4
say) as these two Do loops start. The first loop will not run at all. However, the second loop will run once.
When the Loop While intX < 3 line is executed, the loop will be exited. This happens despite the condi-
tion saying that intX must be less than 3.

Now consider these two Do Until loops:
Do Until intX = 3
intX += 1
Loop
..and ...
Do

intX 4= 1
Loop Until intX = 3
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Again, although at first glance it looks like these two loops are equivalent, they’re not and behave
slightly differently. Let’s say that intX is 3 this time. The first loop isn’t going to run, as intX already
meets the exit condition for this loop. However, the second loop will run once. Then when you execute
Loop Until intX = 3 the first time, intX is now 4. So you go back to the start of the loop and increment
intX to 5, and so on. In fact, this is a classic example of an infinite loop (something I'll discuss later in
this chapter) and will not stop.

When you use Loop While or Loop Until, you are saying that, no matter what, you want the loop to
execute at least once. In general, I find it’s best to stick with Do While and Do Until, rather than use
Loop While and Loop Until.

You may also come across a variation of Do While. .. Loop called the while ... End while. This con-
vention is a throwback to previous versions of Visual Basic, but old-school developers may still use it
with .NET code, so it’s important that you can recognize it. These two are equivalent, but you should use
the first one.

Do While intX < 3
intX += 1
Loop

and

While intX < 3
intX += 1
End While

Nested Loops

You might need to start a loop even though you're already working through another loop. This is known
as nesting, and is similar in theory to the nesting that you saw when you looked at If statements. In this
Try It Out, you'll see how you can create and run through a loop, even though you're already working
through another one.

Try It Out Using Nested Loops

1. Inthe Form Designer, add another Button control to your form and set its Name property to
btnNestedLoops and its Text property to Nested Loops.

2. Double-click the button and add the following highlighted code to its c1ick event handler:

Private Sub btnNestedLoops_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnNestedLoops.Click

'Process an outer loop

For intLoopl As Integer = 1 To 2
'Process a nested (inner) loop
For intLoop2 As Integer = 1 To 3

lstData.Items.Add (intLoopl & ", " & intLoop2)

Next

Next

End Sub
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3.  Run the program and click the button. You should see results that look like those shown in
Figure 4-23.
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Figure 4-23

How It Works

This code is really quite simple. Your first loop (outer loop) iterates intLoopl from 1 to 2, and the
nested loop (inner loop) iterates intLoop2 from 1 to 3. Within the nested loop, you have a line of code
to display the current values of intLoopl and intLoop2:

'Process an outer loop
For intLoopl As Integer = 1 To 2
'Process a nested (inner) loop
For intLoop2 As Integer = 1 To 3
lstData.Items.Add (intLoopl & ", " & intLoop2)
Next
Next

Each For statement must be paired with a Next statement, and each Next statement that you reach
always “belongs” to the last created For statement. In this case, the first Next statement you reach is for
the 1 To 3 loop, which results in m being incremented. When the value of intLoop2 gets to be 4, you exit
the inner loop.

After you've quit the inner loop, you hit another Next statement. This statement belongs to the first For
statement, so intLoopl is set to 2 and you move back to the first line within the first, outer loop —in
this case, the other For statement. Once there, the loop starts once more. Although in this Try It Out
you’ve seen two For . . . Next loops nested together, you can nest Do . . . While loops and even mix
them, so you can have two Do . . . Loops nested inside a For loop and vice versa.

Quitting Early
Sometimes you don’t want to see a loop through to its natural conclusion. For example, you might be

looking through a list for something specific, and when you find it, there’s no need to go through the
remainder of the list.
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In this Try It Out, you'll revise your program that looked through folders on the local drive, but this
time, when you get to c: \ Program Files, you'll display a message and quit.

Try It Out Quitting a Loop Early

1. Add another Button control to your form and set its Name property to btnQuittingAForLoop
and its Text property to Quitting a For Loop.
2. Double-click the button and add the following highlighted code to the c1ick event handler:
Private Sub btnQuittingAForLoop_Click(ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles btnQuittingAForLoop.Click
'List each folder at the root of your C drive
For Each strFolder As String In _

My .Computer.FileSystem.GetDirectories ("C:\")

'Add the item to the list

lstData.Items.Add (strFolder)

'Do you have the folder C:\Program Files?

If String.Compare (strFolder, "c:\program files", True) = 0 Then
'Tell the user
MessageBox.Show ("Found it, exiting the loop now.", "Loops")
'Quit the loop early
Exit For

End If

Next
End Sub
3.

Run the program and click the button. You'll see something similar to the results shown in
Figure 4-24.

How It Works

This time, with each iteration, you use the String.Compare method that was discussed earlier to check
the name of the folder to see whether it matches C: \Program Files:

'Do you have the folder C:\Program Files?

If String.Compare (strFolder, "c:\program files", True) = 0 Then

If it does, the first thing you do is display a message box:

'Tell the user
MessageBox.Show ("Found it, exiting the loop now.", "Loops")
After the user has clicked OK to dismiss the message box, you use the Exit For statement to quit the

loop. In this instance, the loop is short-circuited, and Visual Basic 2005 moves to the first line after the
Next statement.

'Quit the loop early
Exit For
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Of course, if the name of the folder doesn’t match the one you're looking for, you keep looping. Using
loops to find an item in a list is one of their most common uses. Once you've found the item you're look-
ing for, using the Exit For statement to short-circuit the loop is a very easy way to improve the perfor-
mance of your application.

Imagine you have a list of a thousand items to look through. You find the item you're looking for on the
tenth iteration. If you don’t quit the loop after you've found the item, you're effectively asking the com-
puter to look through another 990 useless items. If, however, you do quit the loop early, you can move
on and start running another part of the algorithm.

Quitting Do . . . Loops

As you might have guessed, you can quit a Do . . . Loop in more or less the same way, as you see in the
next Try It Out.

Try It Out Quitting a Do . . . Loop

1. Add another Button control to your form and set its Name property to btnQuittingADoLoop
and its Text property to Quitting a Do Loop.

2. Double-click the button and add the following highlighted code to the 1ick event handler:

Private Sub btnQuittingADoLoop_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnQuittingADoLoop.Click

'Declare variable
Dim intCount As Integer = 0

'Process the loop
Do While intCount < 10
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'Add the item to the list
lstData.Items.Add (intCount)

'Increment intCount by 1
intCount += 1

'Should you quit

If intCount = 3 Then
Exit Do

End If

Loop
End Sub

3. Runthe project and click the button. You'll see a list containing the values 0, 1, and 2.

How It Works

In this case, because you're in a Do . . . Loop, you have to use Exit Do rather than Exit For. However,
the principle is exactly the same. Exit Do will work with both the Do While... Loop and Do Until...
Loop loops.

Infinite Loops

When building loops, you can create something called an infinite loop. What this means is a loop that,
once started, will never finish. Consider this code:

Dim intX As Integer = 0
Do

intX += 1
Loop Until intX = 0

This loop will start and run through the first iteration. Then when you execute Loop Until intX = 0 the
first time, intX is 1. So you go back to the start of the loop again and increment intX to 2, and so on.
What's important here is that it will never get to 0. The loop becomes infinite, and the program won’t
crash (at least not instantly), but it may well become unresponsive.

If you suspect a program has dropped into an infinite loop, you’ll need to force the program to stop.
With Windows XP, this is pretty easy. If you are running your program in Visual Studio 2005, flip over to
it, and select Debug = Stop Debugging from the menu. This will immediately stop the program. If you
are running your compiled program, you'll need to use the Windows Task Manager. Press Ctrl+Alt+Del
and select Task Manager. Your program should show as Not Responding. Select your program in the
Task Manager and click End Task. Eventually this opens a dialog saying that the program is not
responding (which you knew already) and asking whether you want to kill the program stone dead, so
click End Task again.

In some extreme cases, the loop can take up so much processing power or other system resources that

you won't be able to open Task Manager or flip over to Visual Studio. In these cases, you can persevere
and try to use either of these methods; or you can reset your computer and chalk it up to experience.
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Visual Studio 2005 does not automatically save your project before running the application, so you're
likely to lose all of your program code if you have to reset. Therefore, it would be wise to save your pro-
ject before you start running your code.

Summary

In this chapter, you took a detailed look at the various ways that programs can make decisions and loop
through code. You first saw the alternative operators that can be used with If statements and examined
how multiple operators could be combined by using the And and or keywords. Additionally, you exam-
ined how case-insensitive string comparisons could be performed.

You then looked at Select Case, an efficient technique for choosing one outcome out of a group of pos-
sibilities. Next you examined the concept of looping within a program and were introduced to the two
main types of loops: For loops and Do loops. For loops iterate a given number of times, and the deriva-
tive For Each loop can be used to loop automatically through a list of items in a collection. Do While
loops iterate while a given condition remains True, whereas Do Until loops iterate until a given condi-
tion becomes True.

In summary, you should know how to use:

a If, ElseIf, and Else statements to test for multiple conditions
Nested If statements

Comparison operators and the String.Compare method

The select Case statement to perform multiple comparisons

For ...Next and For ... Each loops

0O 00 o0 o

Do ...Loop and Do While ... Loop statements

Exercises

Exercise 1

Create a Windows Application with a text box and a Button control. In the c1ick event of the Button,
extract the number from the text box and use a Select Case statement with the numbers 1 through 5. In
the Case statement for each number, display the number in a message box. Ensure that you provide
code to handle numbers that are not in the range of 1 through 5.

Exercise 2

Create a Windows Application that contains a ListBox control and a Button control. In the c1ick event
for the button, create a For . . . Next loop that will count from 1 to 10 and display the results in the list
box. Then create another For . . . Next loop that will count backwards from 10 to 1 and also display
those results in the list box.
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Structures

In the last couple of chapters, you worked with simple data types, naming Integer and String
variables. While these data types are useful in their own rights, more complex programs call for
working with data structures; that is, groups of data elements that are organized in a single unit. In
this chapter, you learn about the various data structures available in Visual Basic 2005 and will see
some ways in which you can work with complex sets of data. You will also learn how you can
build powerful collection classes for working with, maintaining, and manipulating lists of com-
plex data.

In this chapter, you will learn about:

Q  Arrays
O  Enumerations
O  Constants
a

Structures

Understanding Arrays

A fairly common requirement in writing software is the ability to hold lists of similar or related
data. You can provide this functionality by using an array. Arrays are just lists of data that have a
single data type. For example, you might want to store a list of your friends’ ages in an integer
array or their names in a string array.

In this section, you take a look at how to define, populate, and use arrays in your applications.
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Defining and Using Arrays

When you define an array, you're actually creating a variable that has more than one dimension. For
example, if you define a variable as a string, as follows, you can only hold a single string value in it:

Dim strName As String
However, with an array you create a kind of multiplier effect with a variable, so you can hold more than
one value in a single variable. An array is defined by entering the size of the array after the variable
name. So, if you wanted to define a string array with 10 elements, you’d do this:

Dim strName(9) As String

The reason you use (9) instead of (10) to get an array with 10 elements is explained in detail later.

For now it is simply because numbering in an array starts at zero, so the first element is zero in an

array, the second element is one in an array, and so on.
Once you have an array, you can access individual elements in it by providing an index value between 0
and a maximum possible value — this maximum possible value happens to be one less than the total
size of the array.
So, to set the element with index 2 in the array, you’d do this:

strName (2) = "Katie"
To get that same element back again, you’d do this:

MessageBox.Show (strName (2) )

What's important is that other elements in the array are unaffected when you set their siblings. So, if you
do this:

strName (3) = "Betty"
strName (2) remains set to "Katie".

Perhaps the easiest way to understand what an array looks like and how one works is to write some
code that uses them.

Try It Out Defining and Using a Simple Array

1. Using Visual Studio 2005, click the File menu and choose New > Project. In the New Project dia-
log box, create a new Windows Application called Array Demo.

2.  When the Designer for Form1 appears, add a ListBox control to the form. Using the Properties
window set its Name property to IstFriends and its IntegralHeight property to False.

3. Now add a Button control to the form, set its Name property to btnArrayElement, and set its
Text property to Array Element. Your form should now look something like Figure 5-1.
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@ Form1 H[=] E3

Arrap Element |

Figure 5-1

4. Double-click the button and add the following highlighted code to its C1ick event handler:

Private Sub btnArrayElement_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnArrayElement.Click

'Declare an array
Dim strFriends(4) As String

'Populate the array

strFriends (0) = "Robbin"
strFriends (1) = "Bryan"
strFriends (2) = "Stephanie"
strFriends (3) = "Sydney"
strFriends(4) = "Katie"

'Add the first array item to the list
lstFriends.Items.Add(strFriends(0))
End Sub

5.  Run the project and click the button. The list box on your form will be populated with the name
Robbin.

How It Works

When you define an array, you have to specify a data type and a size. In this case, you're specifying an
array of type String and also defining an array size of 5. The way the size is defined is a little quirky.
You have to specify a number one less than the final size you want (you'll learn why shortly). So here,
you have used the line:

'Declare an array
Dim strFriends(4) As String

In this way, you end up with an array of size 5. Another way of expressing this is to say that you have an
array consisting of 5 elements.

Once done, you have your array, and you can access each item in the array by using an index. The index
is given as a number in parentheses after the name of the array. Indexes start at zero and go up to one
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less than the number of items in the array. The following example sets all five possible items in the array
to the names:

'Populate the array

strFriends(0) = "Robbin"
strFriends (1) = "Bryan"
strFriends(2) = "Stephanie"
strFriends(3) = "Sydney"
strFriends (4) = "Katie"

Just as you can use an index to set the items in an array, you can use an index to get items back out. In
this case, you're asking for the item at position 0, which returns the first item in the array, namely
Robbin:

'Add the first array item to the list
lstFriends.Items.Add (strFriends(0))

The reason the indexes and sizes seem skewed is because the indexes are zero-based, whereas humans
tend to number things beginning at 1. When putting items into or retrieving items from an array, you
have to adjust the position you want down by one to get the actual index; for example, the fifth item is
actually at position 4, the first item is at position 0, and so on. When you define an array, you do not
actually specify the size of the array but rather the upper index bound —that is, the highest possible value
of the index that the array will support.

But why should the indexes be zero-based? Remember that to the computer, a variable represents the
address of a location in the computer’s memory. Given an array index, Visual Basic 2005 just multiplies
the index by the size of one element and adds the product to the address of the array as a whole to get the
address of the specified element. The starting address of the array as a whole is also the starting address
of the first element in it. That is, the first element is zero times the size of an element away from the
start of the whole array; the second element is 1 times the size of an element away from the start of the
whole array; and so on.

Using For Each ... Next

One common way to work with arrays is by using a For Each . .. Next loop. This loop was introduced
in Chapter 4, when you used them with a string collection returned from the
My.Computer.FileSystem.GetDirectories method. In the next Try It Out, you look at how you use
For Each...Next with an array.

Try It Out Using For Each . . . Next with an Array

1. If the program is running, close it. Open the Code Editor for Form1 and add the following vari-
able declaration at the top of your form class:

Public Class Forml

'Declare a form level array
Private strFriends(4) As String
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In the Class Name combo box at the top left of your Code Editor, select (Forml Events). In the
Method Name combo box at the top right of your Code Editor, select the Load event. This
causes the Form1_Load event handler to be inserted into your code. Add the following high-

lighted code to this procedure:

Private Sub Forml_Load(ByVal sender As Object, _
ByVal e As System.EventArgs) Handles Me.Load

'Populate the array

strFriends (0) = "Robbin"

strFriends (1) = "Bryan"

strFriends (2) = "Stephanie"

strFriends (3) = "Sydney"

strFriends (4) = "Katie"
End Sub

Switch to the Form Designer and add another Button control. Set its Name property to
btnEnumerateArray and its Text property to Enumerate Array.

Double-click this new button and add the following highlighted code to its c1ick event
handler:

Private Sub btnEnumerateArray_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnEnumerateArray.Click

'Enumerate the array
For Each strName As String In strFriends
'Add the array item to the list
lstFriends.Items.Add (strName)
Next
End Sub

Run the project and click the button. You'll see results like those in Figure 5-2.
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Figure 5-2
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How It Works

You start this exercise by declaring an array variable that is local to the form, meaning that the variable is
available to all procedures in the form class. Whenever variables are declared outside a method in the
form class, they are available to all methods in the form.

'Declare a form-level array
Private strFriends(4) As String

Next you added the Load event handler for the form and then added code to populate the array. This
procedure will be called whenever the form loads, ensuring that your array always gets populated.

Private Sub Forml_Load(ByVal sender As Object, _
ByVal e As System.EventArgs) Handles Me.Load

'Populate the array

strFriends (0) = "Robbin"

strFriends (1) = "Bryan"

strFriends(2) = "Stephanie"

strFriends(3) = "Sydney"

strFriends(4) = "Katie"
End Sub

In Chapter 4, you saw the For Each . .. Next loop iterate through a string collection; in this example, it
is used in an array. The principle is similar; you have to create a control variable that is of the same type
as an element in the array and gives this to the loop when it starts. This has all been done in one line of
code. The control variable, strName, is declared and used in the For Each statement by using the As
String keyword.

The internals behind the loop move through the array starting at element 0 until it reaches the last ele-
ment. For each iteration, you can examine the value of the control variable and do something with it; in
this case, you add the name to the list.

'Enumerate the array

For Each strName As String In strFriends
'Add the array item to the list
lstFriends.Items.Add (strName)

Next

Also, notice that the items are added to the list in the same order that they appear in the array. That’s
because For Each . .. Next goes through from the first item to the last item as they are defined.

Passing Arrays as Parameters

It’s extremely useful to be able to pass an array (which could be a list of values) to a function as a param-
eter. In the next Try It Out, you'll look at how to do this.

Try It Out Passing Arrays as Parameters

1. Switch to the Form Designer and add another Button control. Set its Name property to
btnArraysAsParameters and its Text property to Arrays as Parameters.
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4.

Double-click the button and add the following highlighted code to its C1ick event handler.
You'll receive an error message that the AddItemsToList procedure is not defined. You can
ignore this error because you'll be adding that procedure in the next step:

Private Sub btnArraysAsParameters_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles btnArraysAsParameters.Click

'List your friends
AddItemsToList (strFriends)
End Sub

Now add the AddItemsToList procedure as follows:

Sub AddItemsToList (ByVal arrayList() As String)
'Enumerate the array
For Each strName As String In arrayList
'Add the array i